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Related Documents

Ref# Title

MA-021 | Perception Server - Installation & User Guide

MA-022 | Perception Web - Installation & User Guide

MA-023 | Perception Workflow Designer - Installation & User Guide

Abbreviations & Definitions

Abbreviation Meaning

KPD file suffix for a Perception Database file (stored in a SQL format)

TOA file suffix for a device configuration file (stored in a CSV format)

DGA Dissolved Gas Analysis

Ccsv Comma Separated Variable — an industry-standard neutral data exchange format
SQL Structured Query Language - an industry-standard database format
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1.1

1.2

INTRODUCTION

Product Overview

Perception is a software product designed to assist power plant personnel in
the maintenance and management of oil-insulated equipment used in the
transmission and distribution of electrical power. It is used primarily for
diagnosing fault conditions as well as trending measurements taken from
transformers, circuit breakers and tap-changers.

The software accepts data from either manual or automated programs of
regular sampling and condition analysis of the equipment’s insulating oil as
well as other performance data. Several well-established and recognized
empirical diagnostic rules are used to present information to the user on the
condition of the insulating oil used in the electrical equipment. This assists in
the running of a maintenance program and in the identification of potential
fault conditions. It allows both the maintenance engineer and asset manager
to monitor and diagnose transformer data collected by GE's range of on-line
monitoring units. The data includes Dissolved Gas Analysis (DGA), calculated
models, bushing and other transformer measurements. By providing access to
this valuable data along with powerful diagnostic tools, Perception delivers
clear transformer condition information. This enables decisions to be made
quickly and reliably, helping to extend the life of transformers, reduce
unplanned outage, and avoid catastrophic failure.

Although Perception is an expert analysis and information system, it is only an
aid and should not be regarded as a replacement for the knowledge of a
subject matter expert in the analysis of insulating oil used in electrical
equipment and the operation of oil filled power equipment.

Software Family

There are four members of the Perception family.

» Perception Desktop — A standalone software application that provides
customized access to the centrally located asset database. It provides
advanced diagnostic profiles on device data, a multi-page transformer
report containing key transformer information as well as the facility to
launch external applications. Additionally, Perception Desktop can operate
standalone or as part of a larger centralized asset management suite in
conjunction with Perception Server.

= Perception Server — The pinnacle of transformer asset management
software. Perception Server provides a fleet-wide network overview via a
wallboard display, automatic data downloading with configurable
scheduling, email notifications of device condition changes and a TOA4
data export facility. It uses a centralized data storage location based on
SQL Server to which Perception Desktop links seamlessly via secure OPC
UA communications.
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= Perception Web — A web-based solution that provides read-only access to
the centrally located asset database. This offers a convenient way to
obtain readings and consolidated data analysis across a variety of
platforms including mobile devices. This includes transformer dashboards,
wallboards and an overview to the status of the entire transformer fleet.

» Perception Workflow Designer — The workflow designer uses common
flowcharting techniques to express transformer diagnostic processes as a
model. These models are known as workflows and in turn drive the
Perception dashboard. The Designer brings easily modifiable workflow-
enabled capabilities to the Perception software suite allowing control over
the diagnostic process and customization of how data is presented on the
Perception dashboard.

Note: Perception Express is no longer available and should be removed
since Perception Desktop includes all this functionality and more.

1.3 What's New?

» Enhanced support for DGA 900 TapTrans Plus with models for cooling,
thermal and OLTC data, including import and export of such data.

» Minor enhancements and bug fixes.

Note: If upgrading to Perception Desktop/Server 2.4. X from version 1.X,
please contact GE Support before commencing as depending upon
the size and complexity of the existing database, a service visit may
be required to make the transition.
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1.4

1.5

Desktop Features

Perception Desktop offers the following:

Can be used as a stand-alone application or as a client application in a
large centralized Perception Server environment

Wallboard facility gives an overview to the entire fleet

Trend charts for any measured parameters, including polar plots for
Bushing Monitors and Partial Discharge (BMT devices & DGA 900 PLUS
with bushing monitoring)

Current status and data history displays

Configure the data upload frequency from remote monitors
Pre-set trend and diagnostic graphs for dissolved gases
User-configurable trend graphs for any monitored parameters
Gas Ratio trend charts

Preset fault monitoring displays utilising Gas ratios (IEC60599 & IEEE
C57.104, Transformer Condition, Rogers Ratio and Doernenburg Ratio),
Duval’s diagnostics and Japanese ETRA standards

Models for Intellix MO150 & Hydran M2 / M2-X devices (see Section 4.16)

Transformer Report for an overview to key information on a transformer’s

condition based on the dissolved gas measurement analysis and user input

(see Section 5.5)

Facility to launch external applications from within Perception Desktop (see

Section 5.7)

System Requirements

The minimum PC and system requirements for Perception Desktop are:

Operating Windows 7 with .NET Framework 4.7
System:

CPU: 2 GHz Processor

Memory: 2 GB RAM

HDD: 10 GB free

Graphics Card: 64 MB graphics, update to the latest driver for your

hardware to ensure that it can provide all the facilities of
NET Framework 4.7

Note: Windows 8 does not enable Microsoft .NET 3.5 features by default.

However, all Perception installers require .NET 3.5, so you will be
prompted to enable it.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 13 of 220



1.6

Software Licensing

Perception Desktop uses a tier-licensing model when used with Perception
Server. This provides greater flexibility to add devices and manage license
expiry. There are six tiers in the model, as listed in Table 1-1, with each tier
supporting an increasing number of devices according to a range of

accumulated device weightings.

Table 1-1: Tier scores

Tier Accumulated weightings

0-50

51-100

101-150

151-250

251-500

Ol W|IN| =

501+

The weighting scores for each type of device are listed in Table 1-2.

Table 1-2: Device scores

Device

Weighting Score

Offline

201Ti

Hydran M2 / M2-X

8 series relays

MO150

MINITRANS

CB Watch3

Transfix

DGA 500

DGA 900

BMT 300

BMT 430

DUALTRANS

TAPTRANS / DGA 900 TAPTRANS

MULTITRANS / DGA 900 MULTITRANS

Transfix PLUS

DGA 900 PLUS

TMS

MS 3000

N[N/o[ofojo|ojfajajafaia|bh|[h[R[W[W[N]|—

You can add any number of devices and assets within the limits set by the
Perception fleet license tier. To add further devices or assets requires a
license upgrade — contact Customer Support.

Note: Customers on an existing annual fleet licensing agreement can add
assets and devices beyond the limits set by the new license tier.
However, once the annual fleet license agreement expires, the license
tier is recalculated and may require an upgrade to service all devices.

Note: When connected to Perception Server, the Fleet Summary window
becomes available in Perception Desktop and provides details on the
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Perception license tier including expiry date and a summary of the
devices and assets that have been added to the database.

1.6.1 License Expiry

A License Expiry message appears in Perception Desktop 90 days before the
Perception fleet license is due to expire as shown in Figure 1-1. Reminder
messages are automatically scheduled to reappear at 60 days, 30 days, 15

days and 5 days, or on each first launch of the application within the set days
of the expiration period.

» Perception Desktop

Perception Fleet Version 2.4.7

Your Perception Fleet License will expire in 25 days,

please contact a GE sales representative to extend your license
period.

If you do not choose to extend your license pericd you can still use
Perception Fleet however the following key features will no longer
be available.

-Transformer Risk Evaluations
-Fleet Ranking

-Transforrmer and Fleet Dashboard
-Wallboard Fleet Visualisation
-Perception Web

-Expert Email Motifications

To reactivate you license please contact your local sales
representative or email sales.digitalenergyMD@ ge.com.

Please quote Perception Fleet License Tier: &

Figure 1-1: License expiry notification

A yellow warning icon also appears in the lower right corner of the application
window with a tooltip when you rest the mouse pointer over it as shown in

Figure 1-2.

Your Perception Fleet License is about to expire.
Click for detailed information.

Figure 1-2: License warning indicator

Perception Server restricts functionality after license expiration. The following
features are disabled:

= Transformer Risk Evaluations

» Fleet Ranking

= Transformer and Fleet Dashboard

= Wallboard Fleet Visualisation

= Perception Web

= Expert Email Notifications
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1.6.2  Fleet Summary

Perception provides a useful summary dialog with license tier details and all
assets and devices that comprise the Perception Fleet. Select Help > Fleet
Summary as shown in Figure 1-3.

ﬁ Perception Desktop

About...
Fleet Summary...

Transformer Technical Services...

Figure 1-3: Help menu

The Fleet Summary dialog displays as shown in Figure 1-4.

Perception Fleet Summary
Version

Copyright & GE Digital Energy 2019

Perception Fleet License Tier: 6 Predicted Perception Fleet License Tier for the following year 6~ +

Perception Fleet License will expire on 21 April 2020

Perception Fleet Summary Devices added since last activation

Transfix 1.6: 2 Transfix 1.6: 1 =
MultiTrans: 1 DGA 900 1

DGA 500: 2 Transformers with imported data: 1

BMT 300/330: 3
Transfermers with imported data: 1
CBWatch: 1

To renew your license, please contact your local sales representative, or email salesdigitalenergyMD @ge.com and quote your Perception
Fleet License Tier,

License Key:

o |

Figure 1-4: Fleet Summary dialog

1.7 Customer Support

E-mail: ga.support@ge.com
North America: 1-877-605-5777
Worldwide: +44 1785-250-070
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2.2

INSTALLING & CONFIGURING

Overview

There are two main steps to installing and setting up Perception Desktop:

» |nstall the Perception Desktop software on your PC.

Note: Itis advisable to use Windows Update to check that your PC is
running an up-to-date version of the “NET Framework’ before
launching the Perception Desktop installer.

= Set up the connections to the Perception databases or Perception Server.

Note: If you install Transport X software on your PC, you can also
incorporate data from the Transport X portable range.

Run the Perception Desktop Installer

2.2.1  Toinstall Perception Desktop, double click the
Perception.Desktop.Setup.exe file. The Setup / Upgrade Wizard
opens to guide you through the process as shown in Figure 2-1. Click
Next to proceed.

Note: The Perception.Desktop.Setup.msi file must also be available in the
same location.

) Perception Desktop =l & &= |

Welcome to the Perception Desktop Setup
Wizard

The installer will guide wou through the steps required to install Perception
Desktop onwour computer.

YWARMING: This computer program is protected by copryright law and
international treaties. Lnautharized duplication or distribution of this program, or
any porion of it may resultin severe civil or criminal penalties, and will be
prosecuted 1o the maximum extent possible under the law.

Figure 2-1: Welcome to the Perception Desktop Setup Wizard
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2.2.2 If the License Agreement is acceptable, select | accept the terms in
the License Agreement and click Next as shown in Figure 2-2.

’ﬁ! Perception Desktop =al= '|i&ﬂ

License Agreement

FORM ES105 (REV 3): SOFTWARE LICENSE
NOTICE - READ THIS CAREFULLY: THIS IS A LEGAL AND BINDING AGREEMENT
BETWEEN YOU AND LICENSOR. BY INSTALLING THE SOFTWARE, YOU AGREE TO
ALL THE TERMS AND CONDITIONS OF THIS SOFTWARE LICENSE ["LICENSE"). IF
YOU DO NOT AGREE TO THESE TERMS, DO NOT INSTALL THE SOFTWARE. YOU
MAY RETURN THE SOFTWARE, ALL MANUALS, DOCUMENTATION AND PROOF OF
PAYMENT TO LICENSOR WITHIN 30 DAYS OF PURCHASE FOR A FULL REFUND.

1. Definitions. Unless otherwise ogreed to by Licensar, the fellowing terms shall

PP Pl

@ | accept the terms in the License Agreement

)| do not accept the terms in the License Agreement

< Bacl ][ Mext »

Figure 2-2: License Agreement
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2.2.3 Browse to select the installation folder or accept the default folder
and click Next to continue as shown in Figure 2-3.

Note: If your PC is shared with other users, you can choose to install

Perception Desktop for use under your login account only, or for all

user accounts of the PC.

ﬁ'}‘F‘erceptiDn Desktop (o= | =]

Select Installation Folder

The installer will install Perception Desktop to the following folder.

Toinstall in this folder, click "Mext". To install to a different folder, enter it below
or click "Browse".

Eolder:
|C:"5F’r|:|gram Files (8614 GE Digital Energy\Perception 2. [ Browse... ]

| DiskCost. |

Install Perception Desktop for yourself, or for amyone who uses this computer:

@ Everyone

) Justme

Cancel H < Back ][ Mext »

Figure 2-3: Select Installation Folder
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2.2.4  Click Next to start the installation, Back to backtrack and change
some of the selections, or Cancel to quit the process entirely, as
shown in Figure 2-4.

j{i‘}! Perception Desktop E =] @ﬁ

Confirm Installation

-

The installer is ready to install Perception Desktop on your computer,

Click "Mext" to start the installation.

Cancel || < Back |[ Mext »

Figure 2-4: Confirm Installation
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2.2.5 If you click Next, then the installation commences and a progress bar
indicates the progress so far as shown in Figure 2-5. The installation
may take some minutes.

ﬁ Perception Desktop E (=] @

Installing Perception Desktop

-

Ferception Deskiop is being installed.

Fleasze wait...

Figure 2-5: Installing Perception Desktop
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2.2.6 The Setup Wizard completes the installation and presents the
following message as shown in Figure 2-6. Click Finish to exit.

rj_,i';! Perception Desktop E [=] @ﬁ

Installation Complete

Ferception Desktop has been successfully installed. Click "Finish" ta exit.

Launch Perception Desktop.
Recommended Softwares:

Selectthe software and click Install Mow. TransCom installer is also available in
ChardFarty directony. The BT 3004330 installer is awvailable on the Ferception...

TransCorm (Provides support for Transfix 1.5) Install Mo
BrAT 3007330

Flease use Windows LUpdate to check for any critical updates to the NET Fra...

Cancel < Back

Figure 2-6: Installation Complete

Perception Desktop is now successfully installed. Other related software
installations include:

= Transport X: the data storage software supplied with the portable Transport
X products. It is used to read the data from the portable devices.
Perception Desktop can automatically interface with the Transport X
software to incorporate that data into the main Perception database. To do
so, the Transport X device must previously be installed on your PC. See the
Transport X device manual for details and 5.8 for installation details.

» Intellix BMT 300/330: the software used to configure and monitor Intellix BMT
devices.

= TransCom: the software used by Perception to support Transfix 1.0/1.5
devices.
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2.3

2.3.1

2.3.2

2.4

Firewall Settings

Perception Desktop must be allowed to communicate with Perception Server
through your firewall. This requires opening certain ports for inbound
connection on the Perception Server firewall. The UA Discovery Server
application should also be added as a permissible program to send and
receive through the firewall. Note: Your firewall settings are maintained by
your IT administrator.

Perception Server ports

Perception Server requires the following ports to be opened:

= 502 (for Transfix, CB Watch and 8 series relay devices)
= 5000 (for Hydran devices)

* 62541 (to allow the client to read the server configuration via Discovery
Server)

= 69 UDP (to allow TFTP data download from 8 series relays)
= 80 HTTP (for DGA 900 and CB Watch devices)
= 443 HTTPS (for DGA 900 and CB Watch devices)

It is recommended that the Perception database be located on the same
server as Perception Server. If not, then the following additional port needs to
be opened:

= 1433 TCP (to allow the client to connect with the SQL Server)

Perception Client ports

Perception Desktop requires the following ports to be opened:

= 4840 (for Perception Server to be discovered)

* 62541 (to allow the client to read the server configuration via Discovery
Server)

= 1433 TCP (to allow the client to connect with the SQL Server)

Create a New Database Connection

Launching the Perception software for the first time prompts for a database
connection in order to use the software as shown in Figure 2-7.
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Powerful Transformer Monitoring & Diagnostics

Getting Started...

Firstly Open or Create a Database Add an Asset to the Asset Explorer OR Configure You can also Import Data from
OR connect to Perception Server your GE M&D Device & Download the data CSV files and the Transport X

Figure 2-7: Getting Started

Having installed and authenticated the Perception Desktop software, you
should now establish a database connection Note: This task need only be
performed once. Perception Desktop allows the user to connect to a
Perception Server database (as outlined in Section 2.4.1) or to a local (file-
based) database as outlined in Section 2.4.1.1.

2.41 Create a new connection to a Perception Server database
Note: Perception Server must be installed prior. The Perception Server
database is created and administered by your System Administrator.

To establish a new connection with a Perception Server database, start
Perception Desktop and select File > Connect as shown in Figure 2-8.

Connect...

Disconnect

Mew Databaze...
Open Database...

Close Database

Exit

Figure 2-8: Connect to an existing database
The ‘Login’ dialog box as shown in Figure 2-9 allows you to specify the

connection details. Click the (...) browse button to configure the server
connection.
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-

i Login

Server

Uszer name:

Password:

Authentication:

=)
[ ]
-

Cancel

Figure 2-9: Login

The ‘Configure a Server Connection’ wizard opens as shown in Figure 2-10
and is designed to assist you with the configuration. Click Next to proceed.

-

% Configure a Server Connection

=X

Welcome to the Server Configuration
Wizard.

This wizard will help you to configure a Server
Connection.

Click Mext to continue.

Figure 2-10: Configure a Server Connection

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3

22-Oct-24

Page 25 of 220



Type the Discovery IP Address or Discovery hostname and click Next as
shown in Figure 2-11.

% Configure a Server Connection ﬁ

Enter Discovery Server |

Enter a Discovery [P Address or Hostname

The Server Name

[ Cancel l[ Back i Mext I

Figure 2-11: Enter Discovery Server
The Discovery Server lists all Perception Server databases that it finds as

shown in Figure 2-12. Select the database that you wish to establish a
connection with and click Next.

& Configure a Server Connection ﬁ

Choose Perception Server

Choose a Perception Server fram the list below.

Name URI
Perception urn: server name:Perception.Server.AAA-123ABCD

[ Cancel ]I Back ’ MNext ]

Figure 2-12: List of Perception databases

The ‘Configure Options’ step of the wizard then invites you to confirm the
security settings for the connection. Figure 2-13 shows the default security
settings — make any changes if required and click Next.

Note: Consult with your network administrator to confirm if any of these
settings should be changed.
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r'ﬁ_ Configure a Server Connection ﬁ1
Configure Options
|
Protocol: [Dpc.tcp v]
|
Security Mode: [Signﬁdencr}rpt ""] |
Security Policy: |Basic128Rsal5 -
Message Encoding: [Binary v]
[ Cancel ] [ Back E MNext i

Figure 2-13: Configure Options

A confirmation message displays the chosen settings and indicates that the
server configuration is now complete as shown in Figure 2-14. Click Finish to
proceed.

- K
":D_ Configure a Server Connection ﬁ

Server Configuration Complete.

Configured Server Connection

The server address / Perception Server

[SignAndEncrypt:Basic128Rsal5:Binary]

Click Finish to save Configured Server
Connection.

[ Cancel ][ Back ]

Figure 2-14: Server Configuration Complete

You are returned to the Login prompt as shown in Figure 2-15. Choose the
Authentication method to be associated with this connection, and finally,
enter the user name and password and click OK.

Note: Your System Administrator will have these login details.
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2.41.1

% Login

Server: The server address / Perception Server ‘_’
Authentication: UserName > ’
User name:

Password:

[ Cancel

Figure 2-15: Login prompt

When connecting for the first time, you will also need to ensure that the
respective certificate on both the client and server are trusted. See Section
2.4.2 .1 for trusting the Server certificate and speak to your System
Administrator for trusting the client certificate.

Trusting Perception Certificates

As a security measure, Perception uses electronic credentials known as
certificates to authenticate clients and servers. Every time a new Perception
Desktop client is added, both the client and the server administrator must
trust each other’s certificates (or physically exchange certificates as outlined
below). This ensures that the requisite trust exists between client and server.
Once the certificates have been exchanged, seamless communication can
take place.

When you try and connect a Perception Desktop client to the server for the
first time, the connection will be rejected as shown in Figure 2-16.

Note: With every attempted connection, the Server’s certificate is
automatically copied to the client’s rejected folder and the client’s
certificate is automatically copied to the server’s rejected folder.

r ~
Connection Error @

-
) Server Certificate not Trusted.

A

Figure 2-16: Server certificate not trusted

This is because the client does not trust the server. To trust the server
certificate, the certificate must be moved from the client’s rejected certificate
store and added to the client’s trusted certificate store.

To do this, open File Explorer and navigate to the rejected folder at this
location:

C:\ProgramData\GE Energy\Perception\RejectedCertificates\cert
s
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2.4.2

Note:  In Windows 10, the ProgramData folder may be hidden. If so, show hidden
items in the File Explorer View menu.

Look for a certificate of the following format:
Perception.Desktop.<computer name>[key].der

Where <computer name> is the computer name of the server, and [key] is the
public certificate key.

Move this certificate to the “TrustedCertificates\certs” folder at this location:
C:\ProgramData\GE Energy\Perception\TrustedCertificates\certs

When you try to connect again you will get another connection error as shown
in Figure 2-17.

' N
Connection Error @

| Client Certificate not Trusted.

Figure 2-17: Client certificate not trusted

This is because the server does not trust the client. To trust the client
certificate, the certificate must be moved from the server’s rejected certificate
store and added to the server’s trusted certificate store.

Note: Contact your Server Administrator to have the relevant steps taken on
the Server side.

All these steps must be performed after every first connection attempt of a
new user and so requires both client user and Server Administrator to move
the respective certificate to the “trusted folder” on their respective machine in
order to establish a trusted relationship and thereby permit communication.

Create a new local database

To create a new local database for Perception Desktop, select File > New
Database as shown in Figure 2-18.
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Connect...

Disconnect

Mew Database...
Open Database..

Close Database

Exit

Figure 2-18: New Database option

In the Create New dialog, navigate to the save location, enter a name for the

local database file and click Save as shown in Figure 2-19.

Note: The file type uses the file extension “.kpd” to denote a Perception
Desktop database file.
1, Create New
' B Desktop » ']‘, || Search Desktop Lo
Organize v New folder = ©
—( Favorites ‘:' e = Libraries
Bl Desktop g a, System Folder
8 Downloads \
% Recent Places h Leeward; Hay
System Folder
-. S b { Computer
"“L'b"m System Folder
_+ Documents
@ Documents ( Network
m; Hiring | System Folder
o Music
(s! One Note =
File pame:  test v

Savuswpe[PuupﬁonComMaFik(‘.kpd)

'~ Hide Folders [

Figure 2-19: Save the local database

The new database is represented in the Asset Explorer pane of Perception
Desktop as shown in Figure 2-20. See Section 3.2 for methods of adding data

to the local database.
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2.4.21

Fil=  View Tools Help

Figure 2-20: New local database
Connect to an older version KPD local database (for the first time)

When you open an older Perception local database* for the first time (i.e. after
upgrading to version 2.4.X), it will be upgraded to the latest format. You will
be prompted as shown in Figure 2-21.

*Note: This is not suitable for SEl files from Perception 0. For details of how
to upgrade an SEl database, please contact GA.support@ge.com or a
GE technical engineer.

Local Data file Upgrade &%

I.-"-_-"- The database you hawe selected was created in an older version of
Y Perception. Do youwant ta upgrade it?

L Yes §[ Mo |

Figure 2-21: Upgrade Local Database Format

If you click Yes, the local database is upgraded to the latest format. A
progress bar indicates progress, but it can take considerable time depending
on the database size. If you click No, the Load operation is aborted.

Note: The upgraded database can no longer be read by previous versions of
Perception. During the upgrade process, a backup copy is created in
the original format, but using “3325” as the file extension instead of
“kpd’ (this number represents the original database schema version
number.) If you wish to use this database for historical/archival
reasons, then it can be read into a previous Perception version.

Before attempting to do so, change the database filename, or move
its location and change its file extension back to “.kpd'.
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3.1

3.1.1

3.1.1.1

ORGANISING ASSETS

Introduction

Upon successful connection to a database, Perception opens on the Database
node showing a Fleet Overview page with a useful summary of the status of

the entire fleet. See Section 3.2 for more details.

If you have opened a new database, then no information will be shown until
you add assets and set up the asset properties. See Section 3.2 and Section
3.8.1.

Transformer Fleet Overview

Risk Index of the o Latest

@ 0:/07/2019 $5:00:21 : GE Trars_Gen 034 located at GE_Gan 03, GE

{30 e ks o et and % o ) From: [t ades [13] | Tot [Sdtadeie [ig]| B

e s condition feoen 1102,

4 froem posttion 33/40 to posiion 2¢/40.

. 03/07/2019 15:00:31 : GE_Trans_Gen_06A located at GE_Gan_ 06, GE

. 01/07/2019 15:00:31 : GE_Trans_Gen_03A located at GE_G=n_09, GE

G 0340772019 15:00:31 2 GE Trars_Gen_O7A located a GE_Gan 07, GE Generation as moved dwn from postion 7/40 L postion 8/40

4~ 01/07/2018 15:00:31 : GE Trans Gen OLA locatad at GE_Gen 01, GE Generation has moved down from postion 11/40 to postion 12140,

. 03/07/2019 15:00:31 : GE_Trans_Gen_11A located at GE_Gen_L1, GE

. 03/07/2019 15:00:31 : GE Trars_Gen_13A bcated at GE_Gan_13, GE Generation has moved dwn from postion 9/40 o postion 10740,

G 00772019 15:00:3) ¢ GE_Trans_Gen. GenLLs,

Average Fleet Risk Index History

L R L O L )

SN R

030772019 15:00:31 - GE Trars_Gen O4A bcated t GE Gen_ 04, GE Generatio s rowed iawn [ postion 15740 Lo psion 16/40.
@ 03/07/2019 £5:00:31 ¢ GE Trars_Gen_02A located a GE_Gen_02, GE Generat
G 0340772019 15:00:31 : GE Trans Gen 024 bocaled a GE_Gan 02, GE Generat

20040,

4 01/07/2019 15:00:31 : GE_Trans_Gen_{SA located at GE_Gen_1, GE Generation has moved up from posttion 20/40 10 positicn 640
G D307/2019 15:00:31 : GE Trans Gen 15A hocaled a GE_Gen 15, GE Generaion changad s condition 1o 2 0 4

L R e e e g

Top Critical Transformers

Trarmer st verven

Figure 3-1: Fleet Overview (only available when connected to Perception Server)

Managing Database Connections

Perception Desktop allows the user to connect to a Perception Server

database or to a local database.

Note: You can only be connected to one database at a time. To connect to
another database requires disconnecting from the current database.

Note: For more details on the advantages of upgrading to a Perception
Server database, please contact a GE sales representative.

Connect to the Server

To connect with a Perception Server database, select File > Connect... as

shown in Figure 3-2.
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3.1.1.2

File | View Tools Actions Help

Connect...

Mew Databaze...

Open Database..

Figure 3-2: Database Connect option

The ‘Login’ dialog box displays as shown in Figure 3-3 with the Server field
populated with the Perception Server if you have connected previously.

Note: If the Server field is not populated or if you wish to change it, see

Section 2.4.1.

[, Login =)
Server: opctopy/lis-2bdpgm 162542 PerceptionServer E]
Authentication: Useriame - ]

User name:
Password:

Figure 3-3: Perception database login

Enter the username, password and click OK.

Note: |If forgotten, contact the System Administrator.

Alternatively, if the Administrator has enabled anonymous access, sign on as
an ‘Anonymous’ user without the need for a user name or password (but with
corresponding Observer status i.e. read-only permissions). This is accessed
via the ‘Authentication’ dropdown menu.

Note: Refer to Section 2.4.1.1if you receive a connection error relating to
trusting certificates.

Disconnect from the Server

To disconnect from Perception Server, select File > Disconnect as shown in
Figure 3-4.
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Connect...

Cisconnect

Mew Database...

Open Database...

Close Database

Exit

Figure 3-4: Disconnect from Perception Server

This action closes the connection to the Perception Server database and
clears the Asset Explorer of all assets.

3.1.1.3 Open a local database

To connect to a local Perception database on your PC, select File > Open
Database... as shown in Figure 3-5.

Connect...

Disconmect

Mew Database...
Cpen Database..

Close Database

Exit

Figure 3-5: Open local database

This displays a list of local databases (those with the ‘kpd’ file extension), for
example, as shown in Figure 3-6.
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Organize New folder
%l Recent Places 4 Name :
- .. Dry-Tx
4 Libraries ] i
= . Examples
b (] Documents
1 Info_sources
p J’ Music
bl . .. PDEM
I k=] Pictures = P ti
. Perception
i % Videos - A
1. Templates
. Transfix
i+ Homegroup :
1% LargeKPD.kpd

4% Computer
b &, Local Disk (C:)
b g PPP (D3)

Date modified

26/03/2011 21:56
26/03/2011 21:56
18/08/2011 21:01
12/08/2011 20:08
06/09/2011 16:57
02/09/2011 17:07
12/08/2011 18:38
06/09/2011 16:47

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder

Perception Local

» =y Media (F) i

1

| »

File name:

- [Local Data File (*.kpd) v]

o

J |

Cancel }

Figure 3-6: Local databases

Select the local database that you wish to open and click Open.

3.1.1.4 Close a local database

To close a local database, select File > Close Database as shown in Figure

3-7.

| File | View Tools Actions Help

Connect...

Disconnect

Mew Database..

Open Database..

Close Database

Exit

|
Figure 3-7: Close a local database

This closes the local database and clears the Asset Explorer of all assets.

3.1.2 Interface

The main screen of the Perception Desktop is divided into two parts as shown

in Figure 3-8.

» The Asset Explorer (denoted by the blue border)

» The Data Area (denoted by the green border)

The Database node is located at the top of the Asset Explorer hierarchy with
all nodes structured below it. Select a node in the Asset Explorer on the left
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3.1.2.1

e.g. GE_Trans_Gen_02A to make it the active node (as highlighted in blue),
and its details display in the Data Area to the right as shown in Figure 3-8.

£, Perception Deskiop
File View Tools Actions Help

- a X
!kun-w

Asset Hierarchy | Ranking
Transfarmer
4 &y detabase GE_Trans_Gen_02A

2 @ e Genestion

5

Main Transformer Details
Serial Number  TRN-073934
Menutecturer | Transakote

Vear of Manufacture 2000

Three Phase ]
Transtormer ype | GSU

il Presenvation Type  Hermetically Sealed

Transformer Management System

Rated Voltage Max. (%) 120 Main Tank Fluid Volume 20000 kg
MNominal Frequency {Hz) 50 MaxMva 220
Temperature Class 0 65 Max Cooling Type | ON A
#p G cen 0o Total PCB Limit (mg/kg) |50 Inhitited (]
4 Gecen 10 Ol type main tank | Mineral Inital inhibitor concentration Default
& = cen 1 _
() More Transformer Details
& o8 Gen_11
& oz en 1) Voltage Sides
s Add
& cecen 12 Number of Voltage Sites 0 |
iy cecen_15 Name  Voltsge (KV) Power Rating 1 (MVA) Power Rating 2 (MVA) Power Rating 3 (MVA] MaxCoofing  BILKY)  Neutral
&y e gen_ 4 () More Voltage Side Details
@) e Distrbution
Compartments
Number of Compartments 0| Add
Name Fluid Type  Fluid Volume Filsation  Filration Instzllation Date

roperties ® | Wallboard % | Dashboard % | DataTable % | status %| 1DCG %] Trend Chart % Key Gas %[ GasRatins %[ Ratios %] ETRA % | Duval's xI

Figure 3-8: Perception Desktop main screen

Asset Explorer

The Asset Explorer uses a tree-like structure to represent the hierarchy of
assets and monitoring devices across multiple areas. Distinct graphical nodes
represent Areas, Substations, Transformer Banks, Transformers, Circuit
breakers and monitoring devices across the entire fleet. This tree-like
structure provides a logical means of organising the assets and a useful
means by which to navigate the hierarchy and find an asset. The Asset
Explorer also features a Search box as shown in Figure 3-9 (left). Type the
first few characters (minimum 2) of the asset name to filter the asset
hierarchy as shown in Figure 3-9 (right).

Asset Hierarchy | Ranking

T CLInTBGZt

w Circuit Breaker_2

Ak Transformer_2
Wt

L

ey MT1-A000333
t§QCtest

Lp

Ly MT1-A000333
% Circuit Breaker_1
* % HydranM2_1

'

I ,lljp: Transformer_3
4

4 "1._'3:’ Transformer_1

H 4-3' HydranM2

"5;1 Transformer_Lisburn

I _‘_'L:E:*Transformer_ﬁll_alarms

Asset Hierarchy | Ranking

i

tranq

4 2 GCIH7BGZE

13"‘"3 Transformer_C1_alarm
13"‘"3 Transformer_All_alarms
13"%3 Transformer_Lisburn
#"j'b Transformer_1
éfm Transformer_3

4 fd% Transformer 2
rE

:'_;{J Transfix 1.6_1

;s_'jh Transformer_1
;‘—I*é Transformer With MultiTank

)
;ng: Transformer_PF_alarm

Figure 3-9: Asset Explorer — Search & results
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3.1.2.2

3.1.3

Click a side right-pointing arrow to expand a node and reveal its hierarchy or
associated monitoring device. Typically an ‘Area’ sits at the top of the
hierarchy, while a ‘monitoring device’ sits at the bottom of the hierarchy.

The asset icons (or nodes) have a status indicator:

= Green Tick: All monitored parameters within bounds. ¢

= Amber Exclamation Mark: A parameter(s) has Bl
exceeded the High or Low thresholds. —

= Red Cross: A parameter(s) has exceeded the “High- i
High” or “Low-Low” or Ratio thresholds. 8

= Purple: Indicates that there is uncertainty in the
latest measurement accuracy, or the latest
measurement is considered to be in error. Refer to
the device data table.

= Blue: Indicates the device has experienced a fault i
and requires a service. -

Note: The device status is reproduced up the asset tree so that the related
Transformer, Substation and Area also reflect the status of its worst
subordinate device.

Data Area

The Data Area shows the corresponding details as calculated or retrieved
from the database for the selected node in the hierarchy. For example, Figure
3-8 shows the details for the transformer GE_Trans_Gen_02A (as selected in
the Asset Explorer).

The relevant data for the selected node is displayed across a series of tabs on
the bottom of the screen (denoted by the purple border in Figure 3-8). The
number and type of tabs vary according to the node. Selecting a tab opens
the relevant tabbed page or worksheet.

The last activated tab opens the next time the node is selected. The default
tab for assets and monitoring devices is Properties.

Note: To remove a tab, click the X’ on the tab. It can be restored via the
View menu, but a custom display tab can only be recreated manually.
See Section 4.4.1.

User Roles (Network databases only)

Perception downloads the sampling data from your monitoring devices and
stores it in a database. The database can be stored on your PC (known as a
‘local’ database), or stored at a remote location when used in conjunction with
Perception Server (known as a ‘network’ database).

Note: A local database can only be accessed by users of that PC.
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When used in conjunction with Perception Server, there are three user roles:

= Observer: ‘Read-only’ permissions to view the data of all devices, but cannot
make any changes to the data or device settings.

= Supervisor: ‘Read-write’ permissions, so can alter device settings including
deletion of a device.

= Architect: All the Supervisor permissions plus the rights to manipulate
workflows including scheduling workflows.

Note: A user of a local database always has full permissions for that
database.

The User role for network databases is controlled by the Administrator of
Perception Server. A Supervisor or Architect role can make changes that
affect all users of the database. They can alter the data upload schedule,
change the device hierarchy and delete devices and data. Therefore, it's
important to restrict the assignment of such roles to those that need this
functionality and can be trusted with these permissions.

Wherever the database is stored, local or network, it is the Perception
Desktop application that downloads the data from the monitoring devices,
whereas Perception Server is used to manage access to a network database.
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3.2 Managing Assets

You use the Asset Explorer to manage the network of assets and monitoring
devices.

Note: A Supervisor role (or higher) allows you to create, move and delete
assets and devices (if used in conjunction with Perception Server).
Those changes will then be visible to all other users of the database
at the next refresh (normally within a few seconds).

3.2.1 Adding Assets

To add a new node to the hierarchy, right click on the node under which the
new node will sit and select New as shown in Figure 3-10. You have the
option of adding a new Area, Substation, Plant, Transformer, Transformer
Bank, Circuit Breaker, Motor or a variety of monitoring devices.

Asset Hierarchy

L= ' @ Area
# Substation
‘ Plant

v o
i Transformer

q'& Transformer Bank
W Circuit Breaker
& Matar
&l Transfix 1.6
Ll Transfix 1.5
&l TapTrans
tl MultiTrans
til DualTrans
‘sl DGA 500
- DGA 900
= Kelman DGA 900 PLUS
= Kelman DGA 900 MULTITRANS
= Kelman DGA 900 TAPTRANS
fl MiniTrans
i Hydran M2/M2-X
5 Hydran201ti
g wvoiso
*'E BMT 300/330
B wvs 3000
&) 345 Relay
&) £60/859 Relay
i Kelman BMT430

Figure 3-10: New nodes

Plant is available by default as shown above, while support has been added
for GE’s Multilin 845 transformer protection relay running firmware version 1.7
or later, Multilin 850 Feeder protection relay running firmware version 1.7 or
later and Multilin 869 Motor protection relay running firmware version 2.00 or
later.
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Note: An additional installer is required to create 8 series relays. (Contact a
GE sales representative to avail of this functionality.) 8 series relays
are supported only in Perception Fleet.

Motor and Circuit Breaker assets are created at the same level in the asset

hierarchy as a Transformer and behave in a similar manner. The 869 relay

device is the only child of the Motor that can monitor a Motor asset. The 850

relay device can only be added as a child of a circuit breaker.

The 845 relay device can be added as a child of a transformer allowing users
to compare the data received from the relay with other monitored transformer
data using the transformer worksheets.

For assets and monitoring devices, complete their properties via the
Properties tabbed page as shown in Section 3.8.1.
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3.2.2 Renaming Assets

To rename an existing asset, right click on it and select Rename as shown in
Figure 3-11.

Asset Hierarchy | Ranking

4 (L UIS-4K30ZW1-ER

i % GE Generation

4 @ GE Distribution
[ 4

Mew 4

Celete

Rename

Wallboard...

Export..,

Figure 3-11: Rename a node

3.2.3 Deleting Assets

To delete an asset, right click on it and select Delete as shown in Figure 3-12.

Asszet Hierarchy | Ranking |

4 [ LIS-4K30ZW1-EB

]
(.
£ E104 New b
4 % GEQ Delete
b = I |
ﬁ“ Rename
4
uﬁ: Wallboard...
4 4 =iy
= Export...
prsfix
Report b
(B —

= B
Figure 3-12: Delete a node

Warning: This action will delete the asset from the database
entirely, including all data downloaded from that device.

subordinate assets. If you are reorganising the hierarchy into new
groupings, ensure that you move all the subordinate assets to new
areas within the Asset Hierarchy before the deletion of a grouping.

if Warning: The deletion of an asset will also delete all its

Before the asset is deleted, you must confirm your action as shown in Figure
3-13. Click Yes to delete the asset or No to cancel the operation.
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Confirm Delete ——

:I Are you sure you want to delete Areal 7

Figure 3-13: Confirm Delete

3.2.4 Moving Assets

The nodes in the Asset Hierarchy can be grouped using drag-and-drop
methods. You can move individual nodes, or move a tree of nodes under
another node in the asset hierarchy, depending on the hierarchical level
selected.

To move a node, rest the mouse pointer over the node, then click and hold the
left mouse button. Drag the node to its new position in the hierarchy before
releasing the left mouse button.

Before the node is moved, you must confirm your action as shown in Figure
3-14. Select Yes to move the node or No to cancel the operation.

Confirm Move S

| Are you sure you want to move Transformerl?

Figure 3-14: Confirm Move
In the example shown in Figure 3-14, the asset “SubStation1” has been moved

from the same level as “Areal” to a subordinate level under “Areal” (denoted
by the indentation).

4 &F test 4 & test

Wiiads ) | O
&

Figure 3-15: Asset Explorer drag and drop
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3.3 Fleet Overview

If you select the top-level database node in the Asset Explorer, a Fleet
Overview page displays with useful information summarising the health of the
entire fleet as shown in Figure 3-16.

Transformer Fleet Overview

Risk Index of the

Latest Fvent. Top Critical Transformers

Average Fleet Risk Index History

0 the b f aeedomars ad 6 f st

23 2 3 2 0 5 T2 e 29 g 0 o> O

QRS GRS RS

S [t adae [ o[t o e (33

@ 03/07/2019 15:00:31 ¢ GE Trans_Gen 004 located at GE_Gan 03, GE =l
0300772019 15:00:31 : GE Trars Gen (4A bxaled a GE_Gan 04, GE Generat

. 0:/07/2019 15:00:31 : GE_Trans_Gen_03A kocated at GE_G=n_09, GE'
4 01/07/2018 15:00:31 : GE Trans Gen OLA Jocatad at GE_Gen 01, GE Generation has moved daw from postion 11/40 to postion 12/40.
. 03/07/2019 15:00:31 : GE_Trans_Gen_11A located at GE_Gen_L1, GE
4~ 01/07/2018 15:00:31 : GE Trans Gen_13A ocatad at GE_Gen_L3, GE Generation has moved dow from £ostion 9/40 to postion 10/40.

G 010772019 15:00:3) ¢ GE_Trans_Gen. GenLLs,

. 03/07/2019 15:00:31 : GE_Trans_Gen_1SA located at GE_Gan_15, GE Generation has moved ug from posttion 20/40 10 positon 640,
G D3/07/2019 15:00:31 : GE Trans Gen 154 bocaled al GE_Gen 15, GE Generation changad s Condition 10 2 0 4 =

E T U7 0 T e 2 T 7 Y

Tranomer et Cverven %

Figure 3-16: Fleet Overview

You can search for specific monitoring events using keywords in the Event
Search box located at the top of the Fleet Overview page as shown in Figure
3-17. If you enter the name of an area, plant, substation or transformer, you
will obtain all related transformer events for that area, plant, substation or
transformer. Use the ‘Navigate to Asset’ link (as highlighted below) to navigate
directly to the affected asset in the Asset Explorer. Use the Date boxes to
filter events by date or click More to filter the search by event type as shown

in Figure 3-17.

Latest Transformer Events

# More...

Select All
Download Failure
Concentration Alarm Raised
Ratio Alarm Raised
Bad Data
Ranking Condition Change
Ranking Algorithm Updated

ol From: | Select a date 15| | To: | Select a date @

Communication Failure
RoC Alarm Raised

Service Alarm Raised
Ranking Position Change
Digital Alarm Raised
Ranking Algorithm Added

i
LN
i
Lo N
<
-

Clm

03/06/2018 10:33:51 :
03/06/2018 10:33:50 :
03/06/2019 10:33:50 :
03/06/2018 10:33:50 :
03/06/2018 10:33:50 :
03/06/2018 10:33:50 :

NAMNAIINIA 1216

GE_Trans_Gen_03A located at GE_Gen_03, GE Generation has moved up from position 17/41 to position 12/41.
GE_Trans_Gen_03A located at GE_Gen_03, GE Generation changed its condition from 3 to 4,

GE_Trans_Gen_04A located at GE_Gen_04, GE Generation has moved down from paesition 15/41 to position 16/41.
GE_Trans_Gen_14A located at GE_Gen_14, GE Generation has maved down from pasition 13/41 to position 14/41.
GE_Trans_Dis_120B located at GE_Dis_120, GE Distribution has moved down from position 14/41 to position 15/41.

GE_Trans_Dis_114A located at GE_Dis_114, GE Distribution has moved down from pesition 16/41 to position 17/41,

+ 3F Trane Mic 1157 laratad 24 GF Nic 115 GF Nictributinn has mevad dnum fram nncitinn 177471 $1 macitian 120601

@ure 3-17: Event Search

Note: A similar Fleet Overview page exists at the database node level for

Circuit Breakers.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3

22-Oct-24 Page 43 of 220



3.4

3.5

Areas, Plants & Substations

Assets can be arranged hierarchically in the Asset Explorer under Areas,
Plants and Substations. Areas, Plants and Substations contain just one tabbed
page called a Wallboard. A Wallboard is a visual overview of all assets and
their status shown on an image, typically a map. A Wallboard can be
configured for an Area, Plant, Substation, Transformer Bank, Transformer or
Circuit Breaker. An example of an Area wallboard is shown in Figure 3-18.

Note: A Plant represents a large industrial site where one or more
Transformers or Motor assets reside. A Motor asset is a child asset of
a Plant.

Percaption Desttcp
Tde Vorw Tooh Actons el .
ot oty

cRRBRRAparprr

[

Figure 3-18: Area wallboard example

If used in conjunction with Perception Server, a Wallboard becomes a useful
way to continuously monitor assets, for example, in a control room scenario.
Perception Server facilitates a dynamic picture that updates as the condition
of the assets change during automatic data download. See Section 3.10 for
more information on setting up a Wallboard.

Transformer

Within a typical Asset Hierarchy there are multiple assets, such as
Transformers and their monitoring devices. If you select a Transformer, a
series of tabs display in the tabbed list at the bottom of the Data area. The
default active tab is Properties as shown in Figure 3-19, but the asset opens
on the last activated tab for the asset. See Section 3.9.1 for populating
Transformer properties.
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3.5.1

Main Tansformer Details

B

S RRRRRRERRRE

Y Y Y Y Y Y YT Y.

Figure 3-19: Transformer > Properties

Dashboard example showing MINITRANS

Select the Dashboard tab to display a page with useful information
summarising the measurement data and ranking history for an individual
transformer via two sub tabs - ‘Devices Summary’ and ‘Ranking Graph’, as
shown in Figure 3-20.

The Dashboard tabbed page opens on the Devices Summary sub-tabbed
page of the Transformer asset as shown in Figure 3-20. This lists each device
monitoring the asset on a separate panel with summarised results from the
various monitoring functions and an overall risk assessment. In this example,
Transformer 02A has just one monitor, a MINITRANS device, attached.

Pascaption Deskicg - 8 x
Fle Vew Tooh Adors Weo g

YT YT YYITYY Y

Figure 3-20: Transformer > Dashboard > Devices Summary — MINITRANS
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3.5.2

Select the Ranking Graph sub tab to display the Risk and Ranking History as
shown in Figure 3-21.

Risk and Ranking History

RNV AN A NI
R T S S Y S S S S—

&

FYYYYY.

Figure 3-21: Transformer > Dashboard > Ranking Graph — MINITRANS

Dashboard example showing Intellix BMT 330

The device summary for an Intellix BMT device is shown in Figure 3-22.
Depending on the inputs, there are multiple tabs, Primary Input (HV) and
Partial Discharge (an additional tab is shown if the Secondary Input is in use
e.g. Low Voltage).

Propetties X | Walboard X Dash *|DaaTaple x|Staus x| TDCG 3 | Trend Char 3 | KeyGas 3 | Gas Rat R ETRA D

Figure 3-22: Transformer Dashboard > Devices Summary - BMT 330

In the example shown in Figure 3-23, the Primary Input labelled HV displays
the following information:

= BMT device ID and Last Measurement timestamp
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= A graphic summary of the bushing input set; namely AC1(%) (the imbalance
of the displacement current amplitudes at the test taps of the three
bushings, see Section 4.17 Bushing Monitor), and the angles ZAB(°) and
ZAC(°) (the test tap currents Inter-Phase Angles, see Section 4.20).

= An extended numerical overview of the bushings’ status.

HV €2 | Partial Discharge €2 |

QC test Last Measurement

Intellix BMT 300/330 18/01/2019 17:57

SN# 1234

AC1(%) <A-B(°) <A-C(°)
10~ - 0.8 - +0.8- -

+0.5° +0.5-

119.84
- P 120,01~ 3 .119.99~
| 3.5

-05° 05 |
i all -

............ i SRS SOOI ... YN
Phase A B C
Bushing B1 B2 B3

Capacitance
Nameplate C1 (pF) 488.50 491.30 489.10
Expected Ampl. (mA) 4430 44.56 4436
Measured Ampl. (mA) 4416 46.18 4479
Estimated™ C1 (pF) 486.93 509.21 493.88
Insulation

Nameplate tan 8/PF (%) 0.17 0.19 0.18
Expected Angle (%) 0.00 120.01 -119.99
Measured Angle (*) 0.00 120.03 -119.84
Estimated* tan &/PF (%) 0.7 0.22 046

* Estimated values based on the measured bushing leakage current amplitude and inter-

bushing phase, and the bushings nominal operating voltage and inter-phase angles.

Figure 3-23: BMT 330 Device Summary > Primary Input (HV)
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In the example shown in Figure 3-24, the Partial Discharge tab displays the
following information:

» The Last Measurement timestamp

» A graphic summary of the Partial Discharge activity for all three Primary
Inputs namely PDI (mW) (the Partial Discharge Index) and the PD Avg. (pC)
(Average Partial Discharge Apparent Charge) for all three inputs. See
Section 4.18.

=  An extended numerical overview of the PD status.

i HV

€ | Partial Discharge €2

Last Measurement
18/01/2019 14:12
A A B B C C
PDI (mW) PD Avg. (pC) PDI (mW) PD Avg. (pC) PDI (mW) PD Avg. (pC)
2000- M 2000- 200- A 2000- 2000- M s000- A
1000~ 1000~ 1000 1000~ 1000 1000~
828 839
525
o- ——-s02 e o- 93 o . o- W D43 &
46.20 mW 828 pC 99.30 mW 525 pC 134.30 mW 839 pC
Pa scharge
Phase A B C Imbalance
Events/cycle 3479 336 3429 1.03
Qave (pC) 828 525 839 308.65
s ng Qmax (pC) 1667 31607 32360 30323.51
PDI (mW) 46.2 99.3 1343 76.83
Figure 3-24: BMT 330 Device Summary > Partial Discharge
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3.5.3

Dashboard example showing MS 3000

The device summary of an MS 3000 device is shown in Figure 3-25.
Depending on the inputs, there are multiple tabs — Load currents, deltaC,
Ageing, Gases & Moisture, Tap changer1 and Temperatures.

Rl Test_5_max

Load currents €2 deltaC €3]  Ageing ©2 | Gases & Moisture €2 | Tap changer 1 €2 | Temperatures i |

Last Measurement

Rl Test_5_max
28/10/2019 10:16:50

MS 2000
SN2 10101010_5_9

RI Test_5_max

HVPhi (A} HVPhZ(A) HVPh3 (A} MVPhi(A) MVPhZ(A) MVPh3(A)

0 =0 0 =0 o- = 0 =0 0- == 0 =0
0.0A 0.0A 0.0A 0.0A 0.0A 0.0A

Figure 3-25: MS 3000 Device Summary

Perception downloads and visualises the Risk Index results along with the
other data stored on the MS 3000. The Risk Index results are calculated
directly on the MS 3000 monitor running master template 3.6.4.22p0_
3.2.2.13p0_4.5p0 or later.

Perception can be configured to use and display only the Risk Indexes
downloaded from the MS 3000, or only the Risk Index calculated in Perception
or a combination of both. When both Risk Index options are configured,
Perception automatically selects and displays in the most critical Risk Index
result and information regardless of its origin.

Figure 3-26 shows how to assign the MS 3000 Risk Index workflow to the
transformer so that the MS 3000 device’s onboard Risk Index can be utilized.
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3.6

(¥) More Voltage Side Details

Compartments
Number of Compartments 0 | Add
Name Fluid Type Flud Volume Filtration Filtration Instaliation Date

Transformer Management System

Is this 3 TMS?
Criticality Details
Process/Delivery loss (%) |50 Transformer supplier currently in operation [
PCB level (ppm) (0 Spare parts available | Yes
Access for minor repaxr | Direct v Physical location | Close to public
Access for major repair | Major rebuild v Oil containment system [V

Strategic spare | No spare

Workflow Associations
Auto criticality cakulation [V Manual criticality (%) Offiine Algonthm Standard | 1EC
Workflows Weight Ranking Influence
Rl TestBushing
DGA Standard 07 Normal
Ri TestRisk Index | MS 3000 Risk index v 1 Normal
DGA Standard

Bushing Standard

Semplif GA

Properties X |Welbosrd X | Dashbol S Pified DGA
| DGA Standard OLTC (Non-Vacuum)

| Simpified DGA OLTC

= R CFine DGA 3nd Oil Quaiity
= | B 15 5000 Risk Index

Figure 3-26: Transformer > Properties > Workflow Associations

TOCG % | Trend Chart X | Bushing Monitor X | Partial Discharge !

Risk Index data downloaded from the MS 3000 can be exported and imported
via the existing mechanism as outlined in Section 5.

Transformer Bank

A Transformer Bank is a grouping of single-phase transformers and their
associated monitoring devices under a single visual entity in the Asset
Explorer and is represented on the Area wallboard as a single node.

A Transformer Bank is treated the same as any other asset in that data can be
imported/exported, alarms raised etc. An alarm status (and email notification)
on any child asset propagates up to represent the status of the entire
Transformer Bank with the most significant alarm determining the overall
status of the Transformer Bank. A new Transformer Bank asset can be added
to the Asset Hierarchy under an Area or Substation node. Right click the
desired node and select New > Transformer Bank as shown in Figure 3-27.
See Section 3.9.2 for populating Transformer Bank properties.
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3.7

Asset Hierarchy | Ranking

4 L5 00030
I GE Generation
1

e 4 o Arez
Delete

- Substation
Rename U Transformer

Export ‘ g Transformer Bank

* Circuit Breaker

&l Transfix 1.6

o Transfix 1.5

ol TepTrans

&l MultiTrans.

! DualTrans

{ DGA 500
DGA 900

[l MiniTrans
‘=¥ HydranM2

3 Hydren2014
0 voiso

“§ BMT 200330
B s 3000

Figure 3-27: New > Transformer Bank

Circuit Breaker

A Circuit Breaker is another type of asset that can be added to the hierarchy.
When a Circuit Breaker is selected in the Asset Explorer, a similar tabbed list
of worksheets displays below in the Data area to the right. The default active
tab is Properties as shown in Figure 3-49. See Section 3.9.3 for populating
Circuit Breaker properties.

Circuit Breaker

4 4 GDIKPGC2E
Al Transformer Bank 1
4 P wes2

4 L substation 1

|

Circuit Breaker_1

Main Circuit Breaker Details

a i‘— Transformer 1 Serial Number Model

‘ vl emT 30072301 Manufacturer Type -

4 Year Installed Type of drive -

';i] CB Watch 1 Rated Voltage Max. (kV) Number of drive motor/pump -

i, Transtormer_1 Rated continuous current (kA) Tpeofdiemator [«

L} vr1-00033 Total weight of SF6 in Kg Number of SF6 compartments :}
@ Testrea

Workflow Associations
Workflows Weight Ranking Influence
CB Watch 1 ~

Properties % ‘WaHbDard K| Dashboard xl Data Table % | Status X | Trend Chart X‘

Figure 3-28: Circuit Breaker properties

Select the Dashboard tab to display a page with useful information
summarising the measurement data and ranking history for an individual
circuit breaker via two sub tabs - ‘Devices Summary’ and ‘Ranking Graph’, as
shown in Figure 3-20.

The Devices Summary for a Circuit Breaker asset is shown in Figure 3-29. This
lists each device monitoring the asset on a separate panel with summarised
results from the various monitoring functions and an overall risk assessment.
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Asset Hierarchy | Ranking

<

§ Circuit Breaker Overall Risk Index @ Maintenance Required

a2

—

m

2 | Device Name 2033129701 Last Measurment 11.02.2019 12:55:52

™ Device Type CBWatch Current position Problem with 52A4/B contacts
SN# 2033139701 Number of operations 6
Host name CBW?3 DL20 Date last operated 15.01.2019 16:35:48
Moenitoring function Pole A Pole B Pole C Total

Operational timing Risk Index 3 3 3 3

SF6 gas levels Risk Index 5 N/A N/A 5
- = -
Arcing contact wear Risk Index 1 1 1 1
Control Circuit Risk Index 3 3 3 3
Stored energy system Risk Index 5 5 5 5
. - e .
Heaters Risk Index 1

Raniong Graph

Devices Summary

Properties % | Wallboard X/ Dashboard % |[DataTable X |Status X | Trend Chat X

Figure 3-29: Circuit Breaker asset — Devices Summary - CB Watch 3

The CB Watch 3 monitoring device is not limited to downloading risk index
and alarms data, but can also download data on the opening, pumping and
closing operations, as well as the continuous measurements of the circuit
breaker as shown in Figure 3-30. Perception regularly polls the CB Watch 3
device and checks if an operation has occurred. If there has been an
operation, Perception then downloads the recent opening, pumping and
closing data. Irrespective of any operation taking place, the continuous
measurement data and risk index data is always downloaded and stored every
four hours. The user can configure fast polling of the circuit breaker to allow
CB Watch 3 to obtain the latest data. The polling interval will depend on the
customer network, number of devices etc.
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Asset Hierarchy

4 =

4 & Area_1
4 @A Plant 1

I *’ Transformer Bank_1

- % Motaor_1
El_ MJ3A18002289 860 Relay

4 "1‘:;3 Transformer_1
i BvT 30053302
" BMT 300/330_1
@ MJTAT16000051 845 Relay

E MS 3000

o % Substation_1

"% DGA 900 Plus_1

* Circuit Breaker_2

i__'Lu Transfix 1.6_1
I "15;-\, MS3000_Risk_Index_3_max
I ;:;3 Transformer_2
4 % Circuit Breaker_1

8 023331702 DG

Measurement Point Status
Heaters Risk Index

Overall Risk Index
Cpening Operation Data
+ Pole A
+  Pole B
+  Pole C
Coil circuit DC valtage source 1
Coil circuit DC voltage source 2
Qutside ambient temperature
Pumping Operation Data
+ Pole A
*  Pole B
H Pole C
Closing Operation Data
+ Pole A
+  Pole B
H  Pole C
Coil circuit DC valtage source 1
Outside ambient temperature
Continous Measurements
= Position 52a/52b Contacts
*  Pole A
*  PoleB
+  PoleC
= Gas
*  Pole A
*  PoleB
*  PoleC
= DC Voltage
Coil circuit BC voltage source 1
Coil circuit DC voltage source 2
= Temperature Sensors
Cutside ambient temperature
Temperature 2
Temperature 3
Temperature 4
Temperature 5

Temneraturs A

Timestamp

14/07/2020 11:48:52

18/03/2020 10:17:38
18/03/2020 10:17:38
18/03/2020 10:17:38

20/05/2020 06:20:22
20/05/2020 06:20:22

14/07/2020 11:48:52
14/07/2020 11:48:52

14/07/2020 11:48:52
14/07/2020 11:48:52
14/07/2020 11:48:52
14/07/2020 11:48:52
14/07/2020 11:48:52
14072020 11:48:57

Properties X | Wallboard X | Dashboard X | Data Table | Status | Trend Chart X

Figure 3-30: Circuit Breaker asset — CB Watch 3 — Status worksheet

3.8 Motor

Current Value

4

380V
220V
21.0°C

380V
320°C

320V
340V

26.0°C
20°C
30°C
40°C
50°C
AT

A Motor is another type of asset that can be added to the hierarchy. A motor
is organised under a Plant and parents a Motor protection relay. The Multilin
869 relay is a microprocessor-based unit designed for the protection, control,
and management of induction and synchronous motors. Base relay models
provide thermal overload and overcurrent protection including current and
voltage-based backup functions.

When a Motor is selected in the Asset Explorer, a similar tabbed list of
worksheets displays below in the Data area to the right. The default active tab
is Properties as shown in Figure 3-31. See Section 3.9.4 for populating Motor

properties.
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€ GE_Plant Motor_01

Asset Hierarchy
Motor
4 test |GE_Plant_Motor_01
. [
GE_Plant_ Moter_1_369 Mator Details
SeralNumber [ ] Motor Full Load Amps (&) [ ]
b Area 1
Manufacturer [ ] Motor Overioad Factor | ]
© R Pant2
VearofManufacture [ ] Motor Horsepower | ]
Rated VoltageMax.(0) [ | RatedSpeed | ]
Nominal Frequency (Hz) Numberoffoles [ |
Motorsuply | | Max AccelerationTime | |
eartpe [ ] e —
< >

Properties % |Wallboard % | DataTable 3| Dashboard | Ststus 3| Trend Chart % | Trend Chart % | ESADats % | ESA Circle Chart % | Bresker Dats % | LDR Data nl

Figure 3-31: Motor properties

As well as data downloaded from the 869 motor protection relay, motor data
can also be imported using the CSV file import mechanism.

Note: The motor asset is enabled as part of the 869 protection relay
support. The 869 relay is the only available child device that can be
added to a Motor asset.
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3.8.1 Dashboard example showing Plant Motor (869 Relay)

Select the Dashboard tab to display a snapshot of the most relevant and
important information gleaned from the Motor asset via Multilin 869 relay

device. Data is grouped across a series of subtabs — Events, Latest Events,
Motor Start and Breaker Data.

The Dashboard tabbed page opens on the Devices Summary Events sub-
tabbed page of the Motor asset. The Events section shows the frequency of

events captured on the 869 relay grouped by event type as well as an event
count per month as shown in Figure 3-32.

Asset Hierarchy

4 59 test
1 W, GE_Plant_Breaker_1
b GE-Plant-Trans-01-845-1v

4 kg, GE Plant Mator 01
G Pl Moror 869 || (©
Relay 869 - GE_Plant_Motor_1_869 - SN: MJ3A18002299

&P Area 3

I I. Plant.2 - 1&5‘ Events | Motor Start | Breaker Data
2
s Available Time Range:
] 02/03/2021 22:56 - 24/11/2021 15:44
S Events / Month
5
9

180
100
23
—_—z 2 . - o 0 0

Events / Type

2902

Devices Summary

Properties ¥ | Wallboard | Data Table talus #| Trend Chart % | Trend Chart % | ESA Data ¥ | ESA Circle Chart X | Breaker Data ®| LDR Data X

Figure 3-32: Plant Motor Device Summary

Figure 3-33 shows the Latest Events tabbed page. The Latest Events section
lists the most recent event records in reverse chronological order.

—
~

GE_Plant_Motor_1.869 (~)

Relay 869 - GE_Plant_Motor_1.869 - SN: MJ3A18002299

Events Latest Events | Motor Start | Breaker Data

Timestamp Description
24/11/2021 15:44:54  Ph 1OC 1 Trip PKP
24/11/2021 15:43:54 Ph1OC 1 Trip PKP C
24/11/2021 15:42:54  Ph IOC 1 Trip PKP B
24/11/2021 15:42:54  BKR1 Opened (BKR1 Opened)
24/11/2021 15:41:54  Ph 1OC 1 Trip PKP A
24/11/2021 15:40:54 PhIOC 1 0P
24/11/2021 15:39:54  Ph I0C 1 OP some new
24/ 21 15:38:54 BKR1 TOC Opened (EKR1 Opened)
24 21 15:38:54 BKR1 Opened Clear Event Rec
24/11/202115:37:54 Ph QC 1 Trip PKP

Figure 3-33: Motor > Dashboard > Latest Events
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Figure 3-34 shows the Motor Start tabbed page. The Motor Start tabbed
page plots the Acceleration Time (Ms), Effective Current (x FLA) and Peak
Current (x FLA).

Relay 869 - GE_Plant_ Motor 1869 - SN: MJ3A18002299

Events Latest Events|  Motor Start | Breaker Data |

Acceleration Time (ms) Effective Current (x FLA) Peal Current (x FLA)

GE_Plant_Motor_1_869

1120

BT R
II I“"7

Figure 3-34: Motor > Dashboard > Motor Start

Figure 3-35 shows the Breaker Data tabbed page. The Breaker Data tabbed
page presents two pie charts summarizing Breaker Arc Energy (kA2-Cycle)
and Breaker Arc Time (ms) per phase.

Relay 869 - GE_Plant_Motor_1_869 - SN: MJ3A18002299

Events | Latest Events | Mator Start | Breaker Data

Breaker Arc Energy (kA2-cycle)

GE_Plant_Motor 1.869 (~)

® Avg. of Ph A Arc Energy
@ 2vg. of Ph B Arc Energy
Avg. of Ph C Arc Energy

Breaker Arc Time (ms)

|S

Figure 3-35: Motor > Dashboard > Breaker Data

@ Avg. of Ph A Arc Time
@ Avg. of Ph B Arc Time
Avg. of Ph C Arc Time
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3.9 Setting up Asset Properties

Transformers, transformer banks, circuit breakers and devices have several
properties that are configured using the Properties worksheet.

3.9.1 Transformer Properties

When a transformer is selected in the Asset Explorer, the data area to the
right lists all the worksheets (on the bottom) of which the Properties tab is
first as shown in Figure 3-36. Since transformers do not have data that can be
automatically downloaded, the transformer properties must be manually
entered here.

/. Perception Desktop

File View Tools Actions Help @
GE Digital Energy

Asset Hierarchy |Ranking |
4 (£ Us-4K30zW1-ER "
g vorso1 m:rm GE_Trans_Gen_13A

4 Hydran201ti_1

1 Transformer

'
I ﬁa Transformer_2

L Main Transformer Details
I Transformer_1

. Serial Number Three Phase
2} HydranM2. .
| & 72000000 Manufacturer Transformer type -
+ @k GE Generaton Vear of Manufacture Oil Preservation Type ~|
&, Ge Gen 11 Rated Voltage Max. (kV) Main Tank Fluid Volume ( -
4 HL GoGems Nominal Frequency (Hz) | ~| Max MVA
1 — —— 3
4 P GETrans Gen 134 Temperature Class (C) - Max Cooling Type | ) % 1
5 Troen-Transfix Total PC8 Limit (mg/kg) Inhibited (@
\
! {4 GETrans Gen 138 Initial inhibitor concentration
& GE_Gen_12
~) More Transformer Detail
& ce.en1s ore Transformer Details
&, GEGen 14 Model Name Rated Amps (4) MVAR Max ":‘_’"“95
SRS rimary
+ @ e Distibution Owner Name Designation MVAR Reserved Ph
Welded Cover [ Part Number MW Actual BhA:
Eauipent Rewisis Cormplianes MW Max Ce:
Equipment Description MVAR Actual MW Reserved hic:

m ]

N
Properties % ‘ V)Hboard x® | Data Table | Status ll TDCG Kl Trend Chart Kl Key Gas % | Gas Ratios xl ETRA Xl Duvals * ‘

Figure 3-36: Transformer properties

The Transformer properties fields depend on whether the connection is to
Perception Server or a local KPD database file. For example, there is no
Workflow Associations section for a local KPD database file. The sections
within the Properties worksheet are explained below.

= Transformer Name

The Transformer Name is a free text field where you can change the default
name and enter more descriptive text as shown in Figure 3-37.
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Transformer

Transformer_l

Figure 3-37: Transformer name
»= Main Transformer Details

The main transformer name plate details are entered in Figure 3-38 and allow
the identity and corresponding details to be stored in the database.

Main Transformer Details

Serial Number Three Phase
Manufacturer Transformer type l -7 ]
Year of Manufacture Qil Preservation Type l ']

Rated Voltage Max. (kV) Main Tank Fluid Valume :]
Nominal Frequency (Hz) :] Max MVA
Temperature Class (“C) :] Max Coaoling Type l V] l V]

Total PCB Limit (mg/kg) Inhibited

Initial inhibitor concentration

| More Transformer Details

Model Name Rated Amps (4) MVAR Max

Cwner Name Designation MVAR Reserved

Welded Cover [l Part Number MW Actual
Equipment Remarks Compliance MW Max
Equipment Description MVAR Actual MW Reserved

Figure 3-38: Main Transformer Details

Scroll to the right to enter primary, secondary and tertiary Bushing details as
shown in Figure 3-39.

Bushings
Primary Secondary Tertiary
Phase Mame Bushing Model Phase Name Bushing Model Phase Name Bushing Model
Ph A: Ph A: Ph A:
Ph B: Ph B: Ph B:
PhC: PhC PhC:

Figure 3-39: Bushings
= Voltage Sides

The Voltage Sides section as shown in Figure 3-40 allows information on the
transformer’s Voltage Sides to be stored in the database. To add a Side to the
description, click the Add button.
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Voltage Sides

Number of Voltage Sides 2 | Add || Remove |

Mame Voltage (kV) Power Rating 1 (MVA) Power Rating 2 (MVA) Power Rating 3 (MVA)  Max Cocling BIL (kV) Meutral
Voltage side 1 (= =}
Valtage side 2 -~ =]
| More Voltage Side Details
Mame Phase Displacement Electric Shield Ground Resistance (O} Impedance (%) Impedance Base (MVA) KW Rating MVA Rating Rated Amps (4)
Voltage side 1 ]
Voltage side 2 ]

Figure 3-40: Voltage Sides
= Compartments

The Compartments section as shown in Figure 3-41 allows information on the
transformer’'s compartments to be stored in the database. To add a
Compartment to the description, click the Add button. To remove a
Compartment, click on the compartment line to be removed and click the
Remove button.

Compartments
MNumber of Compartments 3 [ Add | [ Remove
Mame Fluid Type Fluid Yolume Filtration Filtration Installation Date
Maintank 0o [Select a date 35—|
Selector 0o | Select a date E |
Diverter 0 | Select a date E |

Figure 3-41: Compartments
= Criticality Details

The Criticality Details section as shown in Figure 3-42 allows additional
information to be stored about the transformer, such as its physical location
and the availability of spare parts. These properties may be unique critical
factors or more general transformer characteristics or observations, but
nonetheless could have a bearing on risk. The Criticality Details are used by
the fleet ranking algorithms for a better risk assessment and more accurate
transformer rankings.

Criticality Details

Process/Delivery loss (%) 50 Transformer supplier currently in operation
PCE level (ppm) 0 Spare parts available [‘f’es v|
Access for minor repair [Direct - | Physical localtion [Close to public A |
Access for major repair [Major rebuild v| Cil type main tank [Mineral v|
Strategic spare [No spare = | Cil containment system

Figure 3-42: Criticality Details
» Workflow Associations

The Workflow Associations section as shown in Figure 3-43 contains settings
that are applied at the workflow level. The top line fields control how the
Criticality Details influence the calculations. The default is to use an ‘Auto
criticality calculation’, but this can be changed to any percentage (0-100%).
The bottom field specifies the workflow associated with the transformer and
the weighting of that workflow on the transformer calculations. Note: Click
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3.9.2

‘Remove’ to remove a workflow association. The Ranking Influence field allows
you to control the magnitude of effect that the transformer measurement
parameters have on the data analysis through a sliding five-point scale. The
default is ‘Normal’, but you can also minimize the effect by selecting ‘Extra
Rough’ or maximize the effect by selecting ‘Extra Sensitive’.

Workflow Associations
Auto criticality calculation [l Manual criticality (%) Offline Algorithm Standard | IEC =
Workflows Weight Ranking Influence
13A-Gen-Transfix: MAIN [DGA Standard vl [Normal vl [ Remave l

Figure 3-43: Workflow Associations

The next step is to add the monitoring devices that are associated with the
transformer. See Section 3.2.1 and Section 3.9.5.

Note: Transformer measurement data can also be imported via a TOA
formatted CSV file (See Section 5.1).

Transformer Bank Properties

The Transformer Bank’s Properties worksheet allows the user to configure
phase associations as shown in Figure 3-44. Phase associations allow the
user to assign a transformer to its respective phase.

Transformer Bank
% Transformer Bank_1

Main Transformer Details

Serial Number Transformer type l 'l
Rated Voltage Max. (kV) Max MVA
Nominal Frequency (Hz) x Max Cooling Type [ 'I [ ']
Temperature Class (°C) 4 Inhibited

Voltage Sides
Number of Voltage Sides Add Remave

MName Voltage (kV) Power Rating 1 (MVA) Power Rating 2 (MVA) Power Rating 3 (MVA)  Max Coaling BIL (kV) MNeutral

v | More Voltage Side Details

Phase Association

Transformer Bank Phase Configuration Add

Phase A\ Qil Source A Phase B\, Qil Source B Phase C\ Qil Source C Association date

TRN Phase A TRN Phase B TRN Phase C | Remove

Figure 3-44: Phase Associations

Each phase configuration automatically creates an annotation at the
association date in the Data Table and Trend Chart worksheets when you rest
the mouse on the relevant timestamp as shown in Figure 3-45 and Figure
3-46.
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From |selectadote  [13) | Tor | selectacate  [33)|roves Duees

MT1-A000333:SOURCE 1: MT1-A000333:SOURCE 2: MT1-A000333:SOURCE 3:
Timestamp ¥ Hydrogen Hydrogen Hydrogen
(ppm) (ppm) (ppm)
| 1071072015 13:0000 |

|

| 1071072015 140000 [123 | |
| 1011072015 15:00:00 |

| 10/10/2015 16:00:00 |

| 1011072015 17:0000 [121

| 1071072015 18:00:00 |

| 2071072015 19:0000 |

| 1011072015 20:0000 [123

| 1071072015 210000 |

| 1071072015 22:0000 |

B U L R s S—

@ | 11/10/2015 00:00:00 |

_| Transformer Bank Phase Association:
_| Phase A\Oil Source A:  TRN - Phase A
_| Phase B\ Oil Source B:  TRN - Phase B

122
|
|
h22
|
|
a
|
h2s
|
|
p20
_| Phasec\OUSource C:  TRN - Phase C |
|
120
|
|
121
|
|
i
|
|
120
|
|
21

| 1371072015 06:00:00 |
| 1271012015 07:00:00 |
| 1171072015 08:00:00 [121
| 1171072015 02:00:00 |
| 111012015 10:0000 |
| 1271072015 11:0000 [121
| 1171072015 120000 |
| 11/10/2015 13:0000 |
| 1371072015 140000 [126
| 1171012015 15:0000 |
| 12/10/2015 16:00:00 |
| 111012015 17.0000 [129
| 1171072015 180000 |

Figure 3-45: Phase Association annotation on Data Table

When a data source assignment changes for any transformer that is part of
the Transformer Bank, an annotation is added to the Trend Chart to reflect the
assignment change. An indication will also be made on the diagnostic
worksheets to show the data being displayed crosses over a change of single
phase assignment for the online device.
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Figure 3-46: Phase Association annotation on Trend Chart

The Properties worksheet can also be used to make algorithm assignments for
data sources so that the Transformer Bank and associated single phase
transformers can be risk evaluated and ranked. Figure 3-47 shows how to
associate the BMT Standard workflow with a Transformer Bank.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide — Rev 10.3 22-Oct-24 Page 62 of 220



Transformer Bank
% |Transformer Bank_1

Main Transformer Details
Serial Number l:l Transformer type ‘ ‘“ |
Rated Voltage Max. () | | Max MVA | |
Nominal Frequency (Hz) l:l Max Cooling Type ‘ " | | ~ |
Temperature Class (°C) l:l Inhibited

Voltage Sides

Number of Voltage Sides

| Name  Voltage (kV) Power Rating 1 (MVA) Power Rating 2 (MVA) Power Rating 3 (MVA)  Max Cooling BIL (kV) Neutral

(%) More Voltage Side Details

Phase Association

Transformer Bank Phase Configuration

Phase A\ Qil Source A Phase B\ Oil Source B Phase C\ Qil Source C Association date |

Criticality Details

Process/Delivery loss (%) Transformer supplier currently in operation
PCB level (ppm) l:l Spare parts available | Yes -

Access for minor repair | Direct L] Yes, Mo, Special order Physical location | Close to public L2
Access for major repair | Major rebuild & Qil type main tank
Strategic spare Cil containment system

Workflow Associations
Auto criticality calculation Manual criticality (%) 50 Offline Algorithm Standard | IEC ]
Workflows Weight Ranking Influence
BMT 330 | BMT Standara v| o3 | [Nermal v [ Remowe |

Figure 3-47: Transformer Bank

The Ranking tab shows the Transformer Bank with its condition determined by
the combined risk indexes and conditions of its children including Intellix BMT
devices.
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Transformer_1

Transformer Bank_1

TRAM 1
Transformer_1
Transformer Bank_1
Transformer_1
Transformer_2
Transformer_3
Transformer_4

Figure 3-48: Ranking
Circuit Breaker Properties

When a Circuit Breaker is selected in the Asset Explorer, the data area to the
right lists all the worksheets (on the bottom) of which the Properties tab is
first as shown in Figure 3-49. Since circuit breakers do not have data that can
be automatically downloaded, the circuit breaker properties must be manually
entered here.

4 L GDIKPGC2E
4l Transformer Bank 1

4 P nres2

o Circuit Breaker
Circuit Breaker_L

4 . Substation 1
i

ansformer_L

/] s BMT 300/330_1

. Circuit Breaker_1

W cewacn 1

[ 5‘;;, Transformer_L
£ mmi-a000333

@D Testires

Main Circuit Breaker Details

Serial Number

Manufacturer

Year Installed
Rated Voltage Max. (kV)
Rated continuous current (A}

Total weight of SF6 in Kg

‘Workflow Associations

CB Watch_1

Workflows

|

Numbe

Nomberof 56 compariments 7]

Model
Tyoeof e
T
Typeatanemoe 7]

Weight Ranking Influence

Properties X ‘WaHbDard K| Dashboard xl Data Table % | Status X | Trend Chart X‘

Figure 3-49: Circuit Breaker properties

The Circuit Breaker properties fields depend on whether the connection is to
Perception Server or a local KPD database file. For example, there is no
Workflow Associations section for a local KPD database file. The sections
within the Properties worksheet are explained below.

= Circuit Breaker Name

The Circuit Breaker Name is a free text field where you can change the default
name and enter more descriptive text as shown in Figure 3-50.
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3.9.4

Circuit Breaker

Circuit Breaker_1

Figure 3-50: Circuit Breaker name
= Main Circuit Breaker Details

The Main Circuit Breaker Details are entered in Figure 3-51 and allow the
identity and corresponding details to be stored in the database.

Main Circuit Breaker Details

Serial Number Madel
Manufacturer Type [ i |
Year Installed Type of drive [ & |
Rated Voltage Max. (kV) Number of drive motor/pump [ v|
Rated continuous current (kA) Type of drive motor [ v|
Total weight of SF6 in Kg Mumber of SF& compartments [ v|

Figure 3-51: Main Circuit Breaker Details
= Workflow Associations

CB Watch 3 support is available for the Perception Workflow Risk Indexing
and Ranking mechanism. A new algorithm called CB Watch has been created
under the Workflows dropdown list as shown in Figure 3-52. When selected,
Perception uses the Risk Index results received from the CB Watch 3 to
present a Risk Index overview and rank position within the asset ranking table.

Workflow Associations
Workflows Weight Ranking Influence

CB Watch_1 | cB watch E! Normal || Remove

Figure 3-52: Workflow Associations

Motor Properties

When a Motor is selected in the Asset Explorer, the data area to the right lists
all the worksheets (on the bottom) of which the Properties tab is first as
shown in Figure 3-53. Since Motors do not have data that can be
automatically downloaded, the Motor properties must be manually entered
here. The motor properties page can be used to capture specific information
about the motor being monitored.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 65 of 220



Motar
&‘3 GE_Plznt_Motor_01

Motor Details

Motor Rated Eficiency

Besring Type

Workflows Weight Ranking Influence

Figure 3-53: Motor properties

The Motor properties fields depend on whether the connection is to
Perception Server or a local KPD database file. For example, there is no
Workflow Associations section for a local KPD database file. The sections
within the Properties worksheet are explained below.

= Motor Name

The Motor Name is a free text field where you can change the default name
and enter more descriptive text as shown in Figure 3-54.

Matar

Motor 1

Figure 3-54: Motor name
* Motor Details

The Motor Details are entered in Figure 3-55 and allow the identity and
corresponding details to be stored in the database.

Motor Details
Serial Mumber Motor Full Load Amps (A)
Manufacturer Motor Cwverload Factor
Year of Manufacture Metor Horsepower
Rated Voltage Max. (kV) Rated Speed
Nominal Frequency (Hz) = Number of Poles
Meotor Supply = Mazx Acceleration Time
Mator Type e Motor Rated Efficiency
Maoter Application Bearing Type h

Figure 3-55: Motor Details
» Workflow Associations

A Motor supports the 869 Motor Ranking Workflow. A new algorithm has been
created under the Workflows dropdown list as shown in Figure 3-52. When
selected, Perception uses the Risk Index results received from the 869 Relay
to present a Risk Index overview and rank position within the asset ranking
table.
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Workdlow Associations
Workflows Weight Ranking Influence
GE_Plant_Motor_1_869 | 869 Motor Ranking Bl | [ Normal ~ [ Remove

Figure 3-56: Workflow Associations
3.9.5 Device Properties

When a device is selected in the Asset Explorer (E.g. a Transfix 1.6), the data
area to the right lists all the worksheets (on the bottom) of which the
Properties tab is first as shown in Figure 3-57. The Properties worksheet is
used to configure the device.

Note: If used in conjunction with Perception Server, ‘Supervisor’ status or
higher is required to change device properties.

Asset Explorer «  13A-Gen-Transfix

4 £ us-aK30zWi-ER
I, 108
4 &8 GE Generation
I ﬂ GE_Gen_11
- @ GE_Gen_13

4 [ GE Trans Gen_13A

b & GE_Trans_Gen_138

1 &, GE Gen 12
1 & GE_Gen 15
1 & GE_Gen 14
I @ G Distrbution

Next Scheduled Time

‘Schedule

Next Scheduled Time

Notification E-Mail Address

Expert E-Mail Address

Figure 3-57: Device Properties

The Properties worksheet contains several sections that are explained below:

3.9.5.1 Identity

The Identity section details the identity of the device. It contains two read-
only fields as shown in Figure 3-58:

--Idenlity

Device Type Transfix

Serial Number

Figure 3-58: Identity

= Device Type: The device type is defined by the type of asset added using the
Asset Explorer (see Section 3.2.1).
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= Serial Number: The serial number is populated when the first download is
performed from the device.

Communications

The Communications section allows the communication method to be defined
and configured as shown in Figure 3-59. Other configuration fields are
available depending on the device and your choice of Media as outlined
below:

Note: When used in conjunction with Perception Server, you specify the
communications with the device here. Perception Server downloads
the monitoring data, but Perception Desktop is the controlling
application used to specify all the configuration parameters.

~ Communications

Media | | -

Connection Timecut
Password
Figure 3-59: Communications
» Media: Defines what type of connection is used to connect with the device.

Available options are:
» Network

This adds three additional fields:
e Hostname (or IP address): The devices host name or IP address.

e MODBUS/TCP Port: The MODBUS/TCP port defines the port used for
communication with the host name or IP address (the default value is
502).

e Protocol: When adding a DGA 900-family device, MS 3000 or CB Watch 3
there is the option to use either the HTTP (default port 80) or HTTPS
(default port 443) protocol. The selected protocol must match the
protocol set on the device. For DGA 900-family devices, it is possible to
define a non-standard port, select the checkbox Define network port
and specify a port from 0 to 65535 as shown in Figure 3-60.

« Communications
Media Network b
Protocol HTTP I

Hostname (or IP address)
Define network port
Port 100

Figure 3-60: Communications > Define network port

> Modem

This adds one additional field:
e Phone Number: The phone number of the modem in the device.

> Serial

This adds eight additional fields:
o Slave Address: The address of the device on a multi-drop network.
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o Protocol: The MODBUS protocol to use to communicate with the device.
o COM Port: The local COM port to use when connecting to the device.

o Baud Rate: The maximum speed at which the device talks.

o Data bits: The number of data bits in each character being sent.

o Parity: Turn on error correction.

o Stop Bits: Use the hardware to detect stop bits (end of messages) and re-
synchronize the character stream.

o Flow Control: Allow the transmission of data to be paused / resumed.

If a Hydran M2 or Intellix MO150 device is selected, an additional Protocol
field appears on the Properties worksheet:
» Protocol: Selects the protocol method used to communicate with the
device. Perception Desktop supports the DNP3 protocol and three
Modbus protocols (RTU, ASCIl and TCP/IP).

If a Hydran 201Ti device is selected, an additional Protocol field appears
on the Properties worksheet:

» Protocol: Selects the protocol method used to communicate with the
device. Perception Desktop supports the Hydran Native Protocol and
three Modbus protocols (RTU, ASCIl and TCP/IP). Note: To facilitate
TCP/IP communication, the unit requires an RS-485 to Ethernet
conversion.

Note: For Hydran devices, the Media field displays after you select the
Protocol. Serial refers to a USB or RS-485 connection.

= Connection Timeout: Defines the time to wait before reporting a
connection timeout. Enter a value in seconds.

Note: A default value is created in this field when you select the Media type.

= Password: The password for the device.
Auto-Download

When used in conjunction with Perception Server, the Auto-Download section
becomes available in the device Properties as shown in Figure 3-61.

Note: A local database permits only manual downloads. See Section 5.1.

The Auto-Download section allows the connection and downloading from
devices to be automatically scheduled. The schedule settings are unique to
the device allowing a simultaneous download to be scheduled.

= Auto-Download
Enabled
Based on device sample rate | £4]

Minutes Hours Week Days
Schedule

Next Scheduled Time |~ 05032019 14:41

Figure 3-61: Auto-Download
» Enabled: Enables/disables the scheduling of downloads from the device.

= Based on device sample rate: Ensures that the auto-download takes place
based on the device sampling rate rather than the Perception schedule,
meaning that data is downloaded as soon as new measurements become
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available. This effectively means the Perception schedule below is ignored.
This option is useful if the online monitor goes into alarm mode and starts
to sample more regularly. Previously, Perception would not have been
aware that more regular samples were being taken, so would only have
downloaded data based on the Perception schedule.

Note: Users may notice that there is a time difference of one hour between
the download time and measurement schedule time. This difference is
required as it can take up to 1 hour for a measurement sample to
complete fully.

» Schedule: Defines the download schedule in terms of specific days and
times using the “Unix Cron” notation. The essential Unix Cron field values
supported in Perception scheduling are the “*” character and the “0” value.
> “0” means “at the top of” e.qg. if used in the hour field, then “at the top of

the hour”.
> “*” means “every” e.qg. if used in the hour field, then “every hour”.

Table 3-1 shows some example Cron values used in Perception scheduling
and the corresponding meaning in terms of the expected download result.

Table 3-1: Examples illustrating scheduling using Cron values

Minutes | Hours | Week Days | Download Result

30 08 * 08:30 every day

0 * Mon On the hour, every hour on Mondays

0 0 Wed At 0:00 every Wednesday

0 * * On the hour, every hour, every day of the
week

= Next Scheduled Time: Time of the next scheduled download.

Auto-Export

When used in conjunction with Perception Server, the Auto-Export option
becomes available in the device Properties page as shown in Figure 3-62.

- Auto-Export
Enabled [ ]

Hours Week Days
Schedule

|~ M
Next Scheduled Time

Figure 3-62: Auto-Export

You can enable the auto export to occur at scheduled intervals. The
Perception Server export table is empty by default, which results in the use of
the default Perception export format. To define a custom CSV format, you
must define the export table with appropriate mappings for the data using the
Perception Server Configuration Tool. See Section 5.1. The data is
automatically exported to the following location:

C:\ProgramData\GE Energy\Perception

Note: Use the shortcut “%programdata%”to access C:\ProgramData.
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Email

When used in conjunction with Perception Server, e-mail notification options
become available in the device Properties page as shown in Figure 3-63.

GE offers Transformer G a team of highly skiled ign and testing experts o help you with the i ine and offine and transforme or your fiest
For more details, visit: yn pidsohtions.com/m:

Figure 3-63: Email

Note: This is device specific, so if you need to be on the distribution email
list for several devices, complete this field for all required devices.

= Notification E-Mail Address: defines the email address of the person who
receives condition alerts (or communication issues) for that device. To add
more than one e-mail address to the list, separate the addresses with “;"“. If
on subsequent data downloads the condition of the device changes or
Perception Server fails to communicate with the device, an automatic email
is generated and sent to the recipients specified in this field.

= Segregate Notification emails: allows the user to define the recipients of
the emails based on the notification type. Select the checkbox to specify
the three types of notification address as shown in Figure 3-64.

GE offers Transformer Consultancy Supportfram a team of highly skilled transiormer design and testing experts to help you with the interpretation of online and offine transformer data and the evaluation of your transformer or your fieet
For more details, visi: sere gegridsolutions com/me!

Figure 3-64: Email — Segregate Notification emails
» Alarm - notification that an alarm level breach has occurred on the online
monitor.

» Service - notification that the online monitor requires service attention.
When a service alarm is triggered on a DGA 900-family, Transfix,
TAPTRANS, MULTITRANS, MINITRANS, or Hydran M2, M2-X & 201Ti
device, the service log files are automatically downloaded from the
device and included as an attachment in the service notification email.

» Communication issue — notification that Perception was unable to
communicate with the online monitor.

= Expert E-mail Address: (if enabled in Perception Server) defines the email
address of the person who receives enhanced alarm notification emails.
The e-mail is a comprehensive account of a transformer’s details so that
any expert within or outside the organisation has all the necessary detail at
hand. This includes transformer nameplate details, triggered alarm
information for High High, Low Low, Digital Alarms and ROC alarms. It also
includes ambient temperature, top oil temperature and load currents
information. A CSV attachment with data records for the device in alarm is
also included. Note: For the MO150 device, excessive measurement data
could exceed the allowable attachment size as defined on the mail server.

3.9.5.6 Device Connection

The Device Connection section displays the state of automated downloads to
the user as shown in Figure 3-65.
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4 Device Connection
State

Progress

Response
Last Download Time

Figure 3-65: Device Connection

» State: Displays the current state of the connection to the device. E.g.
Connecting, Connected, Downloading, Disconnected.

» Progress: A progress bar shows the overall progress of a download, if one
is in progress.

= Response: Textual error message showing the last communications error
that has occurred. This may be from a previous communications session.

= Last download time: Updated with the last download time.

The Intellix BMT devices have an additional field in the Device Connection
pane, called Service Alarm:

= Service Alarm: Reports the nature of a service alarm that has been flagged
by the BMT devices. The possible alarms are listed below:
» High Comms cpu temperature status

High FPGA temperature status

Field Devices Comms Error

Rejected Phase Packet Status

Rejected PD Packet Status

Low Bushing Current Warning Status
Power System Frequency Warning Status
Inter cpu CANBUS device error status
High Bushing Adapter Temperature Status
Modbus comm. error status

V V V V V V V V V V

No Signal warning status
» Bushing R Failure Warning status

If the BMT devices have any of these alarms triggered, the Blue service icon
will show on the device icon in the Asset Explorer. See Section 3.1.2.1 for an
example.
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3.9.6 Setting up the Device

Once the communications settings have been established, the device-specific
setup can be run. To set up the device, right click on the device in the Asset
Explorer and select Setup... as shown in Figure 3-66. This loads a setup utility
specific to the device.

[]
4 L‘ﬂ GE_Trans_Gen_14A
;:..h 144-Gen-Transfix

L‘,:;a Ge|| Setup..
@ ceDistriny Do
Delete
Rename
Export...
Report 4

Figure 3-66: Setup

Note: If you are connecting to the device via Modem or Serial, then the
Setup option must be performed on an instance of Perception
Desktop running on the Perception Server. This is because it will be
using the local Perception Desktop resources to communicate with
the device.

3.9.7 Workflows

The following workflows are available:

* DGA Standard: Evaluates dissolved gas analysis and moisture absolute
concentrations compared to IEEE C57.104 & IEC 60422 (2013) standards,
as well as dissolved gas Rate of Change compared to the IEC 60599
standard. Along with best practice information taken from Cigré TB227.

» Simplified DGA: Uses alarm breach information sent from DGA 900-family,
MS 3000, Transfix, MULTITRANS, TAPTRANS, MINITRANS, Hydran M2 &
Hydran 201Ti for absolute dissolved gas concentrations and moisture.

= DGA Standard OLTC (Non-vacuum): Evaluates dissolved gas concentration and
dissolved gas rate of change for resistor type tap changer diverter, using
gas ratio information taken from EPRI (Electronic Power Research Institute).

= Simplified DGA OLTC: Uses alarm breach information sent from DGA 900-
family, MS 3000, Transfix, MULTITRANS, TAPTRANS, MINITRANS, Hydran
M2 & Hydran 201Ti for absolute dissolved gas concentrations and moisture.

» Bushing Standard: Evaluates the alarm limits configured on bushing monitor
devices for Power Factor, Capacitance, PD Count, PD Index & PD Average
Apparent Power and compares it to the measured values for proximity to
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alarm breach as well as breaches. Evaluates the alarm limits configured on
the MS 3000 device for DeltaC, tanDelta and Voltages and compares it to
the measured values for proximity to alarm breach as well as breaches

» Offline DGA and Oil Quality: Evaluates oil dissolved gas analysis, quality and
properties data received from a lab compared to a variety of international
standards. Refer to Appendix F for more information on the Offline DGA &
Oil Quality Workflow.

= CBWatch: When selected Perception uses the Risk Index results received
from the CB Watch 3 to present a Risk Index overview and rank position
within the asset ranking table.

= MS 3000 Risk Index: Support has been added for the download of the onboard
Risk Index results from MS 3000 monitoring devices. Perception now
downloads and visualises the Risk Index results along with the other data
stored on the MS 3000. The Risk Index results are calculated directly on
the MS 3000 monitor running master template 3.6.4.22p0_
3.2.2.13p0_4.5p0 or later. Perception can be configured to use and display
only the Risk Indexes downloaded from the MS 3000, or only the Risk Index
calculated in Perception or a combination of both. When both Risk Index
options are configured Perception automatically selects and displays in the
most critical Risk Index result and information regardless of its origin.

» Transformer Models: A workflow algorithm has been created named
Transformer Models Ranking that analyses and provides a Risk Index for
transformers using the model's data downloaded from the Kelman DGA 900
PLUS with models. The workflow calculates a Risk Index using the following
model's data:

» Winding Hottest Hotspot

» Condensation Temperature

Bubbling Temperature Margin

Moisture in Insulation Barrier

Cooling Efficiency

Cooling Malfunction

Continuous non-operation time of cooling banks

Cooling Deficiency Banks

Cooling Over Current Banks

OLTC Short Term Average of OLTC Temperature Differential
OLTC Long Term Average of OLTC Temperature Differential
Tap Position OLTC Operations per Day

Tap Position OLTC Operations per Hour

OLTC Motor Torque Total Time percentage

OLTC Motor Torque In-Rush Time percentage

OLTC Motor Torque Torque Maximum 1 percentage

OLTC Motor Torque Torque Maximum 2 percentage

YV V V V VYV V V V VY V V VY V V V V

OLTC Motor Torque Torque Maximum 3 percentage
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3.10

» OLTC Motor Torque Average Torque percentage

= 869 Motor Ranking: Evaluates the motor data provided by GE’s 869 protection
relay to determine the Risk Index and ranked position of the motors with
regards to the other motors being monitored. The evaluation uses the
measured parameters and alarm set points for the motors electrical,
thermal and mechanical systems to determine the Risk Index.

" 845 Transformer Ranking: A workflow algorithm has been created named 845
Risk Ranking that analyses and provides a Risk Index for transformers using
the model’'s data downloaded from an 845 Relay with the advanced
monitoring option. The workflow calculates a Risk Index using the following
model's data:

» Winding 1/2/3 Loading

» Winding 1/2/3 Harmonic Derating Factor
» Winding Hottest Spot Temperature

» Transformer Aging Factor

» Loss of Transformer Life

= 850 Circuit Breaker Ranking: Evaluates the circuit breaker data provided by
GE’s 850 protection relay to determine the Risk Index and ranked position
of the circuit breakers with regards to the other circuit breakers being
monitored. The evaluation uses the measured parameters and alarm set
points for the circuit breaker trips details, arching information and charge
time to determine the Risk Index.

For more information on workflows, see the Perception Workflow Designer
manual.

Adding a Wallboard

At an Area, Plant, Substation, Transformer Bank or Transformer level, you can
add a wallboard to give an instant overview of the status of all subordinate
assets. Each client PC with an instance of Perception Desktop that connects
to Perception Server must have its own wallboard configured. The image used
for the wallboard background is user defined and can be any BMP, JPEG, GIF
or PNG file.

To add a wallboard, select an Area, Plant, Substation, Transformer Bank or
Transformer in the Asset Explorer and from the menu bar, select View > New
> Wallboard as shown in Figure 3-67. A new Wallboard tab then appears in
the list of tabs.

i Perception Desktop ST N

File | View | Tools Actions Help
MNew ] Wallboard |

Show data points without measurements

Asce Refresh F5

Figure 3-67: Wallboard
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Right-click in the wallboard area and choose Change map file to browse to
the location of a suitable image to use as a map file. The chosen image is
displayed at minimum zoom within the workspace on the right along with
randomly placed subordinate assets for you to position as required.

It is recommended that the resolution of the image file matches the display
resolution of the monitor that will display the wallboard. For example, if the
monitor displaying the wallboard has a resolution of 1920x1080, then the
image file used should also have the same resolution.

Note: A range of charts are also available for some assets. See Section 4.2.
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Figure 3-68: An example wallboard

Perform any of the following actions to alter the map display:

» To drag the map in any direction, left click while the mouse pointer is within
the map.

= To zoom in and out, use the scroll wheel while the mouse pointer is within
the map.

» To drag the asset to a new location, left click while the mouse pointer is
over the asset location icon. Note: The mouse pointer changes to a hand.

= A useful way to distinguish assets is to change the icon used to depict the
asset location. Right click while resting the mouse pointer over the asset
location icon and choose from a circle or a square.

= For other display options as shown in Figure 3-69, right click on the map.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 76 of 220



Dialogs 3 Show all
Change map file... Hide all
Legend
Show time
Full screen

Figure 3-69: Display options

» Dialogs: Each asset has a titled information dialog that lists all attached
monitoring devices and corresponding statuses. This option allows you to
show or hide all asset dialogs. A single dialog box can also be manipulated
independently as follows:

» To show or hide a dialog box, double click its asset location icon.

» To change the size of a dialog box, rest the mouse pointer over the
lower-right corner symbol of the dialog box (the mouse pointer changes
to a double-headed arrow) and then left click-and-drag to resize.

» To move a dialog box, left click-and-drag the dialog box. Note: A dashed
connecting line indicates the relevant asset location icon.

» To change the dialog box title, right click and choose Edit title.
» To view the ranking details, right click and choose Ranking.
Note: The size and position of the dialog boxes are retained.
» Change map file.. allows you to browse for a new map file.
» |egend: toggles the display of the legend for the asset status.
= Show time: toggles the display of the current time and date.

= Full screen: shows the wallboard in full screen mode. To revert to normal
display, press Escape or right click and select Exit full screen.

A fully configured Wallboard in full screen mode is shown in Figure 3-70.
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Figure 3-70: Fully configured wallboard

Other examples of wallboard images are shown from Figure 3-71 to Figure
3-75. If the condition of any of the monitoring devices changes to reflect an
alarm, service or bad sample condition, this will be denoted by a change in
color of the respective device node. This change will also be reflected in the
asset hierarchy and on the wallboard asset node (where an animation causes
the node to pulse as shown in Figure 3-71 — if configured in Perception
Server). Note: By default, all animations are disabled.

Note: In conjunction with Perception Server, the wallboard dynamically
changes to reflect condition updates if the monitoring devices are
configured with automatic download schedules.
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Figure 3-71: WaIIboard with pulsing node

The wallboard asset node will match the status of the device with the worst
result. This helps alert the user to a problem in that area, plant, substation,
transformer bank or transformer at the earliest opportunity. Right-click any
pulsing device in the asset summary box to acknowledge the alarm (at the
device level only) as shown in Figure 3-72 — this turns off the pulsing
animation.
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Figure 3-72: Acknowledge an alarm
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Any movement in the asset risk index for transformer or circuit breakers
nodes is denoted by a corresponding colour-coded directional arrow (up or
down accordingly) next to the asset label as shown in Figure 3-73, which also
has a ripple animation.
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Figure 3-73: Asset node showing increased movement up the asset risk index
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To acknowledge an asset’s change in position in the asset risk index, right
click the asset and select Acknowledge Risk Index as shown in Figure 3-74 to
turn off the ripple animation.

L Fall nocnesier »
ngag Falls ——rt O Syraocdse
{ 490 e
Buffalo =3 ’
3904 NEW YORK
’_,') 1 4
/ = Gen 03A1}
6 ’ Acknowledge Riskindex E.HI!Q ns“..._en‘
*
v Display as circle m
5 | Display as square 6
e e L L e A e L e o,
c |
Scranton o
\_
Jo 204

Figure 3-74: Acknowledge Risk Index
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3.11

The shortcut menu in Figure 3-74 also offers customization options to display
an individual node as a circle or a square to provide a further visual
differentiation of assets, if required, as shown in Figure 3-75. The default
node for all assets is a circle.

Asset labels on the wallboard or asset summary box are also active hyperlinks
as shown in Figure 3-75. Click the asset label to see where the asset sits in
the Asset Hierarchy, for example as shown in Figure 3-76, and if required,
examine its properties etc.

Substation_1 [ st iy i |

-~

<. Substation_1 * @ comeccn

™~ é’ Transformer Bank_1

R - - 4 @ Area_1
M 4 1"!;{' Substation_1

F] ;'_\',_1 Transformer_1
* Circuit Breaker_1
i—&-ﬂ Transformer_1
“5 MT1-A000333

@ Testhrea

N

Figure 3-75: Customizing asset nodes Figure 3-76: Asset Hierarchy

Ranking Assets

The Ranking page in the Asset Explorer as shown in Figure 3-77 automatically
ranks assets according to an algorithm in the Perception workflow to give an
overall health index. Assets are colour-banded accordingly with the least
healthy transformers listed at the top in red and the healthiest in green at the
bottom. Unranked transformers appear at the bottom of the list without a
colour band. A transformer is unranked if it is not associated with the relevant
Perception workflow, has no measurement devices connected to it or there is
no measurement data e.g. a new install with the first measurement cycle yet
to occur.

Table 3-2: Colour designation
Colour Meaning

White Without evaluation (Asset not evaluated or ranked for any reason)

Good condition

Light green | Minor defects not affecting reliability
Yellow Defects that may affect future reliability
Amber Serious defects that may have serious consequences

m Dangerous defects that may cause faults

Ranking movement at each periodic refresh is denoted by colour-coded
arrows. A red up-pointing arrow denotes that the transformer has moved up in
ranking order, a green down-pointing arrow denotes that it has moved down
in ranking order and a blue double-headed horizontal arrow denotes no
change in ranking order.
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Note: Rest your mouse on any transformer to reveal its actual health index.
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Figure 3-77: Ranking
To review the Risk and Ranking history for an individual transformer, select
the transformer followed by the Dashboard tab. Then select the Ranking

Graph tab as shown in Figure 3-78. Rest your mouse pointer on any data point
for more information.
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Figure 3-78: Risk and ranking history
Note: Data points may refer to ‘EPRI' (Electrical Power Research Institute).
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ANALYSING DATA
Data Area Worksheet Tabs

The Data Area contains several worksheets that are used to visualise the data
and diagnose faults. The worksheets are accessed via a series of tabs at the
bottom of the screen. The available worksheets depend on the type of item
selected in the Asset Explorer. For example, Figure 4-1 lists the worksheets
for a Transformer.

Properties % |Wallooard % | Dashboard 3| DataTable 3 |Status | TDCG | Trend Chart % | Bushing Monitor % | Partial Discharge % | Key Gas % | PRPD % | Gas Ratios *| Ratios ®| ETRA X | Duval's ¥/ Inter-Phase Angle %

Figure 4-1: Transformer worksheet tabs

All available worksheets and a link for further details are listed below:
Properties: See Section 3.8.1.

Wallboard: See Section 3.10.

Dashboard: See Section 3.5.1.

Trend Chart: Line charts are used to display the raw data for user-selected
measurements. Multiple trend charts can be created, each displaying different
sets of gases or peripherals. See Section 4.4.

Data Table: Lists the individual samples for each parameter. You can select the
data range and the parameters to suit. See Section 4.5.

Status: Lists the latest downloaded values of the measured parameters and
their status against the alarm thresholds. See Section 4.6. Note: The alarm
thresholds can be set by launching the device setup in Perception Desktop.

Rate of Change: Displays multiple line charts depicting the rate of change for
each gas based on raw data for user-selected measurements on DGA 900-
family, Transfix-family and MINITRANS devices. Multiple trend charts can be
created, each displaying different sets of gases or peripherals. See Section
4.7.

TDCG: The Total Dissolved Combustible Gases (TDCG) chart displays a
stacked chart containing the temporal values of each gas and the cumulative
values for all gases. See Section 4.9.

Key Gas: IEEE C57-104 offers diagnosis through calculating the relative
proportions (in percent) of these key gases to the rest of the gases in the
transformer. See Section 4.10.

Gas Ratios: Displays the proportions of key gases on a three-dimensional cube
lattice or table, using ratios defined by IEC 60599, IEEE C57.104, Rogers Ratio
and Doernenburg Ratios. See Section 4.12.

Ratios: Trends any gas ratios that have been set up for Transfix devices. You
can also add your own custom gas ratio. See Section 4.13.
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4.1.1

4111

ETRA: Japanese ETRA Analysis is an alternative visualisation and diagnostic
tool. Diagrams A & B are available. See Section 4.14.

Duval’s: Describes how the concentrations of dissolved gases or free gases
may be interpreted to diagnose the condition of oil-filled electrical equipment
in service and suggests future action. There is the choice of six different
formats of Duval's diagnostics: four triangles — Classic, LTC (oil filled) and
Duval's 4 & 5 low temperature, —and two pentagons. See Section 4.15.

Models: Provides diagnostics using state of the art mathematical transformer
models based on IEEE or IEC standards. Calculated using monitored
transformer characteristics taken by the Intellix MO150 and Hydran M2. See
Section 4.16.

Bushing Monitor: BMT & DGA 900 PLUS devices only. Shows two polar plots
with a choice of plot styles, C1 or PF% data, and Primary, Secondary or Teriary
input. See Section 4.17.

Partial Discharge: BMT & DGA 900 PLUS devices only. Shows three polar plots
— PD Count, PD Average Apparent Charge and PD Index. See Section 4.18.

PRPD: BMT & DGA 900 PLUS devices only. Shows the measured Phase
Resolve Partial Discharge data. See Section 4.19.

Inter-Phase Angle: BMT & DGA 900 PLUS devices only. Shows a polar plot with
the measured and expected inter-phase angles. See Section 4.20.

Web Browser: MS 3000, CBWatch, BMT 430 and DGA 900-family devices only.
Shows web content as rendered on the remote HMI of the device. See Section
4.21.

Worksheet Options

Right click any worksheet tab to see the available options as shown in Figure
4-2.

Rename

Apply Template

. Save as Template
| _ﬂl Uashboard ®| Data Table

|

Figure 4-2: Worksheet options
Rename a Worksheet

To rename a worksheet, right click on the tab and select Rename.
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41.1.2 Save or Apply Templates

Users can save worksheet settings as a template. The template contains the
customizable features of a worksheet. For example, the selected
measurement points, appearance settings, date range, selected charts etc.
These settings are all stored in the template XML file and can be applied to
another worksheet or the same worksheet in another instance of Perception.

Right click on the relevant worksheet tab and select the relevant option.
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4.2 Default Asset Charts

When a new asset is added and selected in the Asset Explorer, a default set of charts is enabled as listed in Table 4-1.
Additional charts can be added by the user (see Section 4.4.1).

Table 4-1: Charts per asset
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4.3 Default Device Charts

When a new device is added and selected in the Asset Explorer, a default set of charts is enabled as listed in Table 4-2.
Additional charts can be added by the user (see Section 4.4.1).
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Table 4-2: Charts per device
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4.4

Trend Chart

The trend chart is typical of all the diagnostic charts as shown in Figure 4-3. It
can be configured to show groups of gases or other measurable parameters
with multiple versions of the chart being open concurrently.

Frome & 2| 5
[0y g T P 0
M *‘Q\' ot ; J
@ li’:'
VoL ] I
, \
" S -, k
AN g A Ao .
r I_
’ [
NN I e PR VAT lI‘;‘
" e A AR et M 1 | 1
A DA ETeiE e Gap N Rt o] oo B A
61/07/2017 01/01/2018 01/07/2018 01/01/2019 01/07/2019
00:00 00:00 00:00 00:00 00:00

Propertes % | Rate Of Crange % | Data Table x| Status %[ TDCG %/ Trend Chat X KeyGas % | GasRatios % | Ravos x| e1R8 x| Dwars x

Figure 4-3: Dissolved gas trend analysis

Key to the Chart areas:

1. X axis date(s): Select the date range for the X axis of the chart. Whenever
you place your cursor within the grey plotting area, a vertical date line
follows the cursor with the precise date and time reported in the yellow
box.

2. Legend: The value next to each item is the value of the item at the yellow
box date and time (@) time on the X axis. If the cursor is not within the plot
area, the values are as at the right-hand extreme end of the plot lines. To
change the plotted colour of an item, a double click on the legend colour
launches a format dialog as shown in Figure 4-4.

r =
rL Format Plot &]

Axis Scale
Minimum: @ Auto Fixed | O
Maximum: @ Auto © Fixed | 3.20000004768372
Line Color
Current: - More colors... ( O’
| Close |

S

Figure 4-4: Format Plot
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3. Y axis: The Y axis values for the selected item from the legend. Although all

the parameters are plotted, they have, by default, individual scales. Other
scaling methods are selectable. See Section 4.4.4.

. Slider: The slider allows you to control the degree of ‘smoothing’ that is

applied to the trend lines; the leftmost position (shown) has least
smoothing and sliding it leftwards progressively applies more smoothing.
This can be useful in removing spikes and revealing the overall trend of the
parameters.

If you right click when your cursor is within the plot area, an options menu is
displayed, as shown in Figure 4-5.

(SR

Add/Remove Measitement Ponts ' 1
ANl A ul " A l ﬂ A I !llﬁl‘lLL

i X
01/03/2015 01/04/2015 01/05/2015 01/06/2015
00:00 00:00 00:00 00:00

Figure 4-5: Chart options

Chart: Changes the method of scaling the Y axis. See Section4.4.4.
Auto scale: Returns the Y axis scaling to default.
Appearance: Alters the appearance of details within the trend chart.

Reset Zoom: Returns the trend plot to display all points between the start
and finish dates.

View: Alters whether the legend is displayed or not.
Annotations: Allow you to place notes on the trend chart. See Section 4.4.5
Print: Prints the trend graph to your printer.

Print Preview: Allows you to configure the print output and see the effects
before printing.

Copy: Copies the trend chart to the Windows Clipboard, so that it can be
pasted into another application, for instance a document.

Save: Creates a ‘png’ image of the trend chart that can be saved as a
picture.

Add/Remove Measurement Points: Allows you to select/deselect which
parameters are plotted on the trend graph. See Section 4.4.2.
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4.4.1

You can zoom into part of a plot as shown in Figure 4-6. To do so, place the
cursor in the grey plotting area at the top left X-Y position of the desired zoom
area and then left-click-and-drag your mouse to the bottom right of the
desired zoom area (as illustrated by the red arrow). When you release the
mouse button, the plot range will be 'zoomed’. The zoom can be reversed by
left clicking and dragging back in the opposite direction to the red arrow. It
can also be reset by right clicking and selecting Reset Zoom.

ppm

;

i

08/08/2§11
00:

15/08/2011 22/08/2011 29/08/2011
00:00 00:00 00:00

)
01/08/2011

§/09/2011
00:00 00

fe ppm

10/08/2011 12/08/2011 14/08/2011 16/08/2011 18/08/2011 20/08/2011
00 00

00:00 00: 00:00 00:00 00
Figure 4-6: Zoom plot

By default, the Appearance > Connect gaps option is enabled. This plots the
trend line between two good measurements and omits any bad quality data
with zero-value measurements effectively smoothing out the trend line. If
disabled, Perception will plot all data points and any invalid zero-value
measurements will appear as gaps in the chart.

Create a new Trend Chart

To create a new trend chart, select View > New and choose the type of chart,
for example Trend Chart as shown in Figure 4-7.
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Properties

Rate Of Change
Data Table
Status
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B Trend Chart

Key Gas
Gas Ratios
Ratios
ETRA

Duval's
T

Figure 4-7: Create a new Trend Chart

This action opens a new blank trend chart that can be configured to display

groups of measurements.

4.4.2 Add Measurements to the Chart

To add measurements to a trend chart, right click anywhere on the trend chart
and select Add/Remove Measurement Points. Select the measurements to

be trended in the chart as shown in Figure 4-8.

1000

MA

Figure 4-8: Add measurements to the trend chart

M
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j Vi
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C2HE
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e

i O
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The measurement parameters offered are device specific: a Transfix will offer
gas measurements, whereas a BMT device will offer discharge and phase
measurements. The Total Dissolved Combustible Gases (TDCG) from the

TDCG worksheet is also available as a parameter for trending.

4.4.3 Remove Measurements from the Chart

To remove measurements from a trend chart, right click anywhere on the
trend chart and select Add/Remove Measurement Points. Uncheck the
measurements not to be trended in the chart as shown in Figure 4-9.
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4.4.4

M

Figure 4-9: Remove measurements from the trend chart
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[] AmbientTemp
[] OitPressure
[] CilTemp

[] Normal
] Ambier
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[] Oiffemperature
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s —

Change Y Scale method

A number of Y scale methods are available for the trend chart. Right click
anywhere within the trend chart and select Chart as shown in Figure 4-10.

Water ppm

50

Chart

Auto Scale

Appearance
Reset Zoom

View

Annotations

Print
Print Preview
Copy

Save

Add/Remove Measurement Points

Cammon

v Individual

Log

Conditional

| i i,
i _ L L
01/03/2013 01/04/2013 01/05/2013 01/06/2013 01/07/2013 01/08,
00:00 00:00 00:00 00:00 00:00 o

Figure 4-10: Change Y Scale method

The available options are as follows:

= Common: All parameters are on a common Y scale. Small concentrations will
be squeezed together at the bottom of the chart.

» Individual: The default method. Each parameter is plotted with its own
vertical scale, which gives some vertical separation to the trend lines. The
parameter selected from the legend then has its Y scale indicated on the Y
axis.

* Log: All items plotted together, but the Y axis is logarithmic. This separates
out the parameters at the lower end of the chart, but will have the effect of

squashing the high value parameters.

= Conditional: Only parameters that have alarmed during the selected time
period are plotted on the graph.
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4.4.5 Add Annotations

To add annotations to a trend chart, position the pointer on the X axis (time)
where you wish to place the annotation, then right click and select
Annotations > New... as shown in Figure 4-11.

400

Hydrogen
04 ppm
Methane
il 0.8 ppm
Chart >
300 s Acetylene
Auto Scal 01 ppm
Appearance > Eihyene
PP 0.0 ppm
Reset Zoom
200 Vi . Ethane
e 0.0 ppm
Annotations » Show All
Hide All
Print =
100 |- Print Preview S
Copy Oxygen
Save 112 ppm
b Ao -
Add/Remove Measurement Points » 27 ppm

Figure 4-11: Add annotations

Enter the desired text in the text box that appears on the X axis and click
outside the text box when finished to commit the text as shown in Figure
4-12.

Note: A time repeater at the top of the graph may assist in accurate
placement of the annotation.

T T T

e L B B e\ G SR sy

example text

11/07/2011 D‘BJDB.’?DH 05/08/2011
00:00 00:00 00:00
Figure 4-12: Example annotation

Other available options as shown in Figure 4-11 are:
= Show All: Reveal all annotations (if hidden).

= Hide All: Hide all annotations allows you to see the chart without any
annotations obscuring the data.

To edit or delete an annotation, right click the annotation and choose Edit or
Delete.

Note: When used in conjunction with Perception Server, annotations appear
on the trend chart of the device for all connected Perception Desktop
clients.
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4.5 Data Table

The Data Table Tab lists all received data, which can be filtered for the
selected dates. You can add and remove measurement parameters by right
clicking within the display area as shown in Figure 4-13.
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Figure 4-13: Data Table with colour-coding — add / remove measurement points

The selected parameters are colour-coded as follows:

White Normal (data is within all limits).

Amber Caution (i.e. data has exceeded a high or low threshold).

Red Alarming (i.e. data has exceeded a high-high or low-low threshold).
Pink Uncertainty in the measurement accuracy.

Blue Erroneous data.

Teal First measurement after a reboot

Rest the mouse pointer on any measurement value to see the corresponding
Data Table tooltip, an example of which is shown in Figure 4-14. The tool tip
lists the PGA diagnostic error codes and offers a description below. Note: See
Appendix D for an explanation of the PGA diagnostic details.
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| 26062020 131900 RETON
| 25062020 160800 SO

| 25062020 154200 Point Name . TDCG 123°

| 25062020 15:20:00 Pont Path : MAIN
TeneStamp : 25.06.2020 160800

| 25062020 150600 : 3300 ppm
25.06.2020 150200 UNCERTAN
_| 3506300 150200 PGAD0.1.312
| 25062020 14:4600 PGA Error Codes:
Mztung mans mput
l 20062020 170000 flTB PGA R-source outude range

| 17062020 16:00:00 [178
| 16062020 160000 179 |

| 150K 2000 1A 178
Figure 4-14: Data Table tooltip

4.6 Status

The Status worksheet shows the latest downloaded parameter values and is
the suggested view to start with when investigating an alarm occurrence. The
alarming parameters are highlighted with the latest downloaded data date. An
example is shown in Figure 4-15.

Measurement Point Status Timestamp Current Value  High Limit HigLf.\-!-'|igh Low Limit LO“./-L.OW ROC
imit Limit
= MainTank
Hydrogen High 15/02/201214:00 0.6 ppm 0.1 ppm 150.0 ppr
| Methane  HighHigh 15/0220121400 09ppm  O4ppm  OSppm
Acetylene Off 15/02/201214:00 0.1 ppm 1.0 ppm 30.0 ppm
Ethylene Off 15/02/201214:00 0.0 ppm 1.0 ppm 100.0 ppr
Ethane Off 15/02/201214:00 0.0 ppm 1.0 ppm 100.0 ppr
Carbon Monoxide High 15/02/201214:00 1.1 ppm 1.0 ppm 1500.0 pp
Carbon Dioxide High 15/02/2012 1400 4063 ppm 1.0 ppm 110000 p
Oxygen 15/02/2012 14:00 101 ppm
TDCG 15/02/201214:00 2.6 ppm
Water High 15/02/201214:00  21.5 ppm 1.0 ppm 30.0 ppm
AmbientTemp 15/02/201214:00  26.9°C
NormalizationTemp 15/02/201214:00  20.0°C
QilPressure 15/02/201214:00 9.0 KPa
QilTemp 15/02/201214:00  404°C
Nitrogen 15/02/201214:00 0 ppm
Trload 15/02/201214:00 0.2 ppm
4 i . v
Properties X | DataToble | Status % [TDCG %[ Trend Chart % | KeyGas x| GasRatios x| ETRA x| Duvals Triangle x-

Figure 4-15: Status worksheet
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4.6.1

The ‘High-High’ and ‘Low-Low’ alarms are highlighted in red, the ‘High’ and
‘Low’ alarms in amber. The ROC column indicates whether a Rate of Change
alarm has been set for that item. If the ROC alarm is activated, the Status
column will show ‘ROC'.

Note: Certain alarms triggered on the MS 3000 and CBWatch 3 devices
require the user to connect directly with the device via its user
interface to see alarm details. If such an alarm is triggered, a message
appears at the bottom of the Status worksheet stating, ‘Device is in
alarm or caution state — please refer to the Web Browser for the
details!. The user should then open the Web Browser worksheet and
login to the remote interface of the device to see the alarm details.

Ratio alarm measurement points are also displayed if they are configured on
the device.

Right click anywhere in the status area to see further options to print or
customise the display of columns as shown in Figure 4-16.

Print
Print Preview

Show/Hide Columns *

Figure 4-16: Status area columns

Event Point Type

A new point type called ‘Event’ registers the occurrence of an event. No
measurement value is stored with this point type, only the existence of the
event and when it last occurred. For example, Figure 4-17 shows an MS 3000
Status worksheet with a last OLTC operation event listed as ‘Event triggered’
as the current value and a corresponding date/time stamp.

Measurement Point Status Timestamp Current Value High Limit k

=]

Alarming

Loading

[E20- ]

Load currents

[+

Temperatures

Ageing

Gases & Maoisture

KL=~

Tap changer 1

Time of last OLTC operation 13/07/2020 11:15:22 Event triggered

[+

Valtages
deltaC

+

tanDelta

[+

Cooling unit

Properties ¥ Data Table * Status ¥ TDCG = Trend Chart * Key Gas

Figure 4-17: Status > Event Point type
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4.6.2

4.7

Note: Available for MS 3000 and 869 Relay assets.

Note: The eventis listed as ‘Event triggered’ in the tabulated Status and
Data Table worksheets, but in the Trend Chart it is rendered as a
vertical line.

Rename a Measurement Point

Right click on a display name to edit or reset the names as shown in Figure
4-18.

Edit Display Mame

Reset Display Name

Reset All Display Names in Group
Figure 4-18: Display names

A measurement point display nhame can also be changed. Right click in the
Measurement Point field, select Edit Display Name (or double click the
Measurement Point field) and edit the text inline as shown in Figure 4-19. The
renamed measurement point will be used for all occurrences of the
measurement point throughout the application.

Measurement Point Stz
= 11A-Gen-Transfix

B MAIN = 11A-Gen-Transfix
s —)

TDCG Edit Display Name = MAIN
Oxyg Reset Display Name Hz{:}l
QilTe erzmrers 21T R B3 [ iy (B e

Measurement Point

Figure 4-19: Rename a measurement point

Note: You can also reset a single display hame or all display names back to
the original in the same manner.

Rate of Change

The Rate of Change worksheet visually represents the rate of change for
different sets of gases or peripherals on a trend chart. The ROC trend
chart can be rendered for any Transfix-family device including MINITRANS,
and is based on the parameters configured on the device or as user-
defined in Perception.

Note: The ROC chart is manipulated in a similar way to other trend charts
described in Section 0, but does not display alarm limits.
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Figure 4-20: Rate of Change chart

4.7.1 Rate of Change Parameters

The ROC chart is derived from either the ‘Caution’, ‘Alarm’ or ‘Custom’ option
using two parameters, ‘Time Window’ and ‘Minimum Samples’. Selecting either
‘Caution’ or ‘Alarm’ means the parameters are downloaded from the respective
Caution or Alarm limits on the relevant device as configured in TransConnect
(see Figure 4-24). The ‘Custom’ option allows the user to manually define the
values for the ROC parameters as shown in Figure 4-21. Note: Both fields

accept any value from 1 to 32767.

Rate Of Change Parameters

©) Caution Time Window (hours): 48
) Alarm
@ Custom Minimum Samples: 5

Figure 4-21: Custom: Rate Of Change Parameters

The parameters are also shown in the gas legend tooltip on the chart as

shown in Figure 4-22.

] UL

ChlSourced: CH4
Time window: 24 hours
Minimum samples: 2

Le
.1

D ]

Figure 4-22: ROC tooltip showing parameters
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The Custom option is useful for devices with multiple oil sources to ensure
that the ROC parameters are consistent across all oil sources thereby allowing
data to be reliably aggregated for plotting.

A blank chart occurs where the supplied values are insufficient for any data to
be plotted, the ‘Time Window’ is less than the set measurement period on the
device, or if the number of measurements is less than the ‘Minimum Samples’
value within the ‘Time Window’ period. If the device is not configured with
Caution or Alarm limits, or ROC parameters are not specified, then the chart
on the ROC worksheet will be blank since there is nothing to plot.

Note: A chartis not displayed for a gas or peripheral (including devices
imported from a CSV file) without ROC parameters set for ‘Caution’
and ‘Alarm’ cases. Instead, a popup message states ‘ROC Parameters
are not available’.

4.8 Rate of Change Alarm

The Rate of Change (ROC) alarm is designed to alert the user of a gradual
change in the gas levels of the transformer over a set period. The user will
receive notification in the Status worksheet.

When used in conjunction with Perception Server, with e-mail notification
configured (see Section 3.9.5.5), an alarm notification email similar to that
shown in Figure 4-23 will be sent to the designated recipients.

From: TransFix1@plant.com

Sent: 20° April 2011 14:29

To: Plant_Manager@plant.com

subject: Kelman Transfix (/TransFixl) has exceeded an alarm limit.

Kelman Transfix (TransFix1) has exceeded an alarm limit

Latest Measurements:

MAIN

Name Value Timestamp Status LowLow Limit Low Limit High Limit HighHigh Limit
Hydrogen 280.0 ppm 12/8/2011 3:24:00 PM High & ROC 240.0 ppm
Methane 280.0 ppm 12/8/2011 3:24:00 PM ROC
Acstylene 280.0 ppm 12/8/2011 3:24:00 PM ROC
Ethylene 280.0 ppm 12/8/2011 3:24:00 PM ROC
Ethane 280.0 ppm 12/8/2011 3:24:00 PM ROC
Carbon Monoxide 280.0 ppm 12/8/2011 3:24:00 PM ROC
Carbon Dioxide 280 ppm 12/8/2011 3:24:00 PM ROC
Oxygen 280.0 ppm 12/8/2011 3:24:00 PM ROC
TDCG 1680 ppm 12/8/2011 3:24:00 PM ROC
Water 2.0 ppm 12/8/2011 3:24:00 PM

AmbientTemp 0.0°C 12/8/2011 3:24:00 PM
HormalizationTemp 0.0°C 12/8/2011 3:24:00 PM

QilPressure 0 KPa 12/8/2011 3:24:00 PM

QilTemp 0.0°¢C 12/8/2011 3:24:00 PM

Nitrogen 280 ppm 12/8/2011 3:24:00 PM ROC
DG 2520 ppm 12/8/2011 3:24:00 PM

Ambient Temperaturs 0.0deg C 12/8/2011 3:24:00 PM

Mormalisation Temperature 0.0 deg C 12/8/2011 3:24:00 PM

il Temperature 0.0deg C 12/8/2011 3:24:00 FM

Schedule Mode Alarm

Previous Measurements:

MAIN

Figure 4-23: Example Rate of Change e-mail alert
To set up the ROC limits, launch the device setup option from the Asset

Explorer. In the Alarms worksheet, you can set the maximum Rate of Change
in ppm/hours for Caution and Alarm, as shown in the example in Figure 4-24.
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| MAIN | Ansiogue | TransOpto | Digeal|

[ Caution | Momm_| User Al 3 | User Al 4 | User Alam 5 | User Alam 6 | Ratio Aoan 1.4 | > |
Aam condtions

Max Concentration ppm)  Max Rate Of Change (ppm/day)
Hydrogen, H2: ¥ 0 ¥ 01
Methane, CH4 ¥l 1500 ] 01
Ethane, C2HE: Vi ¥ 01
Ethylena, C2H4: ] v 01
Acstylene, C2H2: ¥ 150. 7 01
TOCG: vl . ¥ 01
Water, H20: ¥ o1
Carbon Moncxide. CO: [V ¥ 0
Carbon Dinode, CO2. 1] ¥ 01
Oxygen. 02: ] ¥ 01
Nerogen, N2 I v 01

ROC Time Window: 1 ROC Minmum Samples: 1

Aerts

7] Relay 2 F Caution indcator Caution Mode
|| Relay 3 ANam indcatee Alam Moda
"] Relay 4 £

| Refesh || Ea

TCP/1P:3.169.62.147:502 | 00:00:44

Figure 4-24: ROC settings in TransConnect

The ‘ROC Time Window’ and ‘ROC Minimum Samples’ must be defined for the
alerts to operate. These values are important as they are used in the ROC
calculation. The ‘ROC Time Window’ can be set between 1 and 96 hours. Over
time, the initial measurements are discarded as they fall outside the
boundaries of the measurement window and are replaced with more recent
results.

To avoid spurious values or dropped measurements (recorded as a zero) from
raising an alert, an ‘ROC Minimum Samples’ parameter is set. When this
parameter is met, the unit will calculate the ROC result and, if applicable,
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generate an alert. This allows the user to control whether an isolated
measurement should raise an alert or whether a more persistent change is
required to raise an alert.

4.9 Total Dissolved Combustible Gases (TDCG) Chart

The Total Dissolved Combustible Gases (TDCG) Chart as shown in Figure
4-25 is a pre-set chart with similar controls to the Trend chart for dissolved
gases as discussed in Section 0.

Frome [o7082017 (53| Tor | 247102007 et Dot

14/08/2017 28/08/2017 11/09/2017 25/08/2017 09/10/2017 2310/2017 06/11/2017 20/11/2017
00:00 00:00 00:00 00:00 00:00 00:00 00:00 00:00

Properties % | Rate Of Change % | Data Table | Status % T0CG % | TrendChart % | KeyGas %[ GasRatios % | Ratios % | €TRA %/ Duvals %

Figure 4-25: TDCG Chart
The key differences are:

» The selection of gases is fixed, so cannot be changed by the user

= The values are stacked upon each other, so it is possible to judge the
relative proportions of each gas.

» A Compartment option exists to change the phase/compartment of the
device being displayed (right click anywhere in the chart to see the option).

Note: Once you have settled on your selection of parameters, it is advisable
to rename the chart to indicate which compartment/phase is being
displayed.

You can modify the plot dates to identify spikes or adverse trends in the total

gas concentrations, for example, as shown in Figure 4-26.

Note: The new plot dates are carried over to the other views so that they
are all displaying the same peaks.
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02/11/2009 04/11/2009 06/11/2009 08/11/2009

10/11/2009 12/11/2009
00:00 00:00 00:00 00:00 :

00:00 00:00

Figure 4-26: TDCG Chart

410 Key Gas

The Key Gas worksheet compares the concentrations of key gases against
thresholds for four deterioration conditions:

» Arcing from load current
= Corona, Partial discharge
= Overheated oil

= Qverheated paper

The set of readings for each condition are rendered graphically (one chart for
each condition) using the specified plot dates as shown in the example of
Figure 4-27. The date of the readings is also shown in the centre of the four
graphs (denoted by the blue rectangle).

Note: The first chart (top left) is replicated below for visibility and
description.
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Figure 4-27: Key Gas charts

The bar graphs indicate the percentage of each gas as a proportion of the
total of the six gases being presented. For each gas, the coloured bar (blue in
this example) indicates the actual percentage and the ‘buff’ bar indicates the
threshold percentage used in the fault condition indication. The numeric
values for the percentages are located across the top of the chart, as denoted
by the red rectangle, for example, for C2H2.

The percentage figure in the centre of each graph (denoted by the green
rectangle) represents the percentage of confidence that it is the most likely
fault condition of the four. This is influenced by the number and extent of the
parameters exceeding their thresholds.
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411 Overvoltages

The Overvoltages worksheet is unique to MS 3000 device and plots the
characteristics of an overvoltage in Kilovolts over time with the user able to
select any date range as shown in Figure 4-28. Any voltage in excess of the
normal operating voltage is important to monitor as any surge can disturb
electrical equipment.

From: | 100772020 [} | %e: [ 1770772020 [R) | Reset Dates

13/07/2020 11:43:34

/ \ — Overvoltages WV Pl
\

13/07/2020 113215 13/07/2020 11:43:34

Properies | DataTable % | Status % | TDCG 3¢| Trend Chart | Key Gas %] Ouenveltages x| Gas Ratios ¢ Ratios x| ETRA | Duval's | Web Browser

Figure 4-28: Overvoltages worksheet
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4.12 Gas Ratios

The Gas Ratios worksheet displays the concentrations of gases in a three-axis
cube graph as shown in Figure 4-29. The position of the plot points is
indicative of certain fault conditions.

From: | 300062011 [i3) | Te:[01/10/2011 [ ResetDates‘

Ratios

|1£c 60599

C2H2/C2H4

[MainTank v

. Partial discharges

D1 Discharges of low energy

D2 Discharges of high energy

Thermal fault not exceeding

300°C

P Thermal fault between 300°C and
700°C

. Thermal fault exceeding 700°C
J

T1

Selected Point

Timestamp: 06/09/2011 11:00

C2H4/C2HS CH4/H2

H2 (ppm): 09
CH4 (ppm): 09
C2H2 (ppm): 03
C2H4 (ppm): 0.1
C2H6 (ppm): 0.0

Diagnosis: D2

Time line * Points are not plotted if any of the

S | | 01 g "ave 3 messurement vz
J

of zero.
20/08/2011 03:00 13/09/201115:00 | -

Figure 4-29: Gas Ratios worksheet

The method of plotting the gas ratios can be selected in the Ratios dropdown,
highlighted by the blue rectangle (top right). The choices are as follows:

= |[EC 60599
= |EEE C57.104
= Ratios Table

The Gas Ratios worksheet automatically uses the last plot point in the timeline
with the selected values listed in the Selected Point drop down. The trend
range that is plotted from the main date range is shown in the time line bar
(denoted by the red rectangle). The plot points (denoted by the green
rectangle) are similarly coloured from cyan to dark blue along the time line.

Note: The span of the timeline plotted is the latest available reading within
the main date range and the last 50 readings prior to that.

To rotate the cube, hold the left mouse button on one side of the cube and
then drag the mouse.

If you select another plot point on the timeline then black dotted lines project
its position onto the cube surfaces and the Selected Point drop down is
updated. The Selected Point information on the legend is also updated. A
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diagnosis for the Selected Point is displayed (as highlighted) in the Selected
Point drop down.

The IEEE C57.104 version of the Gas Ratios is shown in Figure 4-30.

From: |30/06/2011  [55) l To:

ovio2011 3] ‘ lReset Dates

Time line

20/08/2011 03:00

C2H4/C2HE

C2H2/C254

10100

Figure 4-30: IEEE C57.104 version of Gas Ratios

CH4/H2

13/09/2011 15:00

[MainTank 'I

! Unit normal

Low energy density arcing - Partial
discharge

Arcing - High energy discharge
3 Low temperature thermal

4  Thermal < 700°C

. Thermal > 700°C
\ J

Timestamp: 02/09/2011 21:00

H2 (ppm): 1.0
CH4 (ppm): 03
C2H2 (ppm): 0.1
C2H4 (ppm): 04
C2H6 (ppm): 0.0

* Points are not plotted if any of the
above gases have a measurement value
of zero,

In addition, the ‘Ratios Table’ option, an example of which is shown in Figure
4-31, indicates the IEC 57.104 Transformer Condition, Rogers Ratio and
Doernenburg Ratio, with their resultant diagnoses for the selected point.

from: |Select adate (18] To:lSal

Ratios

lect a date

Ratios Used

Diagnosis Ratios
€57.104T0CG ™ Condition 1
C57.104 Individual Gas Condition 3 - C2ZH2 Device Oil Sources
Rogers RLR2RS Indeterminate frwsesr -
Timestamp: 01/11/2012 07:55
+*The C57.104 Transformer Concsample fram new or recently repaired transformers where no measurement history is available, e
CHA (ppm): 500
H2 (ppm}: 2010
Name Formula Values G
C2H2 (ppm): 250
R1 CH4/H2 0.2 oA opms 20
R2 C2H2/C2H4 125 C2H6 (pprk 50
€O (ppm): 4000
R3 C2H2/CH4 05 €02 (ppm): 638
TDCG (ppmk: 683
R4 C2H6/C2H2 0.2 (pprk
@ are ignored if any of
RS C2H4/C2H6 04 the above gases have a measurement

value of zero,

Condition Description

TDCG below this level indicates the transformer is operating satisfactorily. Any individual combustible gas exceeding

Condition 1 specified levels should prompt additional investigation.
- TDCG within this range indicates greater than normal combustible gas level. Any individual combustible gas exceeding
Condition 2 e ER 3 P 3 .
specified levels should prompt additional investigation. Action should be taken to establish a trend. Fault(s) may be present.
TDCG within this range indicates a high level of decomposition. Any individual combustible gas exceeding specified levels
Condition 3 should prompt additional investigation. Inmediate action should be taken to establish a trend. Fault(s) are probably
present.
- TDCG exceeding this value indicates excessive d ition. Continued could result in failure of the
Condition 4 v v

transformer. Proceed immediately and with caution.

Figure 4-31 Ratios Table display for Gas Ratios
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4.13 Ratios

The Ratios worksheet displays any gas ratio on a trend chart (for lab data, a
Transfix or DGA 900-family device) and the corresponding alarm limits set on
the device as shown in Figure 4-32. The fractional formula line showing how
the ratio is calculated is shown below the chart.

From: | Select a date .'E’TQ [setect a date E\

l Ratio 2
Upper Limit
8 8.00 ' Device Oil Sources
IRa:‘c 2 ‘ Phase A

344

Lower Limit
1.00

‘WWWMMWM

L 1 L 1
01/07/2012 01/08/2012 01/08/2012 01/10/2012 0111/,
00:00 00:00 00:00 00:00 oc

i
o
K
+
(o]
N}
+
z

ol10
+

0

ol0
N

+

+

H2 + [1CH4 + [1C2H6 + [ 1C2H4 + [ C2H2 + [¥]H20
@

"
2Hs + [ c2H4 + [ C2H2 + [IH20 + 02 + CIN2

Properties "l Data Table xl Status xlmce % | Trend Chart x[xeyeas % | GesRetios %/ Ratios x| ETRA x| Duval' Triangle |

Figure 4-32: Ratios Trend Graph

When displaying a preset ratio retrieved from the device, the fractional
formula ratio line is greyed out, as these values are defined on the device and
can only be edited via the device setup option.

To create your own custom ratio, use the Ratios drop down to select Custom
Ratio. Select the gases for the numerator and denominator on the fractional
formula ratio line. When this is plotted, there are no appropriate alarm limits to
plot, so only the ratio trend line is plotted, as shown in Figure 4-33.
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From: | Select a date u_s;iTo:‘Sele:tada!e E‘

T T T T
Custom ratio, ¢ e
186.12 | Device Oil Sources

1 1 1 1
01/07/2012 01/08/2012 01/09/2012 01/10/2012 01114,
00:00 00:00 00:00 00:00 oC

[E1H2 + E1CH4 + [E1C2H6 + [ C2H4 + [E] C2H2 + [[1H20 + [E1CO + [E1Co2 + [ 02 + EIN2

[E1H2 + ElcH4 + Ec2He + [E c2H4 + M c2H2 + E1H20 + Elco + Elco2 + E1 02 + EIN2

| Properties x]DataTable XIStatus x]TDCG xITrendChart leeyGas % | Gas Ratios x‘ Ratios X |ETRA xlouvarsmangue x

Figure 4-33: Custom ratio trend plot

414 ETRA

The ETRA worksheet displays gas ratios according to the Japanese ETRA
standards. The ETRA diagrams dropdown offers two choices:

= Diagram A: classifies overheating and discharges.
= Diagram B: categorises the discharges.

The page layout follows the same display and control conventions as the Gas
Ratios and Duval's worksheets, namely that the:

= type of diagram is selected from the ETRA diagrams dropdown.

= plot points and time line have the earliest plot point represented by a cyan
colour ranging to deep blue for the most recent plot point.

= selected plot point has dotted lines to the axes to enable the ratio values to
be read off.

= Selected Point dropdown has the plot point source data values and the
diagnosis.

Figure 4-34 shows ETRA Diagram A for classification of overheating and
discharges. The diagnosis in this example is D — Discharges.
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From: | Select a date @ I To: |Se|ect adate @

ETRA diagrams
Classification of Overheating and Discharges LI_)iMﬂ“'l A i ']
Device Oil Sources
(A &

Reset Dates

T1 Low Temperature
] ledium Temperature
I :
8 High Temperature
S
é O Discharge + Overheating
0 - Discharges
0.01 Timestamp: 20/11/2012 12:50
C2H2 (ppm): 10.0
C2H6 (ppm): 65.0
0.001 + C2H4 (ppm): 50.0
< 0.01 0.1 1 4 10 100 1000 g -
"
C2H4/C2H6
Time line
18/11/2012 11:29 20/11/2012 12:50

Figure 4-34: ETRA Diagram A

Figure 4-35 shows ETRA Diagram B details of discharges. The diagnosis in
this example is PD - Partial Discharges (Low Energy).

From: | Select a date E l To: | Select a date @ ‘F.e:»:-i 95:6‘
ETRA diagrams
Details of Discharges [Diagram B ']
100
Device Oil Sources
[maiy v
10
T1 Low Temperature
: H‘ﬁ ‘ Medium Temperature
@ 1
g - High Temperature
g PD Partial Discharge (Low Energy)
ol 0 Discharge + Overheating
. Discharges (Middle Energy)
0.01 . Arc Discharges
Timestamp: 20/11/2012 12:50
0.001
0.01 0.1 1 4 10 100 1000 C2H2 (ppm): 10.0
C2H4/C2H6 C2H6 (ppm): 65.0
Tireline C2H4 (ppm): 50.0
| Disgnesis: PD
18/11/2012 11:29 20/11/2012 12:50 )

Figure 4-35: ETRA Diagram B

4.15 Duval’s

Duval’s diagnostics is an alternative method of mapping the gas
concentrations to possible fault conditions. The Duval’'s worksheet as shown
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in Figure 4-36 is laid out similarly to the Gas Ratios worksheet described
previously. The Duval’s Diagnostics dropdown offers six available charts:

= Classic

» LTC -the Type 2’ for Load Tap Changer (mineral oil filled)

» Type 4 - Low temperature faults, using different gases from the ‘Classic’
» Type 5 - Low temperature faults, using the same gases as the ‘Classic’

» Pentagon 1- six electrical faults, PD, D1, D2, T3, T2, T1 and stray gassing of
mineral oil S

= Pentagon 2 -three electrical faults PD, D1, D2 and four thermal faults T3-H,
C,0,and S

Note: The ‘Low temperature faults’ Duval’s triangles should only be applied
to faults identified by the Classic Duval triangle as possible faults PD,
T1 or T2, and should be viewed only as a complement of information
for the Classic Duval triangle.

Figure 4-36 shows a Classic Duval’s Triangle. A data point can be selected
either from the plot on the Duval’s Triangle or by sliding along the time line at
the bottom of the display. Both the time line and the plot points are coloured
with the earliest plot point represented by a cyan colour ranging to deep blue
for the most recent plot point. The Selected Point dropdown reveals the plot
data and the diagnosis for the selected point, in this example, an electrical
and thermal fault. The other versions of the Duval’'s Triangle for the same data
point are shown below.

From: ‘Se!ect a date E ‘ To: !Se!ect adate E ‘

| Duval's Triangles

[(lassic da }

Device Oil Sources

(many ~|

. Partial Discharge

D1 Discharges of Low Energy

% C2H4, D2  Discharges of High Energy
Ethylene

% CH4,

Methane
T1 Thermal fault, t<300°C
40

T2 Thermal fault, 300°C < t < 700°C

. Thermal fault, t > 700°C

DT  Electrical and thermal fault

Selected Point

A AN
80 60 40 20
% C2H2, Acetylene C2H2 (ppm): 100

Timestamp: 20/11/2012 12:50

CH4 (ppm): 120.0
C2H4 (ppm): 50.0

] Diagnosis: DT

18/11/2012 11:29 20/11/2012 12:50

Time line

Figure 4-36: Duval's Triangle — Classic

Figure 4-37 shows an LTC example with a T2 diagnosis — severe thermal fault
(300<T<700 °C, coking).
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From: | Select a date @'ToclSe&eﬂadate @l Reset Dates

¢ i v]l
Device Oil Sources
[main g
Unit normal
Severe thermal fault T3 (T>700°C),
heavy coking
Fault T3 or T2 in progress {mostly),
% C2H4, with light coking or increased
5 Elyiens resistance of contacts, Or, severe
® A\ arcing D2,
/ N qp Severe thermal fault T2
" (300<T<700°C), coking
D1 Abnormal arcing D1 (outside of
zone N)
Abnormal arcing D1 or thermal
! fault in progress,

% CH4,
Methane

Selected Point I

q .4

X &

80 Timestamp: 20/11/2012 12:50

80 40
% C2H2, Acetylene

C2H2 (ppm): 100

CH4 (ppm): 1200

Time line C2H4 (ppm): 500
18/11/201211:29

20/11/2012 12:50

Figure 4-37: Duval's Triangle — LTC example

Figure 4-38 is a Type 4 example — Low Temperature Faults using Hydrogen,
Methane and Ethane. Diagnosis S — Stray gassing of mineral oil.

From: 'Selectadne @]Tﬂ’klmadate El Reset Dates

- Stray gassing of mineral oil
)I: Hot spots with carbonization of
~ paper (T > 300°Q)

O  Overheating (T < 250°C)
. Corona Partial Discharge

Lﬁ} Unnamed zone

Selected Point

Timestamp: 20/11/2012 12:50

C2H6 (ppm): 650
3 & 5 H2 (ppm): 10000
80 60 40 20 CH4 (ppm): 1200
% C2H8, Ethane
e I
Time line
18/11/201211:29

20/11/2012 12:50

Figure 4-38: Duval's Triangle — Type 4 example

Figure 4-39 is a Type 5 example — Low Temperature Faults using Methane,
Ethylene and Ethane. The diagnosis is C — hot spots with Carbonization of
paper (T>300 °C).
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From: | Select a date E ’ To: ’Select adate

Duval's Triangles

. Stray gassing of mineral oil
": qi\ Hot spots with carbonization of
€ paper (7> 300°0)
% CH4, % C2H4, 0  Overheating (T < 250°C)
Methane Ethylene

Thermal faults of very high

40 temperatures (T>700°C)

Corona Partial Discharge
[l@j '} Unnamed zone

Selected Point

Timestamp: 20/11/2012 12:50

C2H6 (ppm): 650

80 60 40 20
% C2H8, Ethane CH4 (ppm): 120.0
C2H4 (ppm): 50.0
- .. .
Time line Diagnosis: ,\,%‘
18/11/201211:29 20/11/2012 12:50

Figure 4-39: Duval's Triangle — Type 5 example
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Duval’s diagnostics also offers two pentagon representations for 5-gas ratios.

Figure 4-40 is a Pentagon 1 example using hydrogen, acetylene, ethylene,
methane and ethane. The diagnosis is S — Stray gassing S of mineral oil at 120
and 200 °C in the laboratory.

From: [Select a date @'Yu:lkledadale E‘

.Cuwnpmbld‘-dmws
D1 Low energy discharges
.WWMW
.T'Bml"lllts)?W’C
T2 Therml faults of 300 to 700°C
40% C2H2 2
T1 Thermal faults <300°C
Stray gassing S of mineral oil at 120
and 200°C in the laboratory

\

Timestamp: 10/08/2015 10:00.00
Hz (ppm): 2007

CHa (ppm): 1744

C:He (ppm): 1169

CiHe (ppm): 569

CaHz (ppm: 382

oageoss SN

40% CH4 40% C2H4

Time line

e —

08/08/2015 09:00 10/08/2015 10:00

Figure 4-40: Duval's Pentagon 1 for 5 gases

Figure 4-41is a Pentagon 2 example using hydrogen, acetylene, ethylene,
methane and ethane. The diagnosis is S — Stray gassing S of mineral oil at 120
and 200 °C in the laboratory.

From: [Selectadate  [13) To: |Selectadate  [i8) | |Reset Dates

Pentagon 2

40% H2 |""‘m = |

A

. Carona partial discharges

D1 Low energy discharges
.“ﬁ-wm
Stray gassing § of mineral oil 2t 120
and 200°C i the laborstory
-ﬂmulbulsﬁ-Hl‘nuiuiy
¢ Themmal faults T3:C, T2C.and T1-C
with carbonization of paper
O Overheating T1-0 <250°C
L J
A
Timestamp:  10/08/2015 10:00:00 I
Hs (ppm): 2007
CHu ppml: 1744
CaHa (ppm): 1169
CoH (ppm: 569
Cobls (o) 382
o [ |

40% C2HG A0% C2H2

40% CH4 40% C2H4

Time line

—

Figure 4-41: Duval’'s Pentagon 2 for 5 gases
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4.16 Models

The Models worksheet is for Intellix MO150, Hydran M2 / M2-X, DGA 900
PLUS and DGA 900 TAPTRANS PLUS devices only. These devices measure an
array of parameters (such as current, voltage, temperature and moisture etc)
that Perception Desktop utilises in algorithms for graphical models to infer
other transformer conditions.

The available models are:

Dynamic Loading: This model provides the operator with a continuous

estimation of the capacity of the transformer to continue safe operation
under temporary overloading conditions. See Appendix E.2.1 for a brief

description of the model.

Insulation Ageing: This model monitors the key parameters that lead to the
breakdown of the insulation paper in the transformer windings. See
Appendix E.2.2 for a brief description of the model.

Moisture and Bubbling: This model monitors the water content in the oil
and the current oil temperature compared to the temperature at which
bubbles would form in the oil (dependent upon the atmospheric pressure).
See Appendix E.2.3 for a brief description of the model.

Apparent Power in MVA: This model continuously monitors the load carried
by the transformer. See Appendix E.2.4 for a brief description of the model.

Winding Hot-Spot Temperature (WHST): This model uses several
parameters to estimate the temperature of the hottest spot in the winding,
as opposed to the general winding temperature. See Appendix E.2.5 for a
brief description of the model.

Cooling Status: This model allows identification of the cooling stage
currently in service. This information is also essential to other cooling
models, such as Cooling Efficiency and Cooling Control. See Appendix E.2.6
for a brief description of the model.

Cooling Efficiency: This model computes the top oil temperature that
should be expected considering the load current, the ambient temperature,
the cooling mode, the oil time constant and the altitude. See Appendix E.2.7
for a brief description of the model.

On-Load Tap Changer (OLTC) Tap Position: This model provides
additional information for monitoring the tap changer driving mechanisms.
See Appendix E.2.8 for a brief description of the model.

OLTC Differential Temperature: This model continuously compares the top
oil temperature in the main tank with the tap changer compartment. See
Appendix E.2.9 for a brief description of the model.

In addition, there are device-specific sensor reading history graphs:
Hydran M2 Only

Temperature: Displays the history of various key transformer
temperatures: (see Appendix E.2.10 for a brief description of the model.)
» RH sensor temperature.
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» Heater power (in % of full power).

» Top oil temperature.

» RH sensor hourly average temperature.
» Hydran sensor temperature.

> Base plate temperature.

» Hydran Readings: Displays the history of various key Hydran readings:
(see Appendix E.2.11 for a brief description of the model.)
» Hydran reading in ppm.

» Hydran reading hourly trend, in £ ppm.
» Hydran reading daily trend, in = ppm.
» Hydran sensor temperature.

Intellix MO150 Only

» Transformer Status: This model provides a display of the main sensors feeding the
Intellix MO150. It can accommodate up to six analog and/or digital signals and/or
model outputs. (see Appendix E.2.12 for a brief description of the model).

» Temperature sensors

» Current transformers (CT) for load current

» Hydran® intelligent transmitter

» Aquaoil® 400 relative-humidity-in-oil analyser

» Electric or acoustic partial discharge (PD) detectors
» Geomagnetically-induced current detectors.

= Cooling Control: This model provides additional cooling control features to improve
the performance of the cooling system. (see Appendix E.2.13 for a brief
description of the model).

Figure 4-42 shows a typical format for the Models worksheet for a Hydran
device: a trending graph with gauges to indicate the spot values. The

individual models are selected using the tabbed list at the top of the screen. In
this example, the display is for Hydran Readings.
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Figure 4-42: Models > Hydran Readings

4.16.1 Display Controls

The Models Trend Graph can be manipulated as follows:

» All the available parameters for a model are plotted on the trend graph,
unless they are positively de-selected.

= To de-clutter the trend graph, individual parameters can be de-selected
from the plot by clicking the relevant square in the colour-coded legend (it
toggles to the large size to indicate deselection). For example, the upper
graph in Figure 4-43 shows all parameters plotted, whereas the lower
graph shows the purple plot de-selected.
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Figure 4-43: Example of deselecting a parameter

Note: Rest the mouse over a square in the colour-coded legend to see a
description of the parameter.

= The respective parameter colour also underlines each gauge. The gauges
indicate the most recent reading in the selected date range. If the cursor is
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4.17

within the graph area, then the gauges represent the value at the cursor
position.

= The gauges show an analogue reading on a dial with an appropriate scale.
The value is also shown in digital form at the 6 o’'clock position. If there is
no digital number, then there are no values (as opposed to the value zero).

= Some gauges may have green, yellow and red borders on their
circumference as shown in Figure 4-44. This indicates that normal, low and
high operating ranges are set on the Hydran M2 / Intellix MO150 device.

» | Gauge Representation
TN 700 TN P
n mn S n
*in 'C W - % In C "
- — .—"‘T—P - —

N e N N 0
CERSEY (a2s /N ass
TE1%RHSTemp S#1Heater TopGCilTemp T#1%RHTAvg #1HydSTemp

e B

Figure 4-44: Gauge Representation — examples

= Some models have a user-selected averaging period (at the source device).
If that is the case, the Text parameters between the Gauges and the Graph
Plot show the settings for the averaging period.

Bushing Monitor

This feature is available on all BMT devices and as an option on DGA 900
PLUS and DGA 900 MULTITRANS. The Bushing Monitor and Partial Discharge
(PD) worksheets use polar plots to better identify and quantify which bushing
(C1 and PF%) or phase (PD) is being affected with respect to the others.
External factors such as temperature affect all three bushings (and thus all
three phases) equally. When data is plotted on the polar plots, variations due
to common effects are negated and have no effect on the output that is
displayed on the polar plots. Each plot point represents the sum of all three
phases. The radius of the plot gives its magnitude (e.g. % change) and the
angle on the polar plot gives a visual indication of which bushing(s) are
affected.

The Bushing Monitor worksheet presents two polar plots by default displaying
the following parameters as shown in Figure 4-45.

» The relative change of Capacitance (C1) for a set of three bushings over
time.

= The relative change of Power Factor (PF%) for a set of three bushings over
time.
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Figure 4-45: Bushing Monitor polar plot

Devices with bushing monitoring are shipped from the factory with default
alarm settings. Note: Alarms are user configurable; refer to the relevant
product Operator Guide. If the alarms are enabled on the device, the alarms
are displayed in the polar plot as colour-coded boundaries as shown in Figure
4-46. Green denotes that the amplitude of the polar plot is within the
acceptable given limits; yellow a warning and red an alarm.

Zoom Out Zocmin

Time line

01/01/197001:1647 20u2015 102945 ||

Rest the mouse pointer over any data point on the polar plot to display a
tooltip with the data point information.

Right click inside the pane for a shortcut menu with several graphing options
as shown in Figure 4-47.

» The Plot option offers a choice of a Polar or Histogram view.

» The Bushings option offers a choice of Primary, Secondary or Tertiary
bushings.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 118 of 220



= The Measurement option offers a choice of measurement parameter either

percentage change in either Capacitance or Power Factor.

Plot
Bushings

Measurement

: A

» | ¥ Bushing Capacitance change (%)

Device »
Plot *
| Bushings » Primary
Measurement . Secondary
?] Tertiary

Figure 4-47: Bushing Monitor graphing options

4.17.1 Display Controls

Bushing Power Factor change (%)

The worksheet offers several controls as shown in Figure 4-48.

Zoom Ot 2Zoomn | 200m Ot

Time e Time ine
v

—— |

Zoomln

IS IS
OLOVI9003:1647 27/0w2015 101945 [l 00197001

1627

/02015 101945

—
| Propertes. X | OataTabie . X| St X | Treod Chat. X Bushing X x| R0 X| e %),

Figure 4-48: Bushing Monitor polar plot — controls

4.17.1.1 Date controls

The blue rectangle in Figure 4-48 highlights the Date controls.

= The Date picker is used to set the date range to display. The range is also
shown on the Timeline below with the earliest plot point represented by a
cyan colour ranging to deep blue for the most recent plot point.

» The Reset Dates button resets the date range to include all available data,

ending in the most recent.

4.17.1.2 Zoom and Range controls

The red rectangle in Figure 4-48 highlights the Zoom and Range controls.

= The Zoom slider controls the radial scale to allow zooming in and out of the
polar plot. When the polar plot is zoomed in, click and drag with the left
mouse button to pan the zoomed region within the polar plot.

» The Range selector within the timeline allows the user to display a subset
of the available data filtered by time. Drag the black markers on the far left
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4.17.1.3

and right of the timeline accordingly to define a time-bound range of data.
Drag the time-bound data range to update the polar plot in real time.

The effects of zooming and restricting the date range are shown in Figure
4-49. Zooming in and restricting the date range makes tracking a parameter
over time more visible.

[ [ rom[seectocote @] vecfseecacwe

27/052015 101945

Figure 4-49: Bushing Monitor polar plot — zooming

Other controls

The green rectangle in Figure 4-48 highlights the other controls. These are
also shown in Figure 4-50.

B[

Figure 4-50: Other controls

» The ‘<<’ or ’>>' buttons hide and restore the graphs respectively.

» The ‘graph’ button (left most) toggles the view between a trend chart and a
polar plot.

» The ‘? button gives a short description of the graph.

The controls on one pane are independent of the other pane allowing the
same dataset to be viewed differently alongside each other. For example in
Figure 4-51, the left pane has been changed to a histogram view, while the
right pane shows the same data selection and zoom, but using a plain polar
view.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 120 of 220



4.17.2

4.18

ZoomOut 2o0mln

e e s [ o P
Figure 4-51: HistograT(Ieft) and polar plot (right) using the same dataset

The colour of the histogram pixels denote the density of measurements at
that point. Resting the mouse pointer on a pixel opens a tooltip showing the
numerical value associated with the pixel's colour. This is useful when there
are a large number of plot points: the plain polar view indicates the range of
values, while the histogram indicates the commonality of the values. The
histogram view can also be zoomed to give greater density detail.

Multiple BMT devices

The Asset Explorer allows multiple Intellix BMT 300/330 devices to be added
to a single transformer to support the monitoring of multiple sets of bushings
as shown in Figure 4-52. This makes it possible to visualize the monitoring
data for multiple sets of bushings and easily switch between devices within a
single worksheet, such as the Bushing Monitor worksheet. Right click the plot
area on the worksheet and select the relevant BMT device from the shortcut
menu as shown in Figure 4-53.

4 {y Transformer 1 | Device » BMT 300/3301
+§ BMT 3003302 Plot , BMT 300/2302
. Timefr
'+ BMT 200/320_1 metame - *
- Phase 3
Figure 4-52: Asset Explorer Figure 4-53: Shortcut menu to choose BMT
device

Partial Discharge

This feature is available on all BMT devices and as an option on DGA 900
PLUS and DGA 900 MULTITRANS. The Partial Discharge worksheet renders
polar plots displaying the statistical partial discharge parameters as measured
by the device. The layout consists of three polar plots — one in a ‘major’ pane
and two in ‘minor’ panes as shown in Figure 4-54.
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Figure 4-54: Partial Discharge polar plots

The three polar plots are as follows:

= Partial Discharge Count.

» Partial Discharge Index (PDI) — measured in mW.

» Partial Discharge Value — measured in picocoulombs (pC).

Rest the mouse pointer over any data point on the major polar plot to display a
tooltip showing the data point information.

Right click inside the major pane for a shortcut menu to change the Plot to
either Polar or Histogram view as shown in Figure 4-55.

|} 1 L

) Plot » | « Polar

/\ / Histogram
400 ’

Figure 4-55: Partial Discharge graphing options

Either of the polar plots in the minor panes can be brought into focus by
moving it to the major pane. Click the relevant ‘double arrow’ << button
(denoted by the red circles on the top left corner of the minor panes in Figure
4-54) to move a minor polar plot to the major pane.

The worksheet offers similar controls to the Bushing Monitor polar plot to
define the date range and zoom as described previously in Section 4.17.1.

Click the ‘trend graph’ button (left most on the major pane) to display a trend
chart using the values with which the polar plot is built, an example of which is
shown in Figure 4-57.
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Figure 4-56: Toggle charts

24/11/2014 08/12/2014 22/12/2014 05/01/2015 19/01/2015
00:00 00:00 00:00 00:00 00:00

Pepeies | Do Tabe %[ T G uieg ] i e P90 i Poe le_%

Figure 4-57: Partial Discharge trend chart

The device “High” and “High-High” alarms thresholds are plotted as amber
and red lines respectively.

Click the ‘polar plot’ button as shown in Figure 4-58 to return to the polar plot
view.
Figure 4-58: Return to Polar view

419 PRPD

This feature is available on Intellix BMT 330 devices, BMT 430 and as an
option on DGA 900 PLUS and DGA 900 MULTITRANS. The PRPD polar plot
visualises the Phase Resolved Partial Discharge data patterns (if available).
The PRPD worksheet shows the PD pattern of a grid voltage cycle. This
pattern can be used to analyse and potentially identify the PD sources. The
PRPD tab is only available for the Intellix BMT 330, BMT 430 & DGA 900 PLUS
devices. The worksheet displays PRPD data from the device on a standard 2-
D chart, which can also be configured as a histogram.

?

Summary information as shown in Figure 4-63 and Figure 4-64 for the PRPD
is displayed on the ‘PD event info’ panel (top right). If the 2D chart is active,
the lower panel (‘Selected PD event’) lists the PRPD coordinates of the
selected PD event (if selected); or the selected pixel density in the case of a
histogram.
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4.19.1

Display Controls
The worksheet offers similar controls e.g. to manipulate the date range as
described previously in Sections 4.17 and 4.17.1.

Rest the mouse pointer on any data point (or pixel) to display a tooltip with the
data point (or pixel) information.

Right-click inside the pane for a shortcut menu with several graphing options.

» The Plot option offers a choice of a 2D chart or Histogram as shown in
Figure 4-59.

Plot v | v 20 chart
Timeframe [ Histogram
Phase J

Figure 4-59: Plot shortcut menu

» The Timeframe option offers a choice of a single PRPD view (one record) or
daily view as shown in Figure 4-60.

Plot 2

Timeframe ¥ |+  Onerecord
Day

Phase 3 [

Figure 4-60: Appearance shortcut menu

= The Phase option offers a choice of phases A, B or C as shown in Figure
4-61.

Plot 3

Tirmeframe 3

Phase ¥ | v Phass A
Phasz B
Phase C

Figure 4-61: Phase shortcut menu

The Zoom slider controls the scale and allows you to zoom in and out of the
PRPD. When zoomed in, it is possible to drag the PRPD to pan across the
chart.

To set the PRPD vertical range and the histogram density range, double click
the plot to open the PRPD Range dialog as shown in Figure 4-62.
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£ PRPD Range E3

PRPD vertical range
Maximum: ® Auto O Fixed 200

Histogram density range
Maximum: ® Auto () Fixed 1000.00

Figure 4-62: PRPD Range dialog

4.19.2 2D Chart

The standard 2D chart shown in Figure 4-63 plots the PD events as per the
phase angle of the grid voltage in degrees (X-axis) and the apparent charge
(pC) (Y-axis).

Apparent charge (pC)
o® @vo
=
£
i
i

Zoom Ot Zoomtn

Tine bne.

o220 1241 w0 0n8

Figure 4-63: PRPD standard 2-D chart

4.19.3 Histogram

The histogram shown in Figure 4-64 uses the same axes as the 2D chart to
plot the same data, but adds the PD event density as colour. The colour
scheme for the histogram is shown in the legend at the bottom of Figure 4-64
where the density (the number of events per one thousand cycles) is depicted
by a particular colour.
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4.20

Apparent charge (pC)

£ 0 » st

Figure 4-64: PRPD histogram

Inter-Phase Angle

This feature is available on all BMT devices and as an option on DGA 900
PLUS and DGA 900 MULTITRANS. The Inter-Phase Angle worksheet as shown
in Figure 4-65 uses an Inter-Phase Angle plot to display the temporal
evolution of angles, with the time increasing radially. The Inter-Phase Angle
polar plot displays the measured angles in a more intuitive way than could
otherwise be achieved with a trend chart. The worksheet displays the
measured Angle A-B and Angle A-C against the expected respective angles.
The Phase Angle Caution and Alarm limits as configured on the device are also
shown.

fan.a i
From: | Select a date To:|Selectadate  [33) | Reset Dates

Expected <AC -120.00

ge X|PRPD X Inter-Phase Angle X

Figure 4-65: Inter-Phase Angle
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4.20.1

Display Controls
The worksheet offers similar controls e.g. to manipulate the date range as
described previously in Sections 4.17 and 4.17.1.

Move the mouse pointer on the plot area and a tooltip displays the date and
timestamp of the Marker Line, while the legend (top right) displays the angle
values.

Right-click inside the pane for a shortcut menu with several graphing options.

The Bushings option offers a choice of Primary, Secondary or Tertiary
Bushings as shown in

Figure 4-66.
Device ,
Bushings b Primary
Appearance v Secondary
View p || ¥ | Tertiary

Figure 4-66: Bushings shortcut menu

» The Appearance option toggles the Marker Line On or Off as shown in
Figure 4-67.

Bushings 2
Appearance b [ « Marker Line
View [

Figure 4-67: Appearance shortcut menu

= The View option toggles the Legend On or Off as shown in Figure 4-68.

Bushings 3
Appearance ]
View k| v Legend

Figure 4-68: View shortcut menu

The Zoom slider allows you to change the magnification of the Inter-Phase
Angle plot.

The Phase Angle Caution and Alarm limits are also available on the Data Table
worksheet as shown in Figure 4-69. Rest the mouse pointer on any Angle
point value to obtain a tooltip that includes phase angle caution and alarm
limits.
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From: lSe!ect a date E ' To: lSeIect adate E ' ‘

Primary Bushing:  Primary Bushing:  Secondary Bushing: Secondary Bushing: Primary Bushing: Primary Bushing:
Timestamp ¥ C1% Polar Plot Level PF3% Polar Plot Level C1% Polar Plot Level PF3% Polar Plot Level Angle A-B Angle A-C
(%) (%) (%) (%) ) )
| 16/01/2016 07:30:52 00 po po o |20000 f112.0%
| 16/01/2016 07:25:51 |°‘0 p'o |0'0 |0'0 |120'000 Poinlt Name I : Angle A-B
| 16/01/2016 07:20:51 [00 po po oo 120000 | Point Path : Primary Bushing
TimeStamp :16/01/2016 07:30:52
| 16/01/2016 07:15:50 00 po oo oo [120000 | value 1120000 *
| 16/01/2016 07:10:50 00 po po po 120000 | 32 e
| 16/01/2016 07:05:49 0.0 po po oo 120000 T
High Limit :120500°*
| 16/01/2016 07:00:43 00 po oo oo 120000 High-High Limit ;121000
55 Low Limit 1119500
| 16/01/2016 06:55:48 0.0 po po oo 120000 s e
| 16/01/2016 06:50:48 |00 po o0 [ [r20000 e -
| 16/01/2016 06:45:47 [00 po oo oo [t20.000 [119.99 |
| 16/01/2016 06:4047 00 po po oo [:20.000 f110.999 |
| 16/01/2016 06:35:47 00 po po o 120000 F119.999 |

Figure 4-69: Data Table with Caution and Alarm limits tooltip

The Phase Angle Caution and Alarm limits are also available on the Status
worksheet as shown in Figure 4-70.

Measurement Point Status Timestamp CurentValue  Highlimit  High-HighLimit  Lowlimit  Low-LowLlimit Digital Input Type
Environmental
©  Primary Bushing
Ci%A Off 16/01/2016 07:30:52 00% 05% 10% -05% -10%
Ci%B Off 16/01/2016 07:30:52 00% 05% 10% -05% -10%
Ci%C off 16/01/2016 07:30:52 00% 05% 10% -05% -10%
C1% Polar Plot Level 16/01/2016 07:30:52 00%
PF% A 16/01/2016 07:30:52 00%
PF% B 16/01/2016 07:30:52 00%
PF%C 16/01/2016 07:30:52 00%
PF% Polar Plot Level 16/01/2016 07:30:52 00%
Angle A-B Off 16/01/2016 07:30:52 120.000 * 120.500 * 121.000 * 119,500 ° 119.000 *
Angle A-C Off 16/01/2016 07:30:52 -119.999 ° -119.500 © -119.000 © -120.500 © -121.000 ©
Current A 16/01/2016 07:30:52 0.02 mA
Current B 16/01/2016 07:30:52 0.02mA
Current C 16/01/2016 07:30:52 0.02mA
Expected Angle A-B 22/01/2016 14:14:28 120.000 °
Expected Angle A-C 22/01/2016 14:14:28 -120.000 *
Secondary Bushing
PD

Figure 4-70: Status worksheet with Caution and Alarm limits
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4.21 Web Browser

The Web Browser worksheet displays web content as rendered on the remote
HMI of an MS 3000, CBWatch or DGA 900-family device. An example is
shown in Figure 4-71.

% MS 3000 Condition Monitoring and Expert System

lmope«ues XI Data Table XI Status Xl Trend Chart | Web Browser X ’

Figure 4-71: MS 3000 Log-in screen

The HMI uses an integrated frameless browser for interacting with the
products. To open the web browser, click the tab or select the Setup context
menu item from the appropriate asset in the Perception fleet tree (left pane).
The web browser state is saved while navigating between worksheets of the
same asset, but is reset after switching to another asset. To access web
content, ensure that a valid Host name or IP address for the product is
specified in the Communications section of the Properties worksheet as
shown in Figure 4-72.

-~ Communications

Media [Netwcrk VJ

Protocoal [HTFP ']

Transformer [l 'J

Hostname (or IP address) 192.168.0.1
User Name

Password

Figure 4-72: Properties — Communications — IP address
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4.22

4.23

COMTRADE History

This feature is only available on CB Watch3, 845 and 869 Relays. The
COMmon format for TRAnsient Data Exchange is a standard digital file format
for recording transient fault data identified from sampling electrical
characteristics and stored as a series of files. These files can be downloaded
and stored within the Microsoft SQL Perception database. They can also be
saved to a local location on the PC for later analysis to provide insight on the
magnitude and effect of faults over time using third-party tools.

W e Pl Breaker 1
- [———

St Gormtens i Lol

| watboaca | Duta Tabia 6| Dasnboms x| status | Tt Crant x| COMTRACE History %

Figure 4-73: COMTRADE History

Breaker Trend Chart

This feature is only available on 869 Relay devices. The Breaker Trend Chart
renders the breaker records retrieved from the 869 relay in a predefined way
as shown in Figure 4-74.

From[Setectacote (53] | B [Selectocote [ [Reset Dot

[ eotr Ootaseesier viaveng Comert prase &
24 kA2exc

[ Ootsresce viavcing Comect Prase 5
38 W2oc
et ata ek 1:arcing Carert: Prase €
56 kA2-cyc

 est: Datatreske 1:Arcing Curert-Tots
00 k2o

esit Catasresker 1 tesir: Close Tome
350 ms.

o P ostszescer tmentr oA e e
200 ms

I il

I R
280 ms
I i
340 ms
ot DataSrenker seat P A ArcEnergy
1200 k2o
= [ o vt zence it o A vy
1250 kA2-cye
 reaith Datadresker t:ieath: PH C Arc Erergy
1600 kA2-cyc
01/07/2021 01/08/2021 01/09/2021 01/10/2021 01/11/2021
00:00 00:00 00:00 00:00 00:00

| DataTable % | Status % | Trend Chart X/ Breoker Trend Chart % |ESAData % | £54 Circle Chart % | Breaker Data % | LOR Data %[ 54 Models % | LDR Trenas X

Figure 4-74: Breaker Trend Chart
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4.24

Event data is represented on the chart as solid vertical lines to correlate with
breaker data. This includes breaker arcing parameters and breaker health
records. The resulting trend chart plots the available historical data in
accordance with the custom selected date/time range. See Section 4.4 for
details on the controls to manipulate trend charts.

ESA Data

This feature is only available on 869 Relay devices. ESA (Electrical Signature
Analysis) is the monitoring of stator current or voltage in a rotating machine.
Various electrical and mechanical fault conditions can cause a modulation of
the current and/or voltage signal. Proven ESA algorithms are implemented in
the 8 Series relays to detect mechanical abnormalities in the motor and this
‘signature’ allows motor faults, such as a broken rotor bar, bearing failure,
static & dynamic eccentricity, foundation looseness and misalignments to be
identified early and their severity assessed.

The ESA Data table lists the raw electrical signature analysis data retrieved
from the 869 relay in a predefined way as shown in Figure 4-75.

T —
From: |Select 2 date  [12] | Tor | Select = date Reset Dates

Load Sub-System % | Bearing Sub-System % | Mechanical Sub-System % | Stator Sub-System % | Rotor Sub-System % | Thermal Sub-System % Supply Sub-System %
Load )11 AVG Speed Thermal Capacity Used
BFLA) () (RPM) (%)
| 2s/11/2021 152297 [F0 [ps  [s210 [17esafine |
| 24/11/2021 154154 [70 o6 [521.0 17850100 |
| 24r11/2021 154054 [70 o6 |521.0 17850100 |
| 24/11/2021 153954 [T0 o6 [s21.0 [178s0[100 |
| 24/11/2021 153854 [70 o6 [521.0 [17850[100 |
| 24/11/2021 153754 [70 o6 [521.0  [1785.0[10.0 |
| 24r11/2021 153854 [F0 [ps  [5210 [17esafine |
| 241172021 153554 [70 o6 [521.0 17850100 |
| 2471172021 15:2454 [T0 o6 [521.0 1785100 |
| 2411142021 15:33:54 [0 jos |s210 178500100 |
| 2a/mi2021 152254 70 |06 [521.0 17854100 |
| 24112021 153154 [T o6 [s21.0 17850100 |
| 24/11/2021 153054 [70 o6 [s21.0 1785100 |
| 24/11/2021 15:2954 [70 o6 [521.0 [1785.0[100 |
| 24r11/2021 15:2854 [T o6 [521.0 [1785.0[10.0 |
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I

Timestamp ¥ Load Bin

| 2ar11/2021 152754 [F0 o6 |5210 [17ssafin0
| 2ami2021 152654 70 |06 [521.0 178540100
| 2471172021 152554 [70 o6 [s21.0 [178s0100
| 2471172021 15:2454 [T0 o6 [521.0 17850100
| 24/11/2021 15:2354 [70 o6 [521.0 [17850[100
| 24r11/2021 15:2254 [70 o6 [521.0  [1785.0[10.0

|24miozisnisa [t fos [s210 178sgino

| 24r11/2021 15:2054 [70 o6 [521.0 17850100
| 24/11/2021 15:1954 [T o6 [s21.0 [178s0100

| 2471172021 15:1854 [T0 o6 [521.0 17850100
| 247112021 15:17:54 [T0 o6 [521.0  [17850[100
| 24r11/2021 15:1654 [T o6 [521.0  [1785.0[10.0

| 240215554 F0 o6 [s210 17850100

| 24r11/2021 15:1454 [T 06 [521.0 17850100
[ 2an1por1159354 70 lo6 5210 l1785.0110.0

Properties ¥ | Data Table ¥ | Status % | Trend Chart X | Breaker Trend Chart ®| ESA Data 2 | ESACircle Chart % | BreakerData X |LDRData ¥ |ESAModels | LDRTrends X

Figure 4-75: ESA Data

Data is grouped across a series of subtabs with timestamps to represent the
various subassemblies of the machine being monitored — Load-Sub-System,
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4.25

4.26

4.27

Bearing Sub-System, Mechanical Sub-System, Stator Sub-System, Rotor
Sub-System, Thermal Sub-System and Supply Sub-System.

ESA Circle Chart

This feature is only available on 869 Relay devices. The ESA Circle Chart is a
fault diagnostic tool that plots the last fifty historical data records retrieved
from the 869 relay in a circle format as shown in Figure 4-76.

S
From[selectacate [T T Selecta date [53] e Dwes

Load Bin 4 (30-40%) Load Bin 3 [20-30%)

Load Bin 5 (40-50%) Load Bin 2 (10-20%)

Load Bin & (50-60%) Load Bin 1 (1-10%)

Load Bin 7 (60-70%) Load Bin 12 (>110%)

Load Bin & (70-80%) Load Bin 11 (100-110%)

Load Bin 9 (80-90%) Load Bin 10 (30-100%)

: —
Prapertes | DotaTale | Sat_ | Trend ot | reaer T Chae_% | £34 DX 654 Cic Cranx Booker e | R o | 5 s ] 10 venc:_« [
Figure 4-76: ESA Circle Chart

This is a useful visualization aid as to the motor status (normal, caution or
alarm). The ESA circle is divided into twelve load bins with concentric circles
to show if a historical record is within a baseline or has breached an alarm
level set on the 869 relay. This can be used to identify mechanical, bearing
and stator faults. Refer to the 869 Motor Protection System - Instruction
Manual for more details.

Breaker Data

This feature is only available on 869 Relay devices. The Breaker Data table
lists the breaker records from the 869 relay in a predefined data table as
shown in Figure 4-77.

]
oo [seectadate 2] To [ Selecta cote (12| et e

Tenestap *  Totl Bresker Vips rips Snce Last et Al Counter :’l':]r\m- g af 5 Trip Time :kgnfTrlp'm' Ciose Time: ::: of 5 Clase Time. ::1 of Close Time r;: Arc Teme Aug. of 5 PH A Arc Time Avg. of PH A Arc Time ‘p:: Arc “m':\':g” of 5 PH 8 Arc Time ::: of PH 8 Arc Time ::ﬂc af

i
asitva 152207 [50 20 0 00 peo 230 ) 500 pso pa s =0 10 pso 540
| orroeznet 155700 |10 20 Bo ko o k0 o ko 50 o [ne ) 150 [ 150 60

Figure 4-77: Breaker Data

The breaker records include the breaker arcing parameters and breaker health
records. Refer to the 869 Motor Protection System — Instruction Manual for
more details.

LDR Data
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4.28

From:|5elecladate 'T_;|Tn:‘55\ectadate E‘Re:s:[}ates

Motor Load ¥ | Motor Start  # | Motor Thermal %

This feature is only available on 869 Relay devices. The Learned Data
Recorder (LDR) Data table lists the learned data records retrieved from the
869 relay as shown in Figure 4-78.

Timestamp ¥

Learned Average kW Learmed Average kvar

Learned Average PF

Average Run Time (Days) Average Run Time (Min) Leamed Average Load

(kW) (lvar) (days) (min) (xFLA)
| 2571172021 1322117 54240 [roo0.0 ps po paoo 12 |
| 24711/2021 15:41:54 [5234.0 pogo P ko pato [r2 |
| 24r11/2021 15:40:54 [5346.0 ps70 pa 5o pa20 12 |
| 241172021 15:39:54 [5689.0 beso ps lso pazo [1a |
| 24/11/2021 15:28:54 ‘5?61 0 |985‘0 P.9 |7‘U |2440 ‘1.2 ‘
| 24711/2021 15:37:54 [5643.0 psoo P jpo paso 1o |
| 24r11/2021 15:36:54 [5233.0 p750 pa [0 pago 11 |
| 241172021 15:35:54 [5433.0 bs6o ps [100 paro fi2 |
| 2471172021 13:3454 53220 10020 ps [110 paso 11 |
| 24/11/2021 15:33:54 [5631.0 [1004.0 ps [i20 paso p2 |
| 2471172021 133254 51230 [ro100 ps [130 psoo 2 |
| 2471172021 15:31:54 52340 11450 P [140 ps10 12 |
| 24711/2021 15:30:54 [5564.0 [toa30 pa [150 paoo 12 |
| 241172021 15:29:54 [5764.0 10000 P9 [160 paso [1a |
| 2471172021 13:28:54 [5843.0 11000 ps [i70 paso 2 |
| 24711/2021 15:27:54 54230 10020 P [180 paso [to |
| 24711/2021 15:26:54 [5876.0 [toc4.0 pa [19:0 paso 11 |
| 2411172021 15:25:54 [5345.0 10600 P9 jpo0 paro fi2 |
| 2471172021 13:2454 [5843.0 10300 ps [0 paso 11 |
| 24711/2021 15:23:54 [5743.0 10400 P lp20 paso 12 |
| 2471172021 15:22:54 [5432.0 [t0200 pa [z30 psoo 12 |
| 241172021 15:21:54 [5644.0 10000 P9 [0 ps10 fi2 |
| 2471172021 15:20:54 [5766.0 10300 ps [zs0 paoo 2 |
| 2471172021 1511954 [5433.0 psso P 60 pazo 11 |
| 24711/2021 1501854 [5424.0 psso pa [0 pa10 12 |
| 2471172021 15:17:54 [52340 booo P9 jps0 paso [0 |
| 2471172021 1318154 [5346.0 p750 ps o0 paso fa |
| 2471172021 1511554 [5689.0 ps60 P o0 paro 12 |
| 24711/2021 1511454 [5761.0 10020 pa [0 paso 11 |
| 2411112021 15:13:54 [5643.0 hoo4.0 bs 320 b4g.o h2 |

Properties ¥ | Data Table X | Status

Figure 4-78: Breaker Data

3| Trend Chart X | Breaker Trend Chart % | ESA Data

3 | ESA Circle Chart ¥ | Breaker Data | LDR Data  |ESAModels | LDRTrends X

The Learned Data Recorder measures operational parameters and records up
to 250 data record ‘sets’ from the actual motor operation. LDR Data is grouped
across three tabbed pages — Motor Load, Motor Start and Motor Thermal.
This data is used to identify changes to key motor operations and evaluate
those trends over time. Refer to the 869 Motor Protection System -
Instruction Manual for more details.

ESA Models

This feature is only available on 869 Relay devices. The Electrical Signature
Analysis (ESA) Models tabbed page presents a series of sub-system models
using a combination of predefined graphical gauges and trend charts as
shown in Figure 4-79.

This data is grouped using a series of subtabs — Load, Supply, Thermal,
Bearing, Mechanical, Stator and Rotor.
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Figure 4-79: ESA Models

ESA trend charts plot the available historical data according to the custom
selected date/time range. Event data is represented on the chart as solid
vertical lines to correlate with ESA data. See Section 4.4 for details on the
controls to manipulate trend charts.

4.29 LDR Trends

This feature is only available on 869 Relay devices. The Learned Data Records
(LDR) Trends tabbed page presents a series of sub-system models using a
combination of predefined graphical gauges and trend charts as shown in
Figure 4-80.

This data is grouped using a series of subtabs — Motor Start, Motor Electrical
and Motor Thermal.

Pl Evenes
CEECT T RCEET P TP EET PR P T T DT T e

Leamed Start Cument xFLA

01/10/2020 01/01/2021 01/04/2021 01/07/2021 01/10/2021
00:00 00:00 00:00 00:00 00:00

M‘ * | DataTable X|Status X | Trend Chart X | Bresker Trend Chart X | ESAData X | ESA Circle Chart X | Bresker Data X | LDR Dats X | ESA Modeks K| LDR Trends. l_
Figure 4-80: LDR Trends
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LDR Trends plot the available historical data according to the custom selected
date/time range. Event data is represented on the chart as solid vertical lines
to correlate with LDR data. See Section 4.4 for details on the controls to

manipulate trend charts.
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S) OTHER TOOLS & FUNCTIONALITY

5.1 Downloading Data...
5.1.1 ...Via Perception

To download data from a device, right click on the device in the Asset
Explorer and select Download as shown in Figure 5-1. This starts the manual
download. The device node in the Asset Explorer gains a spinning blue icon to
show that the download is in progress.

ﬂ Setup

Figure 5-1: Download

If the Properties worksheet is open, the progress bar in the Device Connection
section will show the download progress as shown in Figure 5-2.

Figure 5-2: Download progress
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5.1.2

To cancel the download, right click on the device and select Cancel
Download as shown in Figure 5-3.

n Setu
ag M i

s TRN Cancel Download

,"l_l"l-:'-'a TRM Delate
1Ys TRN Rename
i TRN Export ’

Figure 5-3: Cancel Download

When used in conjunction with Perception Server, the download of data can
also be scheduled to occur automatically (see Section 3.9.5.3). Note: Data can
also be manually downloaded during scheduled download intervals.

...Via USB

Data download from a Transfix device using the USB communications support
must be performed via the TransConnect application as shown in Figure 5-4.

Note: The TransConnect application is automatically installed with
Perception Desktop. The default location is ‘Programs/GE Energy’.

The steps are as follows:
= Close Perception Desktop.

= Select Start > All Programs > GE Energy > Perception > TransConnect to
open the TransConnect application.
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. ! TransConnectw1,12,1 li“ﬂ“él

Select a connectian:

Marne Senal Murnber Connection  Pararneters Statu =
Local Connections

Tx1-D000000 Tx1-D000000 sE Disce

4 | 1] [ 3

| Refrezh | Froperties... Mew Connectiorn ... | Delete Connection

Figure 5-4: TransConnect
= Connect your PC to the Transfix via a USB port.

» The Transfix device should be listed under Local Connections. Select this
device, connect to it and then choose the option to download the latest
records.

Note: The data is stored in a temporary folder called “FileWatcher”.
= Exit the TransConnect application.

Upon next starting Perception Desktop, the downloaded data will be
automatically imported from the FileWatcher folder to the database that
Perception Desktop is connected to on launch.

Note: If you have a copy of Perception Express on your PC and launch that
before Perception Desktop, then the downloaded data will be
imported to the Perception Express database. Since Perception
Desktop already includes all the features of Perception Express, it is
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5.2

5.2.1

recommended that any prior copies of Perception Express be
removed.

Exporting and Importing Data

Perception provides several options for configuring the export and import of
data using a CSV file. This includes alarm information for all device types,
measurement diagnostics and quality status information. In addition, the
Perception Server Configuration tool allows you to define any custom CSV
format. However, Perception recognises three CSV formats out of the box:

= Perception
= TransConnect
= TOA4

Export

You can export assets (transformers and/or devices) to a Perception format
standalone CSV file at the database, parent or device-node level. This is
useful if you want to copy data to another system to perform, for example,
custom analysis. Other export options are listed in Table 5-1.

Table 5-1: Export options

Properties Export all the attributes specified on the Properties page along
with the corresponding asset hierarchy.
Measurements Export device measurement data plus the corresponding asset

hierarchy only.

‘Uncertain’ and ‘Bad data’ are attributed with diagnostic
information for each data point. Uncertain data values are
appended with ‘IU’. Bad data values are appended with ‘IB'.

Ranking History Export the ranking history data as described in Section 3.11.

All Data Export everything - all the Properties, Measurements and
Alarms as defined above.

Right click the asset in the Asset Hierarchy or select Actions > Export to see
the available export options as shown in Figure 5-5. Select an option e.g. All
Data.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 139 of 220



Ascet Hierarchy | Ranking |
trams b
4 52 GLIHTBGIE

T_La Transformer_C1_alarm

_rjlb Transformer_All_alarms

4 L Tl Leburn
Debug 3

Mew b

| Expart ) Properties
Report b
_F

J-'h Transfarmer ¥
i

Measuremeris

Ranking History
All Data

idh Transformer |

Figure 5-5: Export options

The ‘Save Exported File As’ dialog as shown in Figure 5-6 allows you to save
the data to a Perception format CSV data file. To do this, navigate to a
suitable location, specify a name for the CSV file or select an existing file to
overwrite, and then click Save to export the data using this format.

£ Save Exported File As.. [ = |
O e 90 e —
Organize v New folder - .@.
n >l IJA Format.csv i
- Favorites w I‘_'la Microsoft Excel Cornma Separate...
= 7] 143 KB
Bl Desktop
& Downloads i ~ral Transconnect format - 1 header.csv
U5 Recent Places l‘_la Microsoft Excel Comma Separate...
e 7] 101 KB
Transconnect Format - 4
ol
B Desktop I‘_‘la header.csv
= Libraries /| Microsoft Excel Comma Separate...
3 Documents e WOVK =
& Music ~¢|  Shortcut |i|
| Pictures S lE 104 KB i
File name; TOA Format.csv -
Save as type: | C5V File (*.csv) v]
“ Hide Folders Save ] ’ Cancel ]
| - = = —

Figure 5-6: Save as a CSV file

The parent-child relationship depicted in the Asset Hierarchy is also included
as part of every export. During an import, this allows assets to be recreated
on the recipient machine in the same structured way as the source machine.
The metadata for the hierarchy of assets is represented in the CSV file in the
following way: A parent column is created in the CSV file and that is used to
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store the value of the parent node against each asset value in the ‘Equipnum’
column. If there is no parent node for an asset, then the value of the parent
column is left blank against the respective asset value. On import, this asset
will be created at the highest level in the asset hierarchy i.e. directly under the
database node.

5.2.2 Import

You can import assets (transformers and/or devices) from a CSV file that
adheres to one of the formats listed in Section 5.1. The CSV file may include
asset properties, device measurement data, ranking history and the
corresponding asset hierarchy, depending on the options chosen at the time
of export.

In Perception Desktop, select Actions > Import > Import File... as shown in
Figure 5-7.

b Import File...

Can e

m

[<1]

anking |

Figure 5-7: Import a file

The Open dialog allows you to select a CSV file. Click Open to import the
contents of the file to the database as shown in Figure 5-8.

.

., Open =

(XDV B Desktop » - - Search Desktop 2
Organize « New folder =~ 0 @

»

shortcut L
- Favorites —‘ ? 1.20 KB

B Desktop = )T*‘ TOA Format.csv
& Downloads I—"la Microsoft Excel Comma Separate..
T — il
= Recent Places L2
IE ] Transconnect format - 1 header.csv
- Microsoft Excel Comma Separate...
Bl Desktop al 101 KB
- Libraries o e e
ransconnect Format -
@ Documents IEa header.csw
J’ Music 7| Microsoft Excel Comma Separate...
[&=] Pictures S wovk ‘E
B videos - P|  Shortcut i
A Fd Rovle ~ (& 1.04 KB n
File name: TOA Format.csv - ’CSV File (*.csv)

N B o [ p—— ]] |

Figure 5-8: Open a CSV file

A progress bar is displayed during the import. The diagnostic information that
accompanies ‘Uncertain’ and ‘Bad data’ is also included as part of the import,

along with the metadata to reconstruct the parent-child node structure in the
Asset Explorer.
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5.3

Note: The import may take several minutes (depending on the size of the
file) during which time you cannot manipulate the asset hierarchy.

Note: Alarms are also imported, including those from Transport X units that
use firmware v1.12.6.567 or later.

Note: Nameplate information that is imported to the database is not time
stamped. If a TOA file contains several rows of nameplate information
for one device, only the first row for each compartment is imported.
See Section 3.9.1.

If the data values of the following fields in the CSV file match all the asset
attributes on the Properties pages, then the asset already exists in the
database and is updated accordingly with any new data from the CSV file.
These fields are:

» Equipnum: the name of the transformer
» Serialnum: the serial number of the transformer
> Apprtype: device type (TRN for transformer)

If any one of the fields does not match, then the asset is considered to be
new. A new asset node will then be created in the Asset Hierarchy at the
desired level as per the data value listed in the parent column of the CSV file
for the asset. The position of new assets can be rearranged as required. See
Section 3.2.4.

The import summary dialog is displayed, and if the import is problematic, it will
also include a link to the corresponding log file. The log file records details of
the import including any errors and is saved in the same location as the
imported CSV file.

Downloading Service Logs

Service and factory logs can be downloaded from some devices, either
remotely over a network, or directly from a Transfix via a USB connection. To
configure the download, use the menu option Tools > Download Service
Logs.... Note: You can also right click the device to access a shortcut menu
option.
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ﬁa_ Download Service Logs w5

Communications

Media: Connect via Network L
IP Address:
Port: 502

Transfix Version A/B: [ ]

POTM Type: Factory Code e

POTM:

Save To

Specify Log Filename:

Start Cancel

Figure 5-9: Download Service Logs - Network

The Media field defaults to a Network source as shown in Figure 5-9. For a
network source, you must supply the IP address and enter the secure POTM
code. To obtain the POTM code, please contact GE. Finally, enter the
destination folder on your PC or use the Browse (...) button to navigate to the
destination folder.
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i+ Download Service Logs 4

Communications

Media: Connect via USB =
COM Port: COM1 =
Please connect your PC to the Unit using the USE connector inside the Unit,
MOT at the front door.

Save To

Specify Log Filename:

[*5]
+

[=1)
¥

Cancel

Figure 5-10: Download Service Logs - USB

If you are onsite at the Transfix, select USB in the Media field. The dialog
changes to reflect the setup as shown in Figure 5-10. For a USB direct
connection, you need only supply the destination folder on your laptop.

Note: You must use the USB port inside the Transfix (located behind the
Control panel).

This resulting file can then be sent to GE for analysis.

5.4 Data Viewing Options

Select Tools > Options > View to examine a couple of options for viewing the
data as shown in Figure 5-11.

‘s Options >

Communications | View

[ ] Show data points without measurements

[ ] Mark Calculated Values

Figure 5-11: Tools > Options > View

» Show data points without measurements: By default, any data points without
measurement values are excluded to aid the identification of trends and
ensure a smooth plot. To include these data points irrespective of their null
values, select Show data points without measurements.

= Mark Calculated Values: Select Mark Calculated Values to identify all values
that result from a calculation of other measurements. By default, this option
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is not selected since many values are obviously calculations e.g. TDCG, but
not all are obvious, so it may on occasion be useful to explicitly identify
them. For example, the nitrogen value comes not from a direct nitrogen
measurement, but a calculation using other directly measured parameters.
Calculated values are marked with an asterix *’ at the end of the display
name e.g. Nitrogen*.

5.5 Transformer Report

The Transformer Report is a multi-page report that contains key overview
details of the transformer using Perception-based data.

Note: The reportis generated as a Microsoft Word document and can be
found in the Documents folder of the local machine.

To generate the report, right click on a Transformer asset in the asset tree as
shown in Figure 5-12.

Aszet Hierarchy | Ranking

- O
I % GE Generation
« ) GE Distribution
by GE_Dis_121
v L, GEDis120
b g, GE Dis 119
v 3G GE_Dis 118
vl GEDis 117
# GE Dis 116

! "h GE_Trans_Dis_116C

I fi% GE_Trans_Dis_1168
4 ;‘jﬁ, GE_Trans_Dis_1164
238 116A-DisBN  New »

L) 1164-Dis-T{  Delete

#G GE Dis 112 Rename
b g4y GE Trans Dis_11 Export P

b gy GETrans Dis 11| Repot Pl GE frans Dis_116A

:
roedll e omes e

Figure 5-12: Transformer Status report context menu

The Report option lists the selected transformer with any qualifying child
assets below. Select an asset to launch the Report Configuration Wizard as
shown in Figure 5-13.
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‘. Report Configuration Wizard — O x
GE_Trans_Dis_111B Report Configuration

Date Range: From |04/09/2019  [53]] To [04r102000 3]
Include DGA section Include BMT section Include Fleet ranking section
Source: QilScurceA v

Gases: |elect Variables [ 7]

Cuval's Triangle: Classic v

Gas Ratio: IEC 60599 v

Select Trend Chart: Trend Chart v

QOpen report on complete Report ‘ | Close

Figure 5-13: Report Configuration Wizard

The Report Configuration Wizard allows the report content to be customized
as follows:

» The Date Range sets the range of dates that the report will span.
* The Include section — choose from DGA, BMT and Fleet ranking.
= The Source dropdown allows you to select the relevant oil source.
» The Gases dropdown allows you to select multiple variables.

= The Duval’s Triangle dropdown allows you to select which of the six
Duval's diagnostics options to display on the report.

» The Gas Ratio dropdown allows you to select which of the two gas ratio
diagnostics to display on the report.

Note: The diagnostic information provided by the Gas Ratio is displayed on
the report (above the conclusion). However, the Gas Ratio diagram is
not displayed.

= The Select Trend Chart dropdown contains a list of the trend charts
available for the report. If you have multiple trend charts in the device
workbook area, these will appear here. You can choose to use one of the
predefined trend charts or you can create a custom trend chart. To create
a custom trend chart, select from the available variables to display as
shown in Figure 5-13.

» The Reset button resets all options back to the default settings.

= The Report button generates the report on the local machine and the
adjacent checkbox opens the report on completion.

A sample first page of the Transformer report is shown in Figure 5-14.
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Perception
Transformer Report

Report Date: 11/09/2019 Report Date Range: | 10/08/2014 - 11/05/2016

ORGANISATION DETAILS

com TEXT EDITABLE FIELD or Email- TEXT EDITABLE FIELD or
pany: predefined and saved in template . predefined and saved in template
ress: TEXT EDITABLE FIELD or . TEXT EDITABLE FIELD or
& : predefined and saved in template A (] predefined and saved in template|
Contact: TEXT EDITABLE FIELD or Repart Verified by: TEXT EDITABLE FIELD or

predefined and saved in template

TEXT EDITABLE FIELD or
predefined and saved in template

TRANSFORMER DETAILS

predefined and saved in template|

Contact Number:

Area GE Distribution Substation GE_Dis_116

Transformer ID\Serial | GE_Trans_Dis_1164 '\ TRN-023321 Transformer Transalats

| Mumber Manufacturer

Rating 220 Rated Vohage 120 kv
ONLINE DGA EQUIPEMENT STATUS

Maonitor Type Mame Serial Number Alarm State Service State
Transfix 1164-Dis-Transfix TK1-D123321 Alarm OK
BMT300 116A-Dis-BMT300 BMT-000123 Normal 8] 4

Figure 5-14: Transformer Status Report

The first pages contain the:

» Report Date and Date Range of the data contained in the report
= QOrganisation Details

» Transformer Details

» List of online DGA equipment and Status (in alarm or not)

The following pages lists the DGA alarm information for each Source. The
report also contains three free-text entry boxes - Introduction, Summary and
Conclusion, which the user can populate before printing.

The remaining pages relate to the DGA analysis with trend charts, DGA
diagnostics (Duval, Key Gas, Gas Ratio, TDCG, CO2\CO with hot metal gases),
Bushing analysis and Risk and Rank analysis (if selected in the Report
Configuration Wizard).

5.6 Workflow Scheduler

Workflows can be scheduled from Perception Desktop via the Tools menu as
shown in Figure 5-15.
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Figure 5-15: Tools menu

Click the Workflow Scheduler option to launch the ‘Workflow Scheduler’
dialog as shown in Figure 5-16.

n Workflow Scheduler ﬁ

Enabled [

Hours Week Days
# | - * | -

Mext Scheduled Time

| Execute All Workflows |

Close

Figure 5-16: Workflow Scheduler dialog

=

To manually execute all workflows, click the Execute All Workflows button to
instantly perform a data evaluation.

To enable scheduling, select the Enabled checkbox and then specify when
the workflow should run. For example, every 6 hours of every day is specified
as shown in Figure 5-17.

- B
; Workflow Scheduler ﬁ

Enabled
Hours Week Days
|0.6,12,18 | 7| |L234567 | 7|

Mext Scheduled Time 1/31/2019 6:00:00 PM

| Execute All Workflows |

Close
B

Figure 5-17: Workflow Scheduler enabled
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5.7 Launching External Applications

External applications can be launched from Perception Desktop via the Tools
menu as shown in Figure 5-18.

. Perception Desktop

GE Transconnect
3 IEE C57-104
2 IEC 60599
Transformer Report Folder
CIGRE Papers Folder
GE Techlog Download Utility
GE Multihost

External Tools...
Download Service Logs...

N
BN ) B 8 8 &

; Options...
A vonieia

Figure 5-18: External Tools Menu Option

Select the External Tools option to launch the ‘External Tools’ dialog as shown
in Figure 5-19.

External Tools @

Tools

Add

Title Name
Path

Arguments

[ ok || cancel |

Figure 5-19: External Tools dialog

To create a new entry, click the Add button as shown in Figure 5-20. The Title
and Path fields become available and must be populated.
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External Tools &3
Tools
Delete ’
Title | Name |
Path | H:’
Arguments
Cancel [

Figure 5-20: External Tools dialog - after clicking ‘Add’
Enter the name of the external tool and the path of the executable file in the
respective fields.

Note: A (...) browse button to the right of the path field allows you to
browse to the executable location.

Figure 5-21 shows an example of adding Windows ‘Notepad’ as a tool.

External Tools =

Tools

Notepad | Add |

Delete ’

Title Notepad
Path C:\Windows\System32\notepad.exer ’
Arguments

| ok || cancel |

Figure 5-21: External Tools — Notepad example
You can also add an argument parameter to the external tool. The argument

can be a command or file to open when the external application is launched.
An example is shown in Figure 5-22.
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External Tools

Tools

Notepad
ServerLog

Title
Path

Arguments

Notepad

C:A\Windows\System32\notepad.exe L’

CAServerlog.txt

[ OK ” Cancel [

Figure 5-22: External Tools — Notepad example with an argument

Click OK to add the configured external tool to the Tools menu as shown in
Figure 5-23.

Y
* ()
w
=

L S0 L S e S S g -

. Perception Desktap

GE Transconnect

IEE C57-104

IEC 60599

Transformer Report Folder
CIGRE Papers Folder

GE Techlog Download Utility
GE Multihost

MNotepad

External Tools...

Download Service Logs...

Options...

Figure 5-23: Tools Menu option with Notepad added to external tools

Any of the listed externals tools can be launched independently from

Perception Desktop, if configured correctly.

To delete an external tool:

= Select Tools > External Tools to launch the ‘External Tools’ dialog.

= Select the external tool entry to delete and click Delete.

= Click Yes to the prompt as shown in Figure 5-24.
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5.8

External Tools @

Tools

Notepad l Add

Nekesd [ Aw |
Removing tool - |

@ Are you sure that you want to remove selected tool?

T ve ] w |

OK Cancel

Figure 5-24: Deleting an External Tool

The external tool is no longer listed on the Tools menu as shown in Figure
5-25.

GE Transconnect
IEE C57-104
IEC 60599
Transformer Report Folder
CIGRE Papers Folder

GE Techlog Download Utility
GE Multihost

External Tools...
Download Service Logs...

Options...

~ BLALUIL ) =

Figure 5-25: Tools Menu with Notepad removed

Transport X2 Options

The Transport X2 device is represented in the Asset Hierarchy and appears

above the root node as shown in Figure 5-26.

Note: The asset is automatically detected about 30 seconds after the

device is connected to a PC with Perception Desktop.
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= Perception Desktop

Asset Explorer
Asset Hierarchy

& Transport X 801233 14
4 LY GCAGZLT2E

)
I s Transformer_8

Figure 5-26: Transport X? Asset hierarchy

The Properties worksheet contains some basic information about the device,
such as the serial number as shown in Figure 5-27. To establish
communication with the device, the connection needs to be confirmed on the
device side. From the Transport X?touchscreen Main Menu, press PC Sync.

Transport X* 801233

Device Type = Transport X2

Serial Number 801233

Firmware version

IP Address 168.254.25.17

Figure 5-27: Transport X? Properties worksheet — before connection

The Properties worksheet details additional sections (Statistics &
Measurements) as shown in Figure 5-28.

Transport X* 801233

Device Type

Transport X*

Serial Number

Firmware version

IP Address 169.254.25.17

Number of Transformers
Number of Transformer Measurements
Filter Status

Service Required

Timestamp
Equipment

Serial number

Qil Type Mineral Qil

Figure 5-28: Transport X? Properties tab - after connection
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If new measurements are detected after successful connection to a PC, the
user is advised to download the data as shown in Figure 5-29 (or this action

can be performed later as described below).
(X

i . — - -
Download measurements - -

801233?

Yes

‘.6‘ Would you like to download measurements from Transport X*

No

L]
y

Figure 5-29: Transport X2 Download measurements message

Right click on the Transport X? asset to see the available options as shown in

Figure 5-30.

Asset Hierarchy | Ranking

& Transport X2 801233

4 L4 GCAGZ Download

| :}iib.} Tra Download Logs

| jé A Export to CSV

Figure 5-30: Transport X2 options

= Download: retrieves all measurements stored on the device and creates
appropriate transformer nodes in the asset tree (or adds additional
information to existing nodes based on serialnum / equipnum id).

= Download Logs: retrieves debugging and sustaining information from the

device to be used by service engineers.

= Export to CSV: export all Transport X? data to a CSV file to maintain
compatibility with a legacy requirement. Note: When exporting to CSV, the
file is automatically adjusted to the regional settings on the local machine.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3

22-Oct-24

Page 154 of 220



Appendix Alnstalling the Transport X driver in Windows 7

Transport X is a portable device that can be used onsite to sample oil by
direct connection to the assets. The Transport X device is then brought back
to the office and connected via USB to your PC. The data collected from the
assets is then transferred to your PC and Perception will then load the data
into the server database.

The Transport X device is installed in the same manner as any plug and play
device attached to a PC.

A.1 Installing Mobile Device Center
The generic Microsoft Mobile Device Center must be downloaded from the
Microsoft website.
For Windows Vista/7 x86 (32-Bit):
http://www.microsoft.com/download/en/details.aspx?displaying=en&id=14

For Windows Vista/7 x86 (64-Bit):

http://www.microsoft.com/en-us/download/details.aspx?id=3182

As part of the download process, you will have to allow the Microsoft
Validation to take place. More information about the Validation requirements
can be obtained by a ‘click here’ link as shown in Figure A-1.

Validation Required

For more information about the validation processg

Quick details

Version: 6.17.67965 Date Published: 8/20/2007
Change Language: English E]
File Name Size

drvupdate-x86.exe 120 MB m

Windows Phone Microsoft Update
£
The only phone with Microsoft ALY Check for the latest security
Office and thousands of apps. ( updates to help protect your
BT ] computer,
| Buy now >| “ ‘p
o Download now > ‘

Figure A-1: Validation
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After the validation process click Download as shown in Figure A-2.

Quick details

Version: 6.1.6965
Change Language: English
File Name

drvupdate-x56.exe

Windows Phone

The only phone with
Microsoft Office and
thousands of apps.

Date Published: 8/20/2007
Size
12.0 MB DOWNLOAD
" Microsoft Update
Ey
i

Check for the latest security
updates to help protect your
computer.

| Download now >

Figure A-2: Download

Then click Run on the File Download - Security Warning dialog as shown in

Figure A-3.

File Download - Security Warning
Do you want te run or save this file?

@ Mame: drvupdate-x86.exe
Type: Application, 12.0MB

From: download.microsoft.com

Run ] ’ Save ]

| cancel |

run or save this software. What's the risk?

I--"\ While files from the Intemet can be useful, this file type can
\gj potentially ham your computer. i you do not trust the source, do not

Figure A-3: Security Warning

And click Run again on the Internet Explorer — Security Warning dialog as

shown in Figure A-4.

Internet Explorer - Security Warning

Do you want to run this software?
@ Name: Windows Mobile Device Center
Publisher: Microsoft Corporation

E] More options Run

] [ pontrRun |

|'F\ While files from the Internet can be useful, this file type can potentially harm
. your computer. Only run software from publishers you trust. What's the risk?

Figure A-4: Browser Security Warning
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The software prepares to install and displays the following series of dialogs as
shown in Figure A-5.

Windows Mobile Device Center Driver Update

_o[d] Preparing to install...
| o

Windows Mobile Device Center Driver Update

__El_ Please wait while Windows configures Windows Mobile Device Center
I .'"g:‘-‘ Driver Update

Time remaining: 1 seconds

Cancel
__ Driver Software Installation ==
Installing device driver software
Unidentified Device {_) Searching preconfigured driver folders...

Windows Mobile Device Center

Please wait while Windows configures Windows Mobile Device Center
T

Time remaining: 3 seconds

— | Cancel

Figure A-5: Installation dialogs

If Figure A-6 appears during the process or at the end, then the installation
has been unsuccessful. Click the Close button and install the Transport X
device manually as outlined in Section A.2.

_',! Driver Software Installation @
Device driver software was not successfully installed
Unidentified Device xDe\rice unplugged

What can I de if my device did not install properky?

Figure A-6: Unsuccessful device driver installation

A.2 Installing Transport X

To connect the Transport X (running Windows CE 5.0 or 4.2) to a computer
running Windows 7, follow the steps below:

= Power up the device.

= Connect the device to your computer with the supplied USB cable.
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= You will see a ‘Found New Hardware’ screen.

» |f you had already installed or attempted installing a driver, you can right-
click Computer, choose Manage and go to Device Manager.

» |f the device appears under ‘Mobile Devices’, then use the ‘Update Device

Driver’ utility.

= Select the option to locate and install software as shown in Figure A-7.

g ,-)\ S|58 » Control Panel »

Adjust your computer's settings

System and Security
Review your computer's status
Back up your computer

Find and fix problems

Network and Internet
Connect to the Internet
View network status and tasks

Choose homegroup and sharing options

Hardware and Sound
* View devices and printers

8,
Ay

<

Add a device

Programs

Hardware and Sound

play CDs automatically, conserve
Uninstall a program| power, update device drivers, and

Add or remove printers and other
hardware, change system sounds,
more.

Figure A-7: Control Panel

|Search Control Panel

View by: Category ¥

User Accounts and Family Safety
‘@' Add or remove user accounts
‘f@ Set up parental controls for any user

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region
Change keyboards or other input methods
Change display language

Ease of Access
Let Windows suggest settings
Optimize visual display

= Under Devices and Printers, select Device Manager as shown in Figure

A-8.
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e,

€ @ # » Control Panel » Hardware and Sound » v Search Control Panel Pt

Control Panel Home 5 5
' Devices and Printers

. i i ' \.." M
Systerm and Sacirity Add adevice | Addaprinter | Mouse | @) Device Manager

Network and Internet AutoPlay
Hardaare and Siad Change default settings for media or devices | Play CDs or cther media automatically

Programs 7y Sound

User Accounts and Family Adjust system volume | Change system sounds | Manage audio devices

patery Fp Power Options

Appearal_'lce_and Change power-saving settings | Change what the power buttons do
Personalization Require 2 password when the computer wakes | Change when the computer sleeps
Clock, Language, and Region Choose a power plan

Ease of Access

Display
Make text and other items larger or smaller | Adjust screen resolution
Connect to an external display | How to correct monitor flicker (refresh rate)

Windows Mobile Device Center
Change connection settings

Figure A-8: Devices and Printers
= Expand Other devices to display Kelman Transport X as shown in Figure
A-9.

TOTETRTT e— A

Eile Action View Help

&5 | FE HE R KRS
4% WIN-3IFBL6OIKEM
[:> 9 Batteries

> 4% Computer

b g Disk drives

> B Display adapters

> oty DVD/CD-ROM drives

- Floppy disk drives

es Floppy drive controllers

b Q:Qj’s Human Interface Devices
b g IDE ATA/ATAPI controllers
- Keyboards

b B Mice and other pointing devices
» B Monitors

»-% Sound, video and game controllers
» & Storage controllers

b M System devices

b @ Universal Serial Bus controllers

Figure A-9: Device Manager

= Right-click Kelman Transport X and select Update Driver Software as
shown in Figure A-10.
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File Action View Help

|les @D Bm &R &S

4 ;25 WIN-3IFBL6OIKEM
b % Batteries
» 8 Computer
b ¢ Disk drives
» & Display adapters
I b ) DVD/CD-ROM drives
| » = Floppy disk drives
I b BE Floppy drive controllers
b &35 Human Interface Devices
I I g IDE ATA/ATAPI controllers
|| b Keyboards
b B Mice and other pointing devices
b & Monitors
> lf Network adapters
|3 Other devices

- il Kelman Transport X
» Y3 Ports (COM & LPT) Update Driver Software...
b B Processors Disable
3 Q Sound, video and g Uninstall
1> Storage controllers
;-8 System devices Scan for hardware changes
b a Universal Serial Bus
Properties

|Li- Launches the Update Driver Software Wizard for the selected device.

Figure A-10: Device Manager - Update Driver Software
= On the Windows Permission Request screen, click Continue.

* On the next screen, select Browse my computer for driver software as
shown in Figure A-11.

e

@ [l Update Driver Software - Kelman Transport X

How do you want to search for driver software?

< Search automatically for updated driver software

I Windows will search your computer and the Internet for the latest driver software
I for your device, unless you've disabled this feature in your device installation
[l settings.

I

L

| = Browse my computer for driver software

i Locate and install driver software manually.

||

|

|

L

|

|

Cancel

%

Figure A-11: Update Driver Software - Kelman Transport X
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= Select Let me pick from a list of device drivers on my computer as shown

in Figure A-12.

@ [l Update Driver Software - Kelman Transport X

Browse for driver software on your computer

Search for driver software in this location:

C:\Users\root\Documents = Browse...
Include subfolders

 Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

| Nex

] [ Cancel ]

.

Figure A-12: Browse for driver software

= Select Mobile devices, then click Next as shown in Figure A-13.

@ | Update Driver Software - Kelman Transport X

=

Select your device's type from the list below.

Common hardware types:

Filmaging devices

f Infrared devices

= Keyboards

g Media Center Extender
@ Medium Changer devices
B \emory devices

E1]Memory technolegy driver
8 Mice and other pointing devices
SANR apmon Controller For Windows Class

m

] [ Cancel

A

Figure A-13: Choose the device type
= Clear the Show compatible hardware checkbox.
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* |n the Manufacturer column, choose Microsoft as shown in Figure A-14.
* |n the Model column, choose Microsoft USB Sync.
= Click Next.

@ I Update Driver Software - Kelman Transport X

Select the device driver you want to install for this hardware.

3 Select the manufacturer and model of your hardware device and then click Next. If you have a
o disk that contains the driver you want to install, click Have Disk.

|
Ll
[l
i Manufacturer - pe
\ ( 5 Microsoft USB Sync

( a3l = Pocket PC 2002 3
| T — | | Sl Windows Powered Pocket PC 2003 L
| MMT ) Windows Powered Smartphone 2002
[ LY 7o YR 1y T LS LV Y/ PRy , PSS I SRRy oy MRS, 1, 1, Y | X
| ) This driveris digitally signed.
|
i Tell me why driver signing is important

[ Next ][ Cancel ]

Figure A-14: Select the device driver
= Select Connect without setting up your device.
* |n the ‘Update Driver Warning' dialog, click Yes as shown in Figure A-15.

Update Driver Warning I“l

4. Installing this device driver is not recommended because Windows
/Alt_i. cannot verify that it is compatible with your hardware. If the driver is
not compatible, your hardware will not work correctly and your
computer might become unstable or stop working completely. Do you
want to continue installing this driver?

Figure A-15: Update driver warning
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» The Installing Driver Software progress bar displays as shown in Figure
A-16.

B

@ Lﬂl Update Driver Software - Kelman Transport X

Installing driver software...

| — e

A

Figure A-16: Installation progress bar

= When the driver has successfully updated, the following screen as shown in
Figure A-17 displays.

[

@ \l Update Driver Software - Microsoft USB Sync

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

@ Microsoft USB Sync

.

Figure A-17: Driver update complete
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= A successful connection is indicated by a green check mark and the word
‘Connected’ as shown in Figure A-18.

Windows |

'r Mobile®

Get Outlook contacts, calendar, e-mail and other
information on your device.

Connect without setting up your device

BITSYXB_JP
Device driver software installed successfully.
13:55

ENG & 3 [m @ )
L = et

Figure A-18: Successful connection
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Appendix BDatabase Mappings for Import and Export

During a Perception export, only the browse names get exported to the CSV file for oll
source and peripheral measurements including their group names. For example,
multiple oil sources, such as the Main, Selector and Diverter tanks, are represented in
the software with the following browse names OilSourceA, OilSourceB and QilSourceC
respectively. On export it is only these underlying browse names that get exported to
the CSV file (not the user-defined names for multiple oil sources specified in the
device setup). The reason for this is that Perception analytics (such as Duval,
GasRatio, KeyGas) recognises only the browse name for the oil sources. Common
browse names also allow Perception data to be imported into any other localised
version of Perception.

Table B-1 lists all the CSV headers, the corresponding field mappings in the Perception
database and a brief description below (where required). When creating custom
import and export mappings, refer to this table to ensure valid data exchange.

Table B-1: Database Mappings

CSV header Field mapping

equipnum equipnum

The name of the asset shown in the Asset Explorer on import. Data must contain an ‘equipnum’ or ‘Serialnum’
field.

assettype assettype

The type of asset. Required, otherwise a transformer asset will be created on import (used for TOA and
TransportX format files).

assettype = HydranM2, MO150, Transfix1_6, MINITRANS, DGA 500, MULTITRANS, TAPTRANS, DUALTRANS,
BMT300, Transfix1_5, Transformer, TransformerBank, Hydran201ti, SubStation, Area

Serialnum | SerialNumber

The serial number of the asset. Data must contain an ‘equipnum’ or ‘Serialnum’ field.

sampledate | sampledate

The data records. Required field if importing ‘measurement data’. If importing ‘properties’ only, this field can be
omitted.

Tank | Tank
The tanks listed under the transformer. Required for the import of TOA format files only.
apprtype | apprtype

The type of asset. E.g. Transfix 1.6 (used for Perception and TransConnect format files).
apprtype = HydranM2, MO150, Transfix1_6, MINITRANS, DGA 500, MULTITRANS, TAPTRANS, DUALTRANS,
BMT300, Transfix1_5, Transformer, TransformerBank, Hydran201ti, SubStation, Area

pgaerrorcodes | pgaerrorcodes

OilSourceA|H2 | OilSourceA|H2

The first value denotes the measurement group or oil source that gets created on import, the second value
denotes a measurement point under that group or oil source. Required for all CSV headers, except the following:
headers that represent property fields

headers appended with the text ‘Diagnostic’.

OilSourceA|H2|Diagnostic | OilSourceA|H2|Diagnostic

Any header format appended with the text ‘Diagnostic’, imports the diagnostic information for the measurement
where the data is of bad or uncertain quality (!B or !U).

OilSourceA|CH4 | OilSourceA|CH4
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OilSourceA|CH4|Diagnostic

| OilSourceA|CH4|Diagnostic

OilSourceA|C2H2

| OilSourceA|C2H2

OilSourceA|C2H2|Diagnostic

| OilSourceA|C2H2|Diagnostic

OilSourceA|C2H4

| OilSourceA|C2H4

OilSourceA|C2H4|Diagnostic

| OilSourceA|C2H4|Diagnostic

OilSourceA|C2H6

| OilSourceA|C2H6

OilSourceA|C2H6|Diagnostic

| OilSourceA|C2H6|Diagnostic

OilSourceA|CO

| OilSourceA|cO

OilSourceA|CO|Diagnostic

| OilSourceA|CO|Diagnostic

OilSourceA|CO2

| OilSourceA|cO2

OilSourceA|CO2|Diagnostic

| OilSourceA|CO2|Diagnostic

OilSourceA|02

| OilSourceA|02

OilSourceA|02|Diagnostic

| OilSourceA|02|Diagnostic

OilSourceA|TDCG

| OilSourceA|TDCG

OilSourceA|TDCG|Diagnostic

| OilSourceA|TDCG|Diagnostic

OilSourceA|H20

| OilSourceA|H20

OilSourceA|H20|Diagnostic

| OilSourceA|H20|Diagnostic

OilSourceA|AmbientTemp

| OilSourceA|AmbientTemp

OilSourceA|AmbientTemp|Diagnostic

| OilSourceA|AmbientTemp|Diagnostic

OilSourceA|NormalizationTemp

| OilSourceA|NormalizationTemp

OilSourceA|NormalizationTemp|Diagnostic

| OilSourceA|NormalizationTemp|Diagnostic

OilSourceA|OQilPressure

| OilSourceA|QilPressure

OiISourceAlOiIPressurelDiagnostic

| OilSourceA|OilPressure|Diagnostic

OilSourceA|QilTemp

| OilSourceA|QilTemp

OilSourceA|OilTemp|Diagnostic

| OilSourceA|OilTemp|Diagnostic

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24

Page 166 of 220




OilSourceA|N2 | OilSourceA|N2

OilSourceA|N2|Diagnostic | OilSourceA|N2|Diagnostic

OilSourceA|TDG | OilSourceA|TDG

OilSourceA|TDG|Diagnostic | OilSourceA|TDG|Diagnostic

Peripherals|Analog|Analog Input-2 | Peripherals|Analog|Analog Input-2

On import of this header format, for example, a ‘Peripherals’ group is created with an ‘Analog’ subgroup. Input-2 is
the measurement created under the Analog subgroup. This interpretation is similar for all peripheral inputs.

Note: If the CSV header contains more than one attribute separated by a pipe character (|), it is the value after
the last pipe character that is considered the measurement point. All preceding values are treated as subgroups.
The only exceptions to this behavior are headers with the appendage ‘Diagnostic’.

Peripherals|Analog|Analog Input-1

| Peripherals|Analog|Analog Input-1

Peripherals|Analog|Analog Input-6

| Peripherals|Analog|Analog Input-6

Peripherals|Analog|Analog Input-5

| Peripherals|Analog|Analog Input-5

Peripherals|Analog|Analog Input-4

| Peripherals|Analog|Analog Input-4

Peripherals|Analog|Analog Input-3

| Peripherals|Analog|Analog Input-3

Peripherals| TransOpto|Channell

| Peripherals|TransOpto|Channel1

OilSourceB|H2

| OilSourceB|H2

OilSourceB|CH4

| OilSourceB|CH4

OilSourceB|C2H2

| OilSourceB|C2H2

OilSourceB|C2H4

| OilSourceB|C2H4

OilSourceB|C2H6

| OilSourceB|C2H6

OilSourceB|CO

| OilSourceB|CcO

OilSourceB|C02

| OilSourceB|C02

OilSourceB|02

| OilSourceB|02

OilSourceB|TDCG

| OilSourceB|TDCG

OilSourceB|H20

| OilSourceB|H20

OilSourceB|AmbientTemp

| OilSourceB|AmbientTemp

OilSourceB|NormalizationTemp

| OilSourceB|NormalizationTemp
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OilSourceB|OilPressure

| OilSourceB|OilPressure

OilSourceB|OilTemp

| OilSourceB|0ilTemp

OilSourceB|N2

| OilSourceB|N2

OilSourceC|H2

| OilSourceC|H2

OilSourceC|CH4

| OilSourceC|CH4

OilSourceC|C2H2

| OilSourceC|C2H2

OilSourceC|C2H4

| OilSourceC|C2H4

OilSourceC|C2H6

| OilSourceC|C2H6

OilSourceC|CO

| OilSourceC|CO

OilSourceC|C0O2

| OilSourceC|C02

OilSourceC|02

| OilSourceC|02

OilSourceC|TDCG

| OilSourceC|TDCG

OilSourceC|H20

| OilSourceC|H20

OilSourceC|AmbientTemp

| OilSourceC|AmbientTemp

OilSourceC|NormalizationTemp

| OilSourceC|NormalizationTemp

OilSourceC|QilPressure

| OilSourceC|OilPressure

OilSourceC|OilTemp

| OilSourceC|OilTemp

GasRatioFormulaContainer

OilSourceA

Formulalnfol|Formula

GasRatioFormulaContainer

OilSourceA

Formulalnfo2|Formula

GasRatioFormulaContainer

OilSourceA

Formulalnfo3

Formula

GasRatioFormulaContainer

OilSourceA

Formulalnfo4

Formula

GasRatioFormulaContainer

OilSourceA

Formulalnfo5

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfol]

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfo2

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfo3

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfo4

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfo5

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfol]

Formula

GasRatioFormulaContainer

OilSourceB

Formulalnfo2|Formula

GasRatioFormulaContainer|OilSourceB|Formulalnfo3|Formula

GasRatioFormulaContainer|OilSourceB|Formulalnfo4|Formula
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GasRatioFormulaContainer|OilSourceB|Formulalnfo5|Formula

GasRatioFormulaContainer|OilSourceC|Formulalnfo1|Formula

GasRatioFormulaContainer|OilSourceC|Formulalnfo2|Formula

GasRatioFormulaContainer|OilSourceC|Formulainfo3|Formula

GasRatioFormulaContainer|OilSourceC|Formulalnfo4|Formula

GasRatioFormulaContainer|OilSourceC|Formulalnfo5|Formula

GasRatioFormulaContainer|OilSourceA|Formulalnfol|FormulaName

GasRatioFormulaContainer|OilSourceA|Formulalnfo2|FormulaName

GasRatioFormulaContainer|OilSourceA|Formulalnfo3|FormulaName

GasRatioFormulaContainer|OilSourceA|Formulalnfo4|FormulaName

GasRatioFormulaContainer|OilSourceA|Formulalnfo5|FormulaName

GasRatioFormulaContainer|OilSourceB|Formulalnfol|FormulaName

GasRatioFormulaContainer|OilSourceB|Formulalnfo2|FormulaName

GasRatioFormulaContainer|OilSourceB|Formulalnfo3|FormulaName

GasRatioFormulaContainer|OilSourceB|Formulalnfo4|FormulaName

GasRatioFormulaContainer|OilSourceB|Formulalnfo5|FormulaName

GasRatioFormulaContainer|OilSourceC|Formulalnfo1|FormulaName

GasRatioFormulaContainer|OilSourceC|Formulalnfo2|FormulaName

GasRatioFormulaContainer|OilSourceC|Formulalnfo3|FormulaName

GasRatioFormulaContainer|OilSourceC|Formulalnfo4|FormulaName

GasRatioFormulaContainer|OilSourceC|Formulalnfo5|FormulaName

Peripherals|Digital|Digital Input-1 | Peripherals|Digital|Digital Input-1
Peripherals|Digital|Digital Input-2 | Peripherals|Digital|Digital Input-2
Peripherals|Digital|Digital Input-3 | Peripherals|Digital|Digital Input-3
Hydran|Hydran Hourly Trend Period | Hydran|Hydran Hourly Trend Period

The first value denotes the measurement group that gets created on import e.g. Hydran, the second value
denotes a measurement point under that group e.g. Hydran Hourly Trend Period. This interpretation is similar for
all CSV headers of this format.

Hydraanydran Daily Trend Period | Hydran|Hydran Daily Trend Period
System|Battery | System|Battery

System|Transformer Type | System|Transformer Type

Moisture|%RH Hourly Average Period | Moisture|%RH Hourly Average Period
Moisture|Standard Temperature for RH | Moisture|Standard Temperature for RH
TemperaturelAmbient Temperature | Temperature|Ambient Temperature
TemperaturelTop Oil Temperature | Temperature|Top Oil Temperature
TemperaturelCaIcuIated Top Oil Temperature | Temperature|CalcuIated Top Oil Temperature
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Temperature|CaIcuIated Top Oil Difference

| Temperature|Calculated Top Oil Difference

TemperaturelCalculated Bottom Oil Temperature

| Temperature|CaIcuIated Bottom QOil Temperature

Power|Apparent Power from H Winding

| PowerlApparent Power from H Winding

Power|Apparent Power from X Winding

| Power|Apparent Power from X Winding

Power|Apparent Power from Y Winding

| Power|Apparent Power from Y Winding

Current|Current Winding H

| Current|Current Winding H

Current|Current Winding X

| Current|Current Winding X

Current|Current Winding Y

Current|Current Winding Y

Winding Hot Spot|Per Unit load on the most loaded
winding

Winding Hot Spot|Per Unit load on the most loaded
winding

Winding Hot Spot|Winding Hot-Spot Temperature in
Winding H

Winding Hot Spot|Winding Hot-Spot Temperature in
Winding H

Winding Hot Spot|Winding Hot-Spot Temperature in
Winding X

Winding Hot Spot|Winding Hot-Spot Temperature in
Winding X

Winding Hot Spot|Winding Hot-Spot Temperature in
Winding Y

Winding Hot Spot|Winding Hot-Spot Temperature in
Winding Y

Winding Hot Spot|Highest Winding Hot-Spot
Temperature

Winding Hot Spot|Highest Winding Hot-Spot
Temperature

Winding Hot Spot|Per Unit load on the most loaded
winding corrected for Ambient and Altitude

Winding Hot Spot|Per Unit load on the most loaded
winding corrected for Ambient and Altitude

Winding Hot Spot|Highest Winding Hot-Spot
Temperature Source Winding

Winding Hot Spot|Highest Winding Hot-Spot
Temperature Source Winding

Winding Hot Spot|Per Unit load on the most loaded
winding source

Winding Hot Spot|Per Unit load on the most loaded
winding source

OLTC|OLTC Tank Temperature

OLTC|OLTC Tank Temperature

OLTC|OLTC Differential Temperature

| OLTC|OLTC Differential Temperature

OLTC|Short Term Average of Tap Changer
Temperature Differential

OLTC|Short Term Average of Tap Changer
Temperature Differential

OLTC|Short Term Filtering Value

| OLTC|Short Term Filtering Value

OLTC|Long Term Average of Tap Changer
Temperature Differential

OLTC|Long Term Average of Tap Changer Temperature
Differential
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OLTC|Long Term Filtering Value | OLTC|Long Term Filtering Value

Cooling|Cooling Efficiency Index | Cooling|Cooling Efficiency Index

Cooling|Cooling Stage 0 Total Activity Time | Cooling|Cooling Stage 0 Total Activity Time
Cooling|Cooling Bank1 Total Activity Time | Cooling|Cooling Bank1 Total Activity Time
Cooling|Cooling Bank2 Total Activity Time | Cooling|Cooling Bank2 Total Activity Time
Cooling|Cooling Bank 1 Current | Cooling|Cooling Bank 1 Current

CoolinglCooling Bank 2 Current | Cooling|Cooling Bank 2 Current

Cooling|Cooling Bank1 Activated | Cooling|Cooling Bank1 Activated

Cooling|Cooling Bank2 Activated | Cooling|Cooling Bank2 Activated

Cooling|Cooling Stage | Cooling|Cooling Stage

Insulation AginnghermaI Aging Acceleration Factor | Insulation Aging|Thermal Aging Acceleration Factor
Insulation Aging|Moisture Aging Acceleration Factor | Insulation Aging|Moisture Aging Acceleration Factor
Insulation Aging|Global Aging Acceleration Factor | Insulation Aging|Global Aging Acceleration Factor
Insulation AginglCumuIative Aging | Insulation Aging|CumuIative Aging

Insulation Aginngervice Time | Insulation Aging|Service Time

Tap Position|Permanent Tap Position Transition Count | Tap Positioanermanent Tap Position Transition Count

Tap Position|Permanent Transition Count for Position 1 | Tap Position|Permanent Transition Count for Position 1

Tap Position|Permanent Transition Count for Position 2 | Tap Position|Permanent Transition Count for Position 2

Tap Position|Permanent Transition Count for Position 3 | Tap Positioanermanent Transition Count for Position 3

Tap Position|Permanent Transition Count for Position 4 | Tap Position|Permanent Transition Count for Position 4

Tap Position|Permanent Transition Count for Position 5 | Tap Position|Permanent Transition Count for Position 5

Tap Position|Permanent Transition Count for Position 6 | Tap Position|Permanent Transition Count for Position 6

Tap Position|Permanent Transition Count for Position 7 | Tap Positioanermanent Transition Count for Position 7

Tap Position|Permanent Transition Count for Position 8 | Tap Position|Permanent Transition Count for Position 8

Tap Position|Permanent Transition Count for Position 9 | Tap Position|Permanent Transition Count for Position 9
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Tap Position|Permanent Transition Count for Position
10

Tap Position|Permanent Transition Count for Position 10

Tap Position|Permanent Transition Count for Position
1

Tap Position|Permanent Transition Count for Position 11

Tap Position|Permanent Transition Count for Position
12

Tap Position|Permanent Transition Count for Position 12

Tap Position|Permanent Transition Count for Position
13

Tap Position|Permanent Transition Count for Position 13

Tap Position|Permanent Transition Count for Position
14

Tap Position|Permanent Transition Count for Position 14

Tap Position|Permanent Transition Count for Position
15

Tap Position|Permanent Transition Count for Position 15

Tap Position|Permanent Transition Count for Position
16

Tap Position|Permanent Transition Count for Position 16

Tap Position|Permanent Transition Count for Position
17

Tap Position|Permanent Transition Count for Position 17

Tap Position|Permanent Transition Count for Position
18

Tap Position|Permanent Transition Count for Position 18

Tap Position|Permanent Transition Count for Position
19

Tap Position|Permanent Transition Count for Position 19

Tap Position|Permanent Transition Count for Position
20

Tap Position|Permanent Transition Count for Position
20

Tap Position|Permanent Transition Count for Position
21

Tap Position|Permanent Transition Count for Position 21

Tap Position|Permanent Transition Count for Position
22

Tap Position|Permanent Transition Count for Position
22

Tap Position|Permanent Transition Count for Position
23

Tap Positioanermanent Transition Count for Position
23

Tap Position|Permanent Transition Count for Position
24

Tap Position|Permanent Transition Count for Position
24

Tap Position|Permanent Transition Count for Position
25

Tap Position|Permanent Transition Count for Position
25

Tap Position|Permanent Transition Count for Position
26

Tap Position|Permanent Transition Count for Position
26

Tap Position|Permanent Transition Count for Position
27

Tap Positioanermanent Transition Count for Position
27
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Tap Position|Permanent Transition Count for Position
28

Tap Position|Permanent Transition Count for Position
28

Tap Position|Permanent Transition Count for Position
29

Tap Position|Permanent Transition Count for Position
29

Tap Position|Permanent Transition Count for Position
30

Tap Position|Permanent Transition Count for Position
30

Tap Position|Permanent Transition Count for Position
31

Tap Position|Permanent Transition Count for Position 31

Tap Position|Permanent Transition Count for Position
32

Tap Position|Permanent Transition Count for Position
32

Tap Position|Permanent Transition Count for Position
33

Tap Position|Permanent Transition Count for Position
33

Tap Position|Permanent Transition Count for Position
34

Tap Position|Permanent Transition Count for Position
34

Tap Position|Permanent Transition Count for Position
35

Tap Position|Permanent Transition Count for Position
35

Tap Position|Operator Tap Position Transition Count

| Tap Position|Operator Tap Position Transition Count

Tap Position|Resettable Count for Position 1

| Tap Position|Resettable Count for Position 1

Tap Position|Resettable Count for Position 2

| Tap Position|Resettable Count for Position 2

Tap Position|Resettable Count for Position 3

| Tap Position|Resettable Count for Position 3

Tap Position|Resettable Count for Position 4

| Tap Position|Resettable Count for Position 4

Tap Position|Resettable Count for Position 5

| Tap Position|Resettable Count for Position 5

Tap Position|Resettable Count for Position 6

| Tap Position|Resettable Count for Position 6

Tap Position|Resettable Count for Position 7

| Tap Position|Resettable Count for Position 7

Tap Position|Resettable Count for Position 8

| Tap Position|Resettable Count for Position 8

Tap Position|Resettable Count for Position 9

| Tap Position|Resettable Count for Position 9

Tap Position|Resettable Count for Position 10

| Tap Position|Resettable Count for Position 10

Tap Position|Resettable Count for Position 11

| Tap Position|Resettable Count for Position 11

Tap Position|Resettable Count for Position 12

| Tap Position|Resettable Count for Position 12

Tap Position|Resettable Count for Position 13

| Tap Position|Resettable Count for Position 13
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Tap Position|Resettable Count for Position 14

| Tap Position|Resettable Count for Position 14

Tap Position|Resettable Count for Position 15

| Tap Position|Resettable Count for Position 15

Tap Position|Resettable Count for Position 16

| Tap Position|Resettable Count for Position 16

Tap Position|Resettable Count for Position 17

| Tap Position|Resettable Count for Position 17

Tap Position|Resettable Count for Position 18

| Tap Position|Resettable Count for Position 18

Tap Position|Resettable Count for Position 19

| Tap Position|Resettable Count for Position 19

Tap Position|Resettable Count for Position 20

| Tap Position|Resettable Count for Position 20

Tap Position|Resettable Count for Position 21

| Tap Position|Resettable Count for Position 21

Tap Position|Resettable Count for Position 22

| Tap Position|Resettable Count for Position 22

Tap Position|Resettable Count for Position 23

| Tap Position|Resettable Count for Position 23

Tap Position|Resettable Count for Position 24

| Tap Position|Resettable Count for Position 24

Tap Position|Resettable Count for Position 25

| Tap Position|Resettable Count for Position 25

Tap Position|Resettable Count for Position 26

| Tap Position|Resettable Count for Position 26

Tap Position|Resettable Count for Position 27

| Tap Position|Resettable Count for Position 27

Tap Position|Resettable Count for Position 28

| Tap Position|Resettable Count for Position 28

Tap Position|Resettable Count for Position 29

| Tap Position|Resettable Count for Position 29

Tap Position|Resettable Count for Position 30

| Tap Position|Resettable Count for Position 30

Tap Position|Resettable Count for Position 31

| Tap Position|Resettable Count for Position 31

Tap Position|Resettable Count for Position 32

| Tap Position|Resettable Count for Position 32

Tap Position|Resettable Count for Position 33

| Tap Position|Resettable Count for Position 33

Tap Position|Resettable Count for Position 34

| Tap Position|Resettable Count for Position 34

Tap Position|ResettabIe Count for Position 35

| Tap Position|Resettable Count for Position 35

Tap Position|ActuaI Tap Position

| Tap PositionlActuaI Tap Position

DLG|Rated Voltage on LV side

| DLG|Rated Voltage on LV side

DLG|Rated Voltage on HV side

| DLG|Rated Voltage on HV side
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DLGlRated Power at Cooling Stage 0

| DLG|Rated Power at Cooling Stage 0

DLGlRated Power at Cooling Stage 1

| DLG|Rated Power at Cooling Stage 1

DLG|Rated Power at Cooling Stage 2

| DLG|Rated Power at Cooling Stage 2

DLG|User estimated Water content in Winding
insulation Paper

DLG|User estimated Water content in Winding
insulation Paper

DLG|Number of Cooling Banks

| DLG|Number of Cooling Banks

DLG|OverLoad Duration #1

| DLG|OverLoad Duration #1

DLG|Load Limiting Factor #1

| DLG|Load Limiting Factor #1

DLG|OverLoad Duration #2

| DLG|OverLoad Duration #2

DLG|Load Limiting Factor #2

| DLG|Load Limiting Factor #2

DLG|OverlLoad Duration #3

| DLG|OverLoad Duration #3

DLG|Load Limiting Factor #3

| DLG|Load Limiting Factor #3

DLG|OverlLoad Duration #4

| DLG|OverLoad Duration #4

DLG|Load Limiting Factor #4

| DLG|Load Limiting Factor #4

DLG|OverlLoad Duration #5

| DLG|OverLoad Duration #5

DLG|Load Limiting Factor #5

| DLG|Load Limiting Factor #5

DLG|OverlLoad Duration #6

| DLG|OverLoad Duration #6

DLG|Load Limiting Factor #6

| DLG|Load Limiting Factor #6

DLG|OverlLoad Duration #7

| DLG|OverLoad Duration #7

DLG|Load Limiting Factor #7

| DLG|Load Limiting Factor #7

DLG|OverLoad Duration #8

| DLG|OverLoad Duration #8

DLG|Load Limiting Factor #8

| DLG|Load Limiting Factor #8

DLG|OverLoad Duration #9

| DLG|OverLoad Duration #9

DLG|Load Limiting Factor #9

| DLG|Load Limiting Factor #9

DLG|OverLoad Duration #10

| DLG|OverLoad Duration #10
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DLG|Load Limiting Factor #10

| DLG|Load Limiting Factor #10

DLG|Max. Top Oil Temp.

| DLG|Max. Top Oil Temp.

DLG|Max. Hot Spot Temp.

| DLG|Max. Hot Spot Temp.

DLG|Min. Bubbling Margin Temp.

| DLG|Min. Bubbling Margin Temp.

DLG|Max. Load Factor on HV Bushing

| DLG|Max. Load Factor on HV Bushing

DLG|Max. Load Factor on LV Bushing

| DLG|Max. Load Factor on LV Bushing

DLG|Max. Load Factor on Tap Changer

| DLG|Max. Load Factor on Tap Changer

Communications|ConnectionString

Communications
Communications
Communications
Communications
Communications
Communications
Communications
Communications
Communications

CronString
IsScheduleEnabled
NextScheduledDownload
ServiceAlarmDescription
NotificationEmail
ExpertEmail
IsAutoExportEnabled
ExportCronString
DownloadError

Communications
Communications
Communications
Communications
Communications
Communications
Communications
Communications
Communications

Communications|ConnectionString

CronString
IsScheduleEnabled
NextScheduledDownload
ServiceAlarmDescription
NotificationEmail
ExpertEmail
IsAutoExportEnabled
ExportCronString
DownloadError

Communications|ServiceAlarmDescription Communications|ServiceAlarmDescription

These are all property fields. No mapping is required.

Environmental|Ambient Humidity | Environmental| Ambient Humidity

Environmental|Ambient Temperature | Environmental|Ambient Temperature

Environmental|Bottom Oil Temperature | Environmental|Bottom Oil Temperature

EnvironmentallTop Oil Temperature | EnvironmentaI|Top Oil Temperature

PrimaryBushing|C1% A | PrimaryBushing|C1% A

PrimaryBushing|C1% B | PrimaryBushing|C1% B

PrimaryBushing|C1% C | PrimaryBushing|C1% C

PrimaryBushing|C1% Polar Plot Level | PrimaryBushing|C1% Polar Plot Level

PrimaryBushing|C1% Polar Plot Angle | PrimaryBushing|C1% Polar Plot Angle

PrimaryBushing|PF% A | PrimaryBushing|PF% A

PrimaryBushing|PF% B | PrimaryBushing|PF% B

PrimaryBushing|PF% C | PrimaryBushing|PF% C

PrimaryBushing|PF% Polar Plot Level

| PrimaryBushing|PF% Polar Plot Level
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PrimaryBushing|PF% Polar Plot Angle | PrimaryBushing|PF% Polar Plot Angle

PrimaryBushing|AngleACReferenceDiff | PrimaryBushing|AngleACReferenceDiff

PrimaryBushing|AngleABReferenceDiff | PrimaryBushing|AngleABReferenceDiff

PrimaryBushing|Current A

| PrimaryBushing|Current A

PrimaryBushing|Current B

| PrimaryBushing|Current B

PrimaryBushing|Current C

| PrimaryBushing|Current C

PrimaryBushing|System Frequency

| PrimaryBushing|System Frequency

SecondaryBushing|C1% A

| SecondaryBushing|C1% A

SecondaryBushing|C1% B

| SecondaryBushing|C1% B

SecondaryBushing|C1% C

| SecondaryBushing|C1% C

SecondaryBushing|C1% Polar Plot Level

| SecondaryBushing|C1% Polar Plot Level

SecondaryBushing|PF% A

| SecondaryBushing|PF% A

SecondaryBushing|PF% B

| SecondaryBushing|PF% B

SecondaryBushing|PF% C

| SecondaryBushing|PF% C

SecondaryBushing|PF% Polar Plot Level

| SecondaryBushing|PF% Polar Plot Level

SecondaryBushing|PF% Polar Plot Angle

| SecondaryBushing|PF% Polar Plot Angle

SecondaryBushing|AngleABReferenceDiff

| SecondaryBushing|AngIeABReferenceDiff

SecondaryBushing|AngleACReferenceDiff

| SecondaryBushing|AngleACReferenceDiff

SecondaryBushing|Current A

| SecondaryBushing|Current A

SecondaryBushing|Current B

| SecondaryBushing|Current B

SecondaryBushinglCurrent C

| SecondaryBushing|Current C

TertiaryBushing|C1% A

‘ TertiaryBushing|C1% A

TertiaryBushing|C1% B

‘ TertiaryBushing|C1% B

TertiaryBushing|C1% C

‘ TertiaryBushing|C1% C
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TertiaryBushing|C1% Polar Plot Level

‘ TertiaryBushing|C1% Polar Plot Level

TertiaryBushing|PF% A

‘ TertiaryBushing|PF% A

TertiaryBushing|PF% B

‘ TertiaryBushing|PF% B

TertiaryBushing|PF% C

‘ TertiaryBushing|PF% C

TertiaryBushing|PF% Polar Plot Level

‘ TertiaryBushing|PF% Polar Plot Level

TertiaryBushing|PF% Polar Plot Angle

‘ TertiaryBushing|PF% Polar Plot Angle

TertiaryBushing|AngleABReferenceDiff

‘ TertiaryBushing|AngleABReferenceDiff

TertiaryBushing|AngleACReferenceDiff

‘ TertiaryBushing|AngleACReferenceDiff

TertiaryBushing|Current A

‘ TertiaryBushing|Current A

TertiaryBushing|Current B

‘ TertiaryBushing|Current B

TertiaryBushing|Current C

‘ TertiaryBushing|Current C

PD|PD Count Polar Plot Angle

| PD|PD Count Polar Plot Angle

PD|PD Count Polar Plot Level

| PD|PD Count Polar Plot Level

PD|PD Average Polar Plot Angle

| PD|PD Average Polar Plot Angle

PD|PD Average Polar Plot Level

| PD|PD Average Polar Plot Level

PD|PDI Polar Plot Angle

| PD|PDI Polar Plot Angle

PD|PDI Polar Plot Level

| PD|PDI Polar Plot Level

PD|PhaseA|Correlation PDi-RH

| PD|PhaseA|Correlation PDi-RH

PD|PhaseA|PD Count

| PD|PhaseA|PD Count

PD|PhaseA|PD Average Apparent Charge

| PD|PhaseA|PD Average Apparent Charge

PD|PhaseA|PDI

| PD|PhaseA|PDI

PD|PhaseB|Correlation PDi-RH

| PD|PhaseB|Correlation PDi-RH

PD|PhaseB|PD Count

| PD|PhaseB|PD Count

PD|PhaseB|PD Average Apparent Charge

| PD|PhaseB|PD Average Apparent Charge
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PD|PhaseB|PDI | PD|PhaseB|PDI

PD|PhaseC|Correlation PDi-RH | PD|PhaseC|Correlation PDi-RH
PD|PhaseC|PD Count | PD|PhaseC|PD Count

PD|PhaseC|PD Average Apparent Charge | PD|PhaseC|PD Average Apparent Charge
PD|PhaseC|PDI | PD|PhaseC|PDI

Parent | Parent

This is used to maintain the parent-child hierarchy so that the asset can be created at the appropriate level. No
mapping is required.

An example hierarchy is as follows:

Area
Substation
Transformer1

Transfix 1.6
HydranM2

Transformer2
TAPTRANS
BMT300

Perception data exported to CSV format adheres to the following rules:

e The Parent header column against Transfix 1.6 and HydranM2 data rows will have the value
‘Transformer?'.

e The Parent header column against TAPTRANS and BMT 300 data rows will have the value ‘Transformer2’.

e The Transformer1 and Transformer2 data rows will have the value ‘Substation’ against their Parent
header column.

e The Substation data row will have the value ‘Area’ against its Parent header column.

Data imported from a CSV file follows a three-step process for each asset to ensure that the same asset
structure is maintained in the Asset Explorer. This is best explained as follows:

1. Perception first checks the Parent value of the asset. If the Parent node doesn't already exist in the
database, Perception creates the Parent node and any associated child nodes in the hierarchy. If the
Parent value in the CSV file is empty, then any child nodes are created at the top level of the hierarchy
i.e. directly under the database node.

2. If the Parent node already exists in the database, then it checks the ‘equipnum’ and ‘serialnum’ fields. If
both the values match, then any child assets will be created under that parent. If any one of them doesn’t
match, then a new Parent node will be created with the corresponding child assets.

3. The same logic of step 2 also applies to any child assets. If any asset already exists i.e. there is a match
of the values ‘parent’, ‘equipnum’ and ‘serialnum’, then the data will be replaced for that asset on import.
Otherwise if any one of them doesn’t match, a new asset will be created.

Alarm Mappings

During import and export, alarms are treated as attributes of measurement points. Measurement points have
various attributes. The alarm-specific attributes are as follows:

[OilSource] | [MeasurementType] | HighLimit (numeric)
[OilSource] | [MeasurementType] | HighEnabled (boolean)
[OilSource] | [MeasurementType] | HighHighLimit (numeric)
[OilSource] | [MeasurementType] | HighHighEnabled (boolean)
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[OilSource] | [MeasurementType] | LowLimit (numeric)
[OilSource] | [MeasurementType] | LowEnabled (boolean)
[OilSource] | [MeasurementType] | LowLowLimit (numeric)
[OilSource] | [MeasurementType] | LowLowEnabled (boolean)

[OilSource] | [MeasurementType] | Formula (text)

[OilSource] | [MeasurementType] | FormulaName (text)

[OilSource] | [MeasurementType] | UpperAlarmValue (numeric)
OilSource] | [MeasurementType] | LowerAlarmValue (numeric)
OilSource] | [MeasurementType] | UpperRatioAlarmEnabled (Boolean)
QOilSource] | [MeasurementType] | LowerRatioAlarmEnabled (Boolean)

The attributes required vary according to the measurement point. For example, the alarm for the 02
measurement point is defined as follows:

OilSourceA | 02

(the measurement point)

OilSourceA | 02 | EngineeringUnits

(ppm for gases)

OilSourceA | 02 | HighLimit

(numeric value)

OilSourceA | 02 | HighEnabled

(boolean flag to mark the High limit enabled or disabled by setting as TRUE or FALSE)
GasRatioFormulaContainer | OilSourceA | Formulainfo1 | Formula

(numeric formula)

GasRatioFormulaContainer | OilSourceA | Formulalnfo1 | FormulaName

(text value)

GasRatioFormulaContainer | OilSourceA | Formulainfo1 | UpperAlarmValue

(numeric value)

GasRatioFormulaContainer | OilSourceA | Formulalnfo1 | UpperRatioAlarmEnabled
(boolean flag to mark the Upper limit enabled or disabled by setting as TRUE or FALSE)

OilSourceA|02 | OilSourceA|02|EngineeringUnits | OilSourceA|O2|HighLimit | OilSourceA|02|HighEnabled

15838 ppm 100 TRUE

GasRatioFormulaContainer|OilSourceA|Formulalnfol|Formula
(H2+C2H4+C2H6+CH4)/(C2H4)

GasRatioFormulaContainer|OilSourceA|Formulalnfol|FormulaName
Ratio 1

GasRatioFormulaContainer|OilSourceA|Formulalnfo1|UpperAlarmValue
15

GasRatioFormulaContainer|OilSourceA|Formulalnfo1|UpperRatioAlarmEnabled
TRUE
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Appendix C Troubleshooting

Table C-1 lists several problems and resolutions.

Table C-1: Problems & Resolutions

Problem

Resolution

Alarms not triggering for data
imported from a CSV file?

This happens because the
AlarmStatus column in the CSV file
incorrectly defaults to zero.

Before importing, ensure that the AlarmStatus column in
the CSV file is manually populated with the correct values.
If you are uncertain about the values, then delete the
entire AlarmStatus column from the CSV file. During the
import, when the AlarmStatus column is found to be
missing, Perception regenerates that column with the
correct values.

Anti-Virus software or firewall blocks
Perception-related executables.

Perception-related executables may need to be added to
the host PC or corporate anti-virus and firewall software.
The following executables are launched from Perception:

C:\Program Files (x86)\KelmanDownload\
KelmanDownload.exe

C:\Program Files (x86)\GE Digital Energy\Perception 2.4.5\
TransconnectBootLoader.Exe
CefSharp.BrowserSubprocess.exe
MPDump.exe
Perception.Database.Upgrade.Tool.exe
Perception.Desktop.exe
Perception.Devices.Provider.Host.exe
Perception.Server.Configuration.Tool.exe
Perception.Server.exe

Transconnect.exe
Perception.Workflow.Designer.exe

C:\Program Files (x86)\GE Energy\BMT 330\BMT_330.exe

Failure to Connect to the Server

Server certificate not trusted. See Section 2.4.1.1

Perception Service does not appear in
Desktop Discovery wizard.

This can be caused by several incorrect configurations.

e Ensure IP Address or Hostname of Perception
Server is correct.

e If Perception Server is installed on a PC with
another OPC service, ensure that the UA
Discovery Server service is running. Verify in
services.msc.

e Ensure the Perception Server Service is running,
check in services.msc.

e Ensure the SQL Service is running, check in
services.msc.

e Ensure the Kelman database is configured in the
Perception Server Config Tool.

e Ensure the Microsoft Distributed Transaction
Coordinator service (MS-DTC) has started on the
PC running the Perception Server. If it was not
running you may need to restart the Perception
Server and UA Local Discovery Server services
after starting.
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e Ensure MS-DTC is configured correctly: Windows
Server 2008. See
http://support.microsoft.com/kb/817064

e Ensure the Perception Server and Discovery
Server certificates exist in the trusted certificate
folder and that they are configured correctly
within the services configuration files. To correct
configuration, run the Perception Server installer
and select the repair option.

Security parameters not appearing at
the end of the Perception Server
discovery connection wizard.

Ensure the ports required by the Perception applications
are not blocked by a firewall (ports 4840 & 62541).

The Gas Ratios 3D graph does not
appear on the Gas Ratios workbook.

Ensure you have the latest drivers for your graphics card.

When you launch Perception Desktop
the application or activation window is
blank.

Ensure you have the latest drivers for your graphics card.

Users are no longer able to log in even
though usernames and passwords are
correct.

This can occur if a new server certificate has been created
on the Perception Server host. To correct the issue you
need to delete and re-add the users.

HydranM2: Exception raised when
configuring HM2 via Perception Setup

Intermittent issue. The workaround is to instead use the
Multihost software to configure the device.

While importing CSV files into a local
KPD file, the browsing performance of
Asset Explorer is slow.

This may be hardware performance related. Wait until the
KPD import completes. This is not an issue using SQL
Server.

Perception Desktop Freezes when you
open a KPD database or try to
connect to Perception Server.

Delete the Perception folder located in:
%APPDATA%\GE_Energy

Note: ‘% APPDATA%’ points to the ‘Roaming’ application
data folder

Connecting to Perception Server Error
- 'The requested key container was
not found'.

Intermittent issue. Close the 'The requested key container
was not found' error by clicking OK. Close the Perception
Desktop application and reopen it.

Attempt connection to Perception Server again.

Perception installer failure — ‘An
internal error occurred’.

Perception installers will fail if the following Microsoft
Windows update is installed on the machine KB2918614.
This is a known Microsoft Windows update issue; the
update must be removed in order to install Perception
successfully.

Trouble importing CSV data in Non-
English windows environment.

If the decimal and list separator symbols used in the CSV
file to be imported into Perception Desktop do not match
the environment variables set in Microsoft Windows, the
import of the data into Perception will fail. Either the CSV
file must be updated with the correct symbols or the
environment variables should be changed to match the
CSV file.

Perception Desktop certificates error —
‘Perception Desktop certificate
missing, reinstall/repair setup to
connect’ reinstall/repair does not
correct error.

Intermittent issue. Perception Desktop installer fails to
create certificates or certificate assignments can be
missing after a Perception Desktop upgrade is performed.
To resolve this issue (Windows 7):
1. Browse to C:\ProgramData\
2. Delete the 'OPC Foundation' folder
3. Browse to C:\Program Files (x86)\Common Files
(on x64 0S)
4. Delete the 'OPC Foundation' folder
5. Browse to C:\Program Files\Common Files (on x86
0S)
6. Delete the 'OPC Foundation' folder
7. Uninstall Perception Desktop
8. Re-install Perception Desktop
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Unexpected or empty wallboards

Clear wallboards cache - folder located in: C:\Documents
and Settings\<User>\Local Settings\Temp\Wallboard,
where <User> stands for a user logged in to the Windows
system

When attempting to download from an
MS 3000 device, the following
message appears in the Response
field: "The remote certificate is invalid
according to the validation
procedure”.

The MS 3000 is configured for HTTPS communication, but
downloading data from the device requires a valid
certificate to be added. See Appendix G: MS 3000: HTTPS
& Self-signed Certificates.

When trying to download from a
Hydran unit or launching setup for a
Hydran unit, an error appears stating
TMW.SCL.dII or related component
cannot be loaded.

The Windows environment does not have the required
C++ library (x86). Please install the Microsoft Visual C++
2010 Service Pack 1 Redistributable Package,
https://www.microsoft.com/en-
gb/download/details.aspx?id=26999
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Appendix D PGA Diagnostic Error codes and Status Flags

The Data Table tooltip, an example of which is shown below, includes a
Diagnostic row that lists PGA diagnostic information. E.g. PGA;0,0,6. The
syntax for the PGA entry is:

PGA; [errorState], [errorCodes], [flagNumber]

Fram: | Select a date @ To: | Select a date Reset Dates
Timestamp * :—L);c:-;?gen {.&;;rt:;ene EI:F:::]m Monoxide lf:;:]rl
| 23/06/2014 12220 2300 [1400  [2500 13004
| 23/06/2014 1125 2200 [1300  [2400 12804
| 20/06/201413:25 100 [1200  [2300 12604
| 10/06/2014 13:24 000 [1100  [2200 1240
| 09/06/2014 1323 [1900 1000 [2100 12204
| 05/06/201413:23 [1800 00 [2000 12000
| 03/06/201413:22 [1100 o0 [1900 1180
| 01/06/2014 13221 1600 700 [1800 1160
| 16/05/201413:21 [1500 0.0 [1700 11404
| 15/05/2014 1320 [1400 500 [160.0 11204
| 13/05/2014 1319 [1300 P00 [1500 11009
| 03/04/2014 13118 [1200° po0  [1400 [1080.0
| 01/04/201413:15 [1100 oo [1300 [1060.
| 01/04/2014 13:14 1400 [io6S0NTo0NNio400
Point Mame : Hydrogen
Point Path : MAIN
TimeStamp : 01/04/2014 13:14:00
Value : 740.0
Clyalits 2
High Limit : 10.0 ppm

Figure D-1: PGA diagnostic information

Note: Perception displays the flag number in decimal, but this must be
converted to binary in order to draw comparison with the bitmap
outlined in Table D-3. E.g. a decimal status flag of 6 in the above
example equates to binary 0000000000000110. Using Table D-3, this
would indicate that the PPM values are valid and that it is the first
measurement after a reset.
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Table D-1 lists all Transfix-family PGA Diagnostic Error Codes.

Table D-1: Transfix-family PGA Error codes

Error Codes Description

(32-bit field)

bit 0 1 = Missing mains input (obsoleted)

bit 1 1 = PGA power supply voltage too low

bit 2 1 = PGA chopper frequency outside range
bit 3 1 = PGA IR-source outside range

bit 4 1 = Gas flow lower than limit

bit 5 1 = Background noise/vibration too high
bit 6 1 = Microphone test failed

bit 7 1 = Not Levelsensor1 pulses (level)

bit 8 1 = Not Levelsensor3 (drain)

bit 9 1 = Fill level shows oil

bit 10 1 = Over Fill level shows Oil

bit 11 1 = PGA Air temperature outside limits

bit 12 1 = Bad communication with control PCB
bit 13 1 = Gas leak test: Pump pressure too low
bit 14 1 = Gas leak test: Pressure decay too high
bit 15 1 = Unusual ambient gas measurements
bit 16 1 = Oil temperature too low

bit 17 1 = Oil temperature too high

bit 18 1 = Oil pressure too low

bit 19 1 = Oil pressure too high

bit 20 1 = Oil pump tacho count too high

bit 21 1 = Oil pump pressure too low

bit 22 1 = Oil pump speed out of range

bit 23 1 = Manual oil sampling switch

bit 24 1 = Oil pump tacho count too low

bit 25 1 = Oil pump not turning

bit 26 {not used/defined}

bit 27 1 = Temperature Sensor(s) 1 disconnected
bit 28 1 = Temperature Sensor(s) 2 disconnected
bit 29 1 = Drain level shows oil

bit 30 1 = Conditioned oil temp. outside limits
bit 31 {not used/defined}

Table D-2 lists all MINITRANS PGA Diagnostic Error Codes.

Table D-2: MINITRANS PGA Error codes

Error Codes Description

(32-bit field)

bit 0 1 = Missing mains input (obsoleted)

bit 1 1 = PGA power supply voltage too low
bit 2 1 = PGA chopper frequency outside range
bit 3 1 = PGA IR-source outside range

bit 4 1 = Gas flow lower than limit

bit 5 1 = Background noise/vibration too high
bit 6 1 = Microphone test failed

bit 7 1 = Not Levelsensor1 pulses (level)

bit 8 1 = Not Levelsensor3 (drain)

bit 9 1 = Levelsensor1 (level)
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bit 10 1 = Levelsensor2 (level alert)

bit 11 1 = PGA Air temperature outside limits

bit 12 1 = Bad communication with control PCB
bit 13 1 = Gas leak test: Pump pressure too low
bit 14 1 = Gas leak test: Pressure decay too high
bit 15 1 = Unusual ambient gas measurements
bit 16 1 = Oil temperature too low

bit 17 1 = Oil temperature too high

bit 18 1 = Oil pressure too low

bit 19 1 = Oil pressure too high

bit 20 1 = Oil pump tacho count too high

bit 21 1 = Oil pump pressure too low

bit 22 1 = Oil pump speed out of range

bit 23 1 = Manual oil sampling switch

bit 24 1 = Oil pump tacho count too low

bit 25 {not used/defined}

bit 26 1=5V supply below 4.5V

bit 27 1 = Temperature Sensor(s) 1 disconnected
bit 28 1 = Temperature Sensor(s) 2 disconnected
bit 29 1 = Drain level shows oil

bit 30 {not used/defined}

bit 31 {not used/defined}

Table D-3 lists all PGA Status Flags.
Table D-3: PGA Status flags

Status Flag Description

(bit field)

bit 0 1 = ESHL Valid

bit 1 1 = PPM values valid

bit 2 1 = First measurement after reset
bit 3 1 = Sampling Skipped

bit 4 1 = Error checking disabled

bit 5 1 = Nitrogen Valid

bit 6 1=TDG Valid

bit 7 1 = Oil Switch failed

bit 8 1 = Spurious alarm suspected

bit 9 1 = Manual Sample

bit 10 1 = Measurement Manually Stopped
bit 11 1 = Weak NHC Indication

bit 12 1 = Strong NHC Indication

bit 13 1 = Measured with PreSens sensor
bit 14 1 = External Alarm ON

bit 15 1= TDH Valid

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3

22-Oct-24

Page 186 of 220



Appendix E Model Descriptions

E.1 Japanese ETRA Models

Reference source: “Latest Diagnostic Methods of Gas-in-oil Analysis for Oil-
filled Transformer in Japan; Proceedings of 13th International Conference on
Dielectric Liquids (ICDL '99), Nara Japan 20-25th July 1999.”

An extract of the summary and introduction are reproduced below:

DGA is one of the most widely used diagnostic techniques for detecting and
evaluating types of faults in a transformer. The first edition of "Supervision
and Maintenance by DGA” standardized by the ETRA in 1980, has been widely
used for oil filled transformers in Japan. The standard, however, lacked
diagnoses for some cases and had no detection limits nor precision
requirements for DGA. Therefore, the ETRA started to investigate the actual
status of conventional diagnosis by DGA in Japan and overseas. Also, DGA
data have been investigated on about 1300 operating transformers which are
now in service including some which have experienced inner faults. As a
result, a new "Supervision and Maintenance by DGA" which is the second
edition was released in February 1999. This paper summarizes that standard.

Regarding gas analysis methods in oil which are used presently in Japan,
torricelli, toepler pump, vacuum piston and stripping methods are used for the
extraction of dissolved gases in oil and gas chromatography is used for
analysis of the extracted gases. Review of the analysis sensitivity of each gas
in 12 laboratories showed the detection and determination limits had some
scattering among the laboratories. By considering the detection limits that
were standardized in IEC 567 (1992) and the determination limits which are
necessary to improve the precision of present diagnoses by DGA, the
detection limit was defined as 3 times the noise level and the determination
limit was defined as 5 times the detection limits. The repeatability and
reproducibility were evaluated by the Round Robin Test with the three gas-in-
oil-standard samples and the sample oils taken from transformers in service.
By using the evaluation formula of repeatability which was prescribed by IEC
567 (1992) and the detection limit, it was found that the repeatability for each
gas at each laboratory satisfied the evaluation formula at a 93.9% probability.
It was found that the repeatability and reproducibility of the stripping method
were better than those of the other extraction methods.

The paper then defines some new gas correlations that have prognostic
utility.

E.2 Multi-Host Models

Reference source: GE Multi-Host Manual, part# 18415
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E.21

Dynamic Loading Model

The purpose of this model is to provide the transformer owner and operator
with a continuous estimation of the capacity of the transformer (and its
associated components) to continue safe operation under overloading
conditions. Starting with current conditions of oil temperature and ambient
temperature and using a steady load of a given magnitude, the model
computes how long this load can be carried until a limit condition is reached.
The implementation of this model in the Hydran M2 with Models and Intellix
MO150 Devices is also known as ‘Time vs Steady Load.’

The model’s Device Provider setup offers two choices for the Ambient Air
Temperature and Top Oil Temperature — either to use manual input values or
sensor-measured values. Manual input values are useful for simulation
purposes and are used only in the calculations of the model. The device will
still always gather sensor-measured values and render these in all other areas
of the software where these values are used e.g. data view charts and
dashboards. This feature is available only for the MO150 device with firmware
version 3.06 or higher.

This model is intended for short-duration overloads, as when a parallel
transformer is removed from service for maintenance for a few hours or less.
Model computations are made with the assumption that the transformer is
operating on the top-cooling mode. Computations of the top oil and winding
temperatures are carried out according to Section 7.2 of IEEE C57.91-1995,
Guide for Loading Mineral-Oil-Immersed Transformers. A similar calculation
method is described in Section 8.2.2 of IEC 60076-7, Loading Guide for Oil-
Immersed Power Transformers.

Calculation starts with a load of 1.1 p.u. and actual values for Ambient
Temperature and Top Oil Temperature (from sensors). The ambient
temperature is assumed to remain constant for the period of overload being
considered. The actual top oil temperature will be used as a starting point for
oil temperature calculation at each load level. Calculations are done with this
load level (1.1 p.u.) and with a time increment of 0.1 hour (6 minutes) until one
of the Limiting Factors (or Overload Limit) is exceeded or when the acceptable
duration exceeds 12 hours (720 minutes). The calculation is then repeated
with a load of 1.2 p.u. and the acceptable duration is determined (less or equal
to 720 minutes) again along with the Limiting Factor that was first reached.
This calculation is repeated until a load of 2.0 p.u. is reached.

For each Load level, the time duration to reach the limit is recorded along with
the Limiting Factor that was first reached. If the 12 hours (720 minutes) were
reached but no Limiting Factor was exceeded, the Limiting Factor is shown as
“Duration.” If the Hydran M2 with Models and Intellix MO150 Devices are
working in the on-line mode of operation, then the computation is repeated
every 10 minutes using the actual sensor values. If the Hydran M2 with Models
and Intellix MO150 Devices are working in the off-line mode of operation, then
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the output screen reflects the values computed during the last on-line
operation.

E.2.2 Insulation Ageing Model

Winding insulation is made of oil-impregnated cellulose material. In order to
properly fulfil its function, this material must have a certain mechanical
strength and flexibility. These properties depend on the length of the cellulose
chain constituent of the paper and pressboard. With time and temperature,
these long polymer chains break down into shorter segments, a process
called depolymerisation. The practical effect is that the paper loses its
flexibility and tensile strength to become a brittle material. The winding is
continuously submitted to clamping forces and vibrations. Moreover, during
short-circuit on the system, these forces are increased tremendously and if
the insulating paper is too brittle, it may rupture under the pressure and create
a weak point in the insulation that will later allow flashover between adjacent
turns when a voltage surge occurs on the transformer.

This insulation aging process is irreversible. It is also the main factor
determining the transformer’s end of life. The rate of aging of cellulose
insulation material is a function of the following factors:

» Insulation temperature at the hot spot: The effect of temperature is the most
important, as described in the IEEE and IEC Loading Guides. The effect of
temperature on aging is a function of the type of paper. It is therefore
important to state in the configuration page the type of paper used for
winding insulation.

=  Water content in the winding insulation paper: It is assumed that the aging
acceleration factor is directly proportional to the water content with 0.5 %
as reference value for dry paper. The water content in winding insulation is
computed in the Moisture Content in Insulating Barrier model. The effect is
more severe on normal Kraft paper than on thermally-upgraded paper and
it can be practically neglected on Aramid paper.

= Oxygen content of the insulating oil: This oxygen content can be inferred from
the type of oil preservation system. The IEEE Loading Guide recommends
using an aging acceleration factor of 2.5 for free-breathing conservators
while the sealed-type transformers and those with a membrane in the
conservator are practically oxygen-free.

The following Model Output Text Parameters are displayed in the Insulation
Ageing Model:

= Thermal Aging Acceleration Factor: It considers only the hot-spot current
temperature.

= Moisture Aging Acceleration Factor: It considers only the effect of moisture in
paper.
= Global Aging Acceleration Factor: This is the actual aging rate or aging

acceleration factor, considering the cumulated effect of temperature,
moisture and oxygen in oil.
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» Cumulative Aging: This field indicates the aging cumulated since the
commissioning of the system, adding the “Previous Aging” if this value was
configured on the Insulation Aging Model configuration page. The value is
expressed in days of operation at rated temperature; for instance, a
transformer with thermally upgraded paper operating 24 hours at 117 °C
will undergo 2 days of “normal aging at rated temperature.”

= Service Time: This field indicates the number of days the transformer has
been in service since the commissioning of the system, adding the
“Previous Service Time” if this value has been configured.

E.2.3 Moisture and Bubbling Model

The moisture content of the oil and the solid insulation is a serious concern for
power transformers, especially for aging units. Extensive drying procedures
are applied at the manufacturing stage and sustained efforts are deployed in
service to maintain a high level of dryness. However, with time, water can
penetrate through various paths such as the air breather and leaky gaskets.
Aging of cellulose also releases some water. Moisture tends to accumulate in
the solid insulation and leads to several detrimental consequences, namely:

= Acceleration of insulation aging.

= Risk of water vapour bubbles being released from the winding insulation.
» Reductions of dielectric strength of insulating barriers.

= Risk of water condensation in transformer oil at low temperatures.

Moisture content assessment is too often derived from a single oil sample
submitted to a Karl Fischer test in laboratory. This is a valid approach for oil
evaluation but it does not allow evaluation of the moisture content in the solid
insulation as the rate of water exchange between the oil and the paper has to
be considered. On-line monitoring of moisture in oil allows the integration of
temperature variations and the computation of a dependable value for
moisture content in the various components of the solid insulation system,
even if they are at different temperatures and characterized by different
diffusion rates.

The most critical part of the winding insulation is the top of the winding that
operates at the hot-spot temperature. This is the area where the aging is most
severe, and the effect of the water content can be computed. The
determination of the critical temperature for bubble evolution takes into
account the atmospheric pressure, the oil pressure above the hot-spot area,
and the amount of gas dissolved in the oil.

The moisture sensor continuously monitors the oil's temperature and relative
moisture saturation at the sensor location. A filtering is applied to remove the
effect of cyclic heating created by the sensor to ensure oil circulation. This
filtered value is used to calculate the absolute value of the water content in
the oil, the temperature of water condensation, and the relative saturation at
the reference temperature.
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Since the oil and winding temperature varies continuously, this moving target
is used with an integrating algorithm taking into account the diffusion time
constant and the temperature. The calculated value of the water content in
the winding insulation allows prediction of the bubbling temperature. It is also
used in the Insulation Aging model (described above).

E.2.4 Apparent Power Model (MVA)

The primary function of this model is to continuously monitor the load carried
by the transformer in MVA (Mega Volt-Amperes). The Apparent Power can be
computed on the primary, secondary, and tertiary windings, depending on the
input configuration. The historic maximum MVA value is retained with a time
stamp and can be reset.

The current signal is a mandatory input, whereas the voltage signal is
configured as a fixed value. Since voltage variations occurring in service and
tap changer operations are not taken into consideration, the MVA is an
approximate reading, and used only for display purposes.

The model’s Device Provider setup offers two choices for the Apparent Power
model computations — either to use manual input values or sensor-measured
values. The former requires the user to assign three new types to the output
models of an Analog input:

= Rated Voltage on HV side
= Rated Voltage on LV side
= Rated Voltage on tertiary side

When a new measurement sensor for voltage output is assigned to an Analog
input, the Apparent power model is calculated based on this measured
voltage instead of the one manually configured on the device, and displayed
in the appropriate worksheets in Perception.

Manual input values are useful for simulation purposes and are used only in
the calculations of the model. The device will still always gather sensor-
measured values and render these in all other areas of the software where
these values are used e.g. data view charts and dashboards. This feature is
available only for the MO150 device with firmware version 3.06.

E.2.5 Winding Hot-Spot Temperature Model (WHST)

The rating of a transformer is closely linked to the winding temperature as it
governs the insulation aging rate and bubbling release threshold (both
estimated by other models described above). This winding temperature can
also raise an alarm if excessively high values occur. In the industry standards,
the winding temperature limit is defined as a temperature rise above the
ambient air temperature. The cooling system is designed to ensure that at full
load, the average winding temperature rise does not exceed the industry-
accepted value (usually 65 °C).
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E.2.6

However, it is not the average winding temperature that is of most interest but
rather the temperature in the hottest area (the ‘hot-spot temperature’). This
temperature cannot be measured directly as it is not possible to insert
thermocouples in a winding that is to be put in service. It is possible to use
fibre optic temperature sensors that do not interfere with dielectric strength,
but this procedure is costly and is usually limited to the validation of the
manufacturer calculation methods. Therefore the traditional method was to
use a Winding Temperature Indicator to fulfil that function.

A more accurate and reliable evaluation of the hot-spot temperature can be
provided, using the equations provided in the IEEE and IEC Loading Guides:

» |EEE C57.91 - 1995, IEEE Guide for Loading Mineral-Oil-Immersed
Transformers

= |[EC 60076-7 - 2005, Power Transformers - Part 7: Loading Guide for Qil-
Immersed Power Transformers

In the computation methods described in these Loading Guides, a key value is
the temperature difference between the winding hot-spot and the top oil at
rated conditions. This value is normally provided by the transformer
manufacturer after suitable validation of their computation method. In the
Winding Hot-Spot Temperature model, this rated value is corrected to
account for actual load current and winding thermal time constant. The
computed hot-spot temperature rise is then added to the measured top oil
temperature to provide the actual winding hottest-spot temperature.

The winding hot-spot temperature is computed separately for each winding.
The highest value of winding hot-spot temperature is identified and used to
raise an alarm signal on the transformer. The hottest winding might not always
be the same, depending on the load on the tertiary winding and on the
position of the tap changer.

For autotransformers, the winding hot-spot temperature is calculated for the
series winding (H), the common winding (C) and the tertiary winding (Y). The
current in the common winding is calculated by subtracting the secondary
load current minus the primary load current.

Cooling Status

This model allows identification of the cooling stage currently in service. The
cooling bank refers to the cooling device. A transformer can have several sets
of fans and each one will be supplied by a feeder where the current can be
measured. Information concerning the status of each cooling device (oil
pumps, water pumps, fans) can be provided from several sources. The most
common is a set of digital inputs giving the status (ON / OFF) of the relay
supplying the cooling device. This information is adequate to allow
determination of the cooling stage and the cumulative operating time for each
device. A measurement of the current consumption by each cooling device
can also be provided by AC RMS sensors or DC analog sensors. If this is the
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case, additional information can be developed such as detection of
inoperative fans or bearing gripping. The digital indication of cooling bank
status is to be used as the prime source of information. For determination of
cooling bank status, cooling bank feeder current is to be used only if no digital
information is available. The digital indication of cooling bank status is to be
used as prime source of information. For determination of cooling bank status,
cooling bank feeder current is to be used only if no digital information is
available.

E.2.7 Cooling Efficiency

This model computes the top oil temperature that should be expected
considering the load current, the ambient temperature, the cooling mode, the
oil time constant and the altitude.

The calculated value is then compared with the measured value and an alarm
is raised if the transformer is found to be overheating. This calculation is used
to detect obstructions, such as dirt on the coolers, which could be a limiting
factor when the transformer is required to operate at full load or under
overload conditions.

During the initial model computation, the measured values of top oil
temperature and ambient temperature are used to provide a starting point for
the calculated value of top oil temperature rise. From then on, the calculated
temperature at the end of the time interval is used as the initial temperature
for the next time interval. This calculation is run with load current in the H
winding only. The rated current for each cooling stage is calculated from the
rated power on each stage and the rated current on the top cooling stage.
The ultimate temperature rise and the current temperature rise are calculated
considering the actual cooling stage and the actual oil time constant. This
value is added to the ambient temperature to provide a calculated top oil
temperature. This value is subtracted from the measured top oil temperature
and the difference is averaged over a configurable period. An alarm is raised
when the difference exceeds a configured value for a period of time that is
also configurable. The model can accommodate a transformer with one, two
or three cooling stages.

E.2.8 OLTC Tap Position

Tap changer driving mechanisms are always provided with a visual tap
position indicator and a counter indicating the total number of operations. This
model provides additional information that is useful to monitor the proper
operation of this critical unit, such as:

» The cumulative number of operations at each tap since commissioning
» Resettable variables for operation and maintenance counts

= Warnings for excessive number of operations over a certain period
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= The time spent since the last operation of the reversing switch
= A warning to avoid contact cooking because of insufficient operation

A position transducer, driven by the visual indicator shaft (also called Geneva
shaft), provides a 4-20 mA signal that is proportional to the tap changer
mechanical position. The multi position switch can be equipped with jumpers
(instead of resistors) in the “through positions” where the tap position
indicator stays only momentarily during operation of the reversing switch. In
this case, the potentiometer provides an indication of the electric position of
the tap changer. When the tap changer operates, the signal should remain
steady, until it changes to a new value without falling to zero.

It is assumed that the Geneva shaft rotates by a fixed value for each step on
the transducer. The signal from the Geneva shaft position transducer is read
at regular intervals and is analyzed to determine the actual position of the
visual position indicator.

The position generated may refer to the mechanical position of the Geneva
gear or the electrical position. In the first case, the mechanical position is
converted into the electrical position considering the number of through
positions specific to this tap changer when it moves to the neutral position.

The number of operations on each tap position is presented by histograms
using the tap position denomination configured. The system provides three
separate registers to record the number of operations carried out by the tap
changer:

» The Permanent Tap Position Transition Count is intended to sum all operations
since the commissioning of the system. However, if the monitoring system
is moved to a different transformer, the System Administrator can reset this
value to zero. This counter provides the number of operations on each tap
position, the total number of operations, and the date when the system was
put in service. The total number of operations performed prior to the
commissioning of the system can also be taken into account.

= The Operator Tap Position Transition Count can be reset by the Operator when
there is a need to check the number of operations in one day, or several
days, in order to demonstrate that the tap changer control unit is operating
properly. This counter provides the number of operations on each tap
position, the maximum and minimum positions visited by the tap changer
since the last reset, and the date of the last reset.

= The Maintenance Tap Position Transition Count is used by maintenance
personnel to assess the need for maintenance and to plan maintenance
schedules. It is typically reset every three or four years when an inspection
activity is performed on the unit. This counter provides the number of
operations on each tap position, the maximum and minimum positions
visited by the tap changer since the last reset, and the date of the last
reset.
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E.2.9 OLTC Differential Temperature

The On-Load Tap Changer (OLTC) Temperature Differential model
continuously compares the top oil temperature in the main tank with the tap
changer compartment temperature. Monitoring of the tap changer
temperature is a recognized method of detecting abnormal operating
conditions in the tap changer. This monitoring method is intended for tap
changers mounted on a separate compartment on the transformer tank. The
tap changer temperature is normally lower than the main tank temperature
because no heat source is expected in the tap changer. If the tap changer
temperature rises above the main tank temperature, it is indicative of an
overheating contact.

The temperature difference is calculated by subtracting the tap changer
temperature minus the main tank temperature, thus yielding a negative value.
This method allows to set the alarm on a positive threshold value rather than a
negative value. This temperature difference is averaged with a low-pass filter
to eliminate normal variations arising from sunshine and wind.

A short-term averaged value is generated with a configurable filtering factor
typically set at 60 minutes. This short-term average is intended to detect
severe heat sources such as resistor overheating when the mechanical links
break while the switches are between two contacts.

A long-term averaged value is generated with a configurable filtering factor
typically set at 7 days. This long-term average is intended to detect slow-
evolving thermal problems such as contact overheating. The measured
temperature difference is averaged over a round number of days to filter out
the daily temperature variations.

E.2.10 Temperature Model

The Temperature Model is specific to the Hydran M2. It displays a trend for
the temperature readings taken for the thermal sensors supported on the
Hydran M2.

The following values are displayed:

» Tank #1 %RH Sensor Temperature °C (Relative Humidity)

= Sensor #1 Heater Power in %

= Top Oil Temperature °C

= Tank #1 %RH Sensor Temperature °C Hourly Average (Relative Humidity)
= Sensor #1 Hydran Sensor Temperature °C

= Sensor #1 Base Plate Temperature °C
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E.2.11 Hydran Reading

The Hydran Reading worksheet is specific to the Hydran M2. It displays the
Hydran gas level readings taken from the device as well as the Hydran Sensor
Temperature.

The gas levels are displayed as actual level in PPM, Hourly Trend in PPM and
Daily Trend in PPM.

The Hydran Sensor Temperature is displayed in Degrees Celsius.
E.2.12 Transformer Status Model

The Transformer Status Model is specific to the Intellix MO150. It combines
information from other models calculations into one worksheet.

The following information is displayed:

= Top Oil Temperature °C

= Ambient Temperature °C

= Tank #1 %RH Level (Relative Humidity)

= Tank #1 Hydran Level

= Tank #1 H20 PPM Hourly Average

= Highest Winding Hot Spot Temperature °C

= Highest (P.U) (Per unit load on the most loaded winding)
* % Moisture Content In Winding Paper

* % Moisture Content in Insulating Barrier

E.2.13 Cooling Control

The transformer manufacturer usually provides a control system that offers
several basic features that are not duplicated by this model and need to be
maintained:

» |ndividual thermal protection on each motor
= Electrical protection as specified by local electrical code

= Manual interruption of power to allow for maintenance activity (removal and
replacement of a fan)

» Temporization system to avoid the starting of two cooling banks
simultaneously, especially if the Device monitoring system experiences a
power failure

However, taking advantage of a monitoring system to improve the
performance of the cooling system extends the useful life of the transformer
while reducing maintenance costs. Beyond the basic features provided by the
transformer manufacturer control system, this model provides the following
functions:
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= Beside input from top oil and winding temperature, it is now possible to link
cooler initiation to the load current, thus providing an earlier start when a
sudden overload occurs.

» The transformer rating can be adjusted to the ambient temperature to have
a more consistent cooler operation. For example, in winter, cooling stages 1
and 2 start at ahigher current.

» The transformer rating can also be adjusted to the altitude. At higher
altitude, the ratedcurrent is reduced to account for reduced air density,
therefore the cooling system should be started at lower load current.

» For transformers with two cooling banks, a duty-sharing function can be
initiated. Many users prefer to alternate the usage of cooling banks to
equalize the wear on bearings and extend the period between fan motor
maintenance.

= The cumulative operating time is computed for each cooling bank.

= A temporization function is included to avoid the two cooling banks from
starting at the same time.

= The current drawn by the two cooling banks is monitored with two
dedicated analog inputs. These values can be used to detect cooling bank
status if no digital input is available for this purpose.

= A cooler exercising routine can be used to run the units for a few minutes
every week.

= Continuous measurement of cooling bank current is also used to detect
malfunction when the current is significantly below or significantly above
the rated values.

= A cooling discrepancy function will raise an alarm whenever the cooling
status of one cooling bank is not reflecting the cooling control instruction
that was issued.

The Cooling Control model is intended for transformers that have two or three
ratings related to specific cooling modes. The lowest rating is defined as
“cooling stage 0”, and it usually applies to the natural cooling of the
transformer tank without any fan or pump. In other words, this mode is not
controlled by the cooling control system. Some transformers (such as indoor
generating units) have only one cooling mode, so that whenever the
transformer is energized, the full cooling is automatically initiated. These units
are treated as having only cooling stage 0, and several of the control features
described below are not applicable.
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Appendix F Offline DGA & Oil Quality Workflow

F.1

F.1.1

Perception Fleet deploys the Offline DGA & Oil Quality workflow to evaluate
transformer risk. The workflow evaluates DGA data including moisture and
additional oil properties from laboratory analysis results to calculate the risk
index for a transformer.

Implement the offline risk workflow

Follow these steps to implement the offline risk workflow in Perception

Desktop.

Note: Perception Server and Perception Workflow Designer must be

installed.

Prepare a CSV file with offline measurements data

Use an editor to create or modify a CSV file with the necessary offline
measurements data. The available parameters are listed in Table F-1.

Specify the list of parameters, populate them with values and save the file.
Note: A sample CSV file called “Offline_Oil_Analysis_Example.csv” is located
on the installation CD in the “Example Files” folder.

Table F-1: CSV fields

Mandatory fields

Comment

equipnum TransformerID

serialnum

apprtype Always set to TRN

tank Name of the compartment e.g. ‘MAIN' in
‘Offline_Oil_Analysis_Example.csv’ associated with the
Offline Oil Quality measurements.

sampledate Sample timestamp

Oil property fields

Comment

visual Standardized oil appearance remarks
color Fluid color index

iec156 Dielectric breakdown - IEC 156
fg_water Moisture concentration

acidnum Acid number

tan_delta Fluid dissipation factor

resistivity Resistivity at 90 C (gigohm-meters)
inhibitor Oxidation inhibitor concentration

ift Interfacial tension (IFT)

totalpcb Total PCB concentration

d1275a, d1275b Corrosive sulfur test result
passivator Passivator concentration

d1816_1, d1816_2

Dielectric Breakdown Voltage VDE electrode-1mm
and -2mm

pf25

Fluid Power Factor at 25 C
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pf100 Fluid Power Factor at 100 C
totalfuran Total furans

resistivity_20 Resistivity at 20 C (gigohm-meters)
sludge Sediment and sludge, %

h2 Hydrogen concentration in PPM

ch4d Methane concentration in PPM

c2h6 Ethane concentration in PPM

c2h4 Ethylene concentration in PPM

c2h2 Acetylene concentration in PPM

co Carbon Monoxide concentration in PPM
co2 Carbon Dioxide concentration in PPM

Standard TOA4 field names are also supported. See Appendix F.2 for more
details on supported parameters.

F.1.2 Run the workflow

Use Perception Desktop to run the workflow.
1. Start Perception Desktop.
2. Connect to the Perception Server.

3. Select Actions > Import > Import File and choose the CSV file created
previously. A transformer instance appears in the asset tree using the
CSV field value from "equipnum®.

4. Select the transformer instance and then select the Properties tab.

5. Inthe Main Transformer Details section, complete the following as shown
in Figure F-1 (see Appendix F.2 for configuration details):

» Rated Voltage Max (kv)
> Inhibited (check or uncheck)

Main Transformer Details

Serial Number  SNO030 Three Phase  [C]
Manufacturer Transformer type [ v|
Year of Manufacture Qil Preservation Type [ - |
Rated Voltage Max. (kV) 132 Main Tank Fluid Volume v|
Nominal Frequency (Hz) . v| Max MVA
Temperature Class (C) Y| Max Cooling Type v | [ Y|
Total PCB Limit (mg/kg) 50 Inhibited [V

Initial inhibitor concentration
Figure F-1: Main Transformer Details
6. In the Workflow Associations section, complete the following as shown in
Figure F-2 (see Appendix F.2 for configuration details):
» In the Offline Algorithm Standard, select either IEC or IEEE.
» In the ‘Workflows’ dropdown, select Offline DGA and Oil Quality.

MA-020 - Perception Desktop 2.4.7 - Installation & User Guide - Rev 10.3 22-Oct-24 Page 199 of 220



Workflow Associations

Auto criticality calculation Manual criticality (%) Cffline Algorithm Standard  |IEC - |
Worlkflows Weight Ranking Influence
11B-Gen-TransfixMAIN |Offiine DGA and Oil Quality | 1 Normal +| | Remove |

Figure F-2: Workflow Associations

7. Select Tools > Workflow Scheduler, select Enabled and specify the period.

> An asterisk (*) in each time field signifies workflow calculation on a
minute-by-minute basis.

8. Wait the specified workflow calculation period e.g. 1 minute.
9. Select the transformer instance and then select the Dashboard tab.
10. Select the Ranking Graph.

» The Risk Index and status message display.

11. In the Asset Explorer, select the Ranking tab and rest the mouse pointer
over a transformer.

» A popup displays with the Risk Score.
F.2  Offline risk workflow configuration

The following data is required for offline oil quality:

» Transformer voltage class

» Standard for oil quality tests: IEC or IEEE

= Qil type: inhibited or uninhibited

The voltage class is configured using the ‘Rated Voltage Max. (kV)’ property.
The |IEC standard defines 4 classes as follows:

O (RV > 400 kV)

A (170 kV < RV <= 400 kV)

B (72.5kV < RV <= 170 kV) and

C (RV <=72.5kV)

The IEEE standard doesn't define literal values and differentiates classes as
follows:

= >=230kV
= >69kV - <230kV
= <=69kV
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F.2.1

F.2.1.1

F.2.1.2

F.2.1.3

F.2.1.4

IEC Oil Quality Configuration Parameters
Fluid Color Index

ISO 2049 & ASTM D1500 specifies a method for the visual determination of
the colour of a variety of petroleum products.

Name Color
Type Float
Units 0-8
Standard ISO 2049

Standardized Oil Appearance Remarks

A method of visually inspecting the appearance of the oil and categorising it
as either ‘Dark’ or ‘Clear’.

Name Visual
Type Text(30)
Units ;
Standard )

Dielectric Breakdown Voltage

IEC 60156 specifies the method for determining the dielectric breakdown

voltage of insulating liquids at power frequency.

Name iec156
Type float
Units kv
Standard IEC60156

Moisture Concentration

IEC 60814 describes methods for the determination of water in insulating
liquids and in oil-impregnated cellulosic insulation with coulometrically

generated Karl Fischer reagent.
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Name fq_water
Type ﬂoat
Units ppm

F.2.1.5 Acid Number (acidity)

F.2.1.6

F.2.1.7

F.2.1.8

IEC 62021-1 & 2 describes the procedure for the determination of the acidity
of unused and used electrical mineral insulating oils.

Name acidnum
Type float
Units mg KOH/g
Standard IEC 62021-1
Or
IEC 62021-2

Fluid Dissipation Factor (tan delta)

IEC 60247 describes methods for the determination of the dielectric
dissipation factor (tan 6), relative permittivity and d.c. resistivity of any
insulating liquid material at the test temperature.

Name tan_delta
Units %

Resistivity at 20 °C

Describes methods for the determination of the dielectric dissipation factor
(tan 8), relative permittivity and d.c. resistivity of any insulating liquid material
at the test temperature of 20 °C.

Name resistivity_20
Type float

Units Gohm-m
Standard IEC 60247

Resistivity at 90 °C

Describes methods for the determination of the dielectric dissipation factor
(tan &), relative permittivity and d.c. resistivity of any insulating liquid material
at the test temperature of 90 °C.
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Name resistivity
Type float
Units Gohm-m
Standard IEC 60247

F.2.1.9 Oxidation Inhibitor Concentration

IEC 60666 specifies the concentration of the oxidation inhibitor for the
detection and determination of specified additives in unused and used mineral
insulating oils.

Name inhibitor
Type float
Units %
Standard IEC 60666

An Inhibitor value can be added at any time. However, Perception doesn’t
automatically update the initial concentration value — this must be done
manually by the user via the Transformer Properties as shown in Figure F-3.

[ Main Tank Fluid Volume | -
Max MVA
Max Cooling Type | il v
Inhibited

[Initial inhibitor concentration

Figure F-3: Inhibitor Concentration

An offline measurement of the inhibitor concentration should reveal a drop
from the initial inhibitor concentration. The user should calculate the
percentage drop and record this percentage value in the Inhibitor field of the
CSV file. Perception calculates the risk for the inhibitor component based on
the rate of change from the initial concentration.

If the initial inhibitor concentration is unknown, the user can specify the
volume and then click Default to generate a reference point value (based on
0.3% of the oil volume).
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Annex C of IEC 60422 describes a test method for the determination of

F.2.1.10 Sediment and Sludge

sediment and sludge.

Name sludge

Type float

Units %

Standard | Annex C of IEC
60422

F.2.1.11Interfacial Tension (IFT)

ASTM D971 describes the measurement of the interfacial tension between
mineral oil and water, under non-equilibrium conditions.

Name ift

Type float

Units mN/m

Standard | ASTM D971, EN 14210

Note: Risk is calculated in different ways for inhibited and uninhibited oil.
F.2.1.12 Total PCB Concentration

IEC 61619 specifies a method for the determination of polychlorinated
biphenyl (PCB) concentration in non-halogenated insulating liquids by high-
resolution capillary column gas chromatography using an electron capture
detector (ECD).

Name totalpcb
Type float
Units ppm
Standard IEC 61619

Note: This parameter is specified in ppm (mg/kg) and recorded in the CSV
file. The default value is 50 and is compared to the Total PCB Limit
transformer property as shown in Figure F-4. Excluding a value (or
any value less than 50) means the parameter does not factor in risk

calculations.
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Main Transformer Details

Senal Number  SMNOO30
Manufacturer
Year of Manufacture

Rated Voltage Max. (kV)

Mominal Frequency (Hz) | '|

Temperature Class (*C) | '|

[ Total PCB Limit (mg/kg) 50

Figure F-4: Total PCB concentration

F.2.1.13 Corrosive Sulfur Test Result

IEC 62535 specifies a test method for the detection of potentially corrosive
sulfur in used and unused mineral insulating oil.

Name d1275a, d1275b
Type text(30)

Units -

Standard IEC 62535

F.2.1.14 Passivator

IEC 60666 specifies the detection and determination of additives in unused
and used mineral insulating oils. Annex B specifically defines the analysis
method for determination of passivators in mineral oils by high performance
liquid chromatography (HPLC)

Name passivator
Units ppm
Standard IEC 60666-2010 annex B

If a passivator is added to the oil, the Passivator value should be modified
accordingly. However, Perception doesn’t automatically update the Passivator
value — this must be manually performed by the user via the CSV file.
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F.2.1.15 Total Furans

IEC 61198 specifies test methods for the analysis of 2-furfural and related
furan compounds resulting from the degradation of cellulosic insulation and
found in mineral insulating oil samples taken from electrical equipment.

Name totalfuran
Type float
Units ppb
Standard I[EC 61198

F.2.2 |EEE Oil Quality Configuration Parameters
F.2.2.1 Fluid Color Index

ASTM D1500 & ISO 2049 specifies a method for the visual determination of
the colour of a variety of petroleum products.

Name color
Units -

F.2.2.2 Dielectric Breakdown Voltage VDE electrode-1T mm and -2 mm

ASTM D1816 specifies the method for determining the dielectric breakdown
voltage of insulating liquids at power frequency for a 1 mm gap and 2 mm gap.

Name d1816_1, d1816_2

Type float

Units kV

Standard ASTM D1816 1 mm gap, ASTM D1816 2 mm gap

F.2.2.3 Moisture Concentration

ASTM D1533 specifies methods for the determination of water in insulating
liquids and in oil-impregnated cellulosic insulation with coulometrically
generated Karl Fischer reagent.
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Name fq_water

Type float

Units ppm
Standard ASTM D 1533

F.2.2.4 Acid Number (acidity)

Name acidnum

Type float

Units mg KOH/g

Standard ASTM D 664, ASTM D974

F.2.2.5 Fluid Power Factor at 25 °C

Describes methods for the determination of the dielectric dissipation factor
(tan &), relative permittivity and d.c. resistivity of any insulating liquid material
at the test temperature of 25 °C.

Name pf25

Type float

Units %

Standard ASTM D924 25C

F.2.2.6 Fluid Power Factor at 100 °C

Describes methods for the determination of the dielectric dissipation factor
(tan 8), relative permittivity and d.c. resistivity of any insulating liquid material
at the test temperature of 100 °C.

Name pf100

Type float

Units %

Standard ASTM D924 100C

F.2.2.7 Oxidation Inhibitor Concentration

ASTM D2668 & ASTM D4768 specify the determination of 2,6-ditertiary-butyl
para-cresol and 2,6- ditertiary-butyl phenol in new and used insulating liquids
at concentrations up to 0.5 %.
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Name inhibitor
Type float
Units %
Standard ASTM D2668, ASTM D4768
Note: The calculation is based on the value provided in the CSV file

according to the risk index table. The ‘Initial inhibitor concentration’
field is not used in the IEEE standard.

F.2.2.8 Interfacial Tension (IFT)

ASTM D 971 & ASTM D2285 specified a test method covering the
measurement of the interfacial tension between mineral oil and water, under
non-equilibrium conditions.

Name ift

Type float

Units mN/m

Standard ASTM D 971, ASTM D2285

F.2.2.9 Total PCB Concentration

ASTM D4059 specifies a method for the determination of polychlorinated
biphenyl (PCB) concentration in non-halogenated insulating liquids by high
resolution capillary column gas chromatography using an electron capture
detector (ECD).

Name totalpchb
Units ppm
Note: The calculation is performed in the same way as the IEC standard.

F.2.2.10Corrosive Sulfur Test Result

ASTM D1275 method A & DIN 51353 method B describes the detection of
corrosive sulfur compounds (both inorganic and organic) in electrical
insulating oils of petroleum origin.
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F.2.2.11 Passivator

Name d1275a, d1275b

Type text(30)

Units -

Standard ASTM D1275 method A, B DIN 51353

Name passivator
Units ppm

ASTM D3487 specifies properties for new mineral insulating oil of petroleum
origin for use as an insulating and cooling medium in new and existing power
and distribution electrical apparatus.

Note: The calculation is performed in the same way as the IEC standard.

F.2.2.12Total Furans

F.2.3

ASTM D5837 specifies test methods for the analysis of 2-furfural and related
furan compounds resulting from the degradation of cellulosic insulation and
found in mineral insulating oil samples taken from electrical equipment.

Name totalfuran
Type float

Units ppb
Standard ASTM D5837

DGA Configuration Parameters

IEEE C57.104 specifies condition levels for absolute dissolved gas
concentration in transformer insulation oil.

Name h2
Units ppm
Standard | C57.104
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Name ch4
Type float
Units ppm
Standard C57.104
Name c2h6
Type float
Units ppm
Standard | C57.104
Name c2h4
Type float
Units ppm
Standard C57.104
Name c2h2
Type float
Units ppm
Standard | C57.104
Name co
Type float
Units ppm
Standard | C57.104
Name co2
Type float
Units ppm
Standard | C57.104
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Appendix G MS 3000: HTTPS & Self-signed Certificates

To download data from the MS 3000 to Perception (or access the MS 3000
web HMI) over the HTTPS protocol, use a Secure Sockets Layer (SSL)
certificate (rather than the default self-signed certificate) to prevent
certificate security warnings. For example, with Windows 7 follows these
steps in Internet Explorer to access the MS 3000 over HTTPS.

Open Internet Explorer and in the address bar specify the IP address of the
MS 3000 device. For example, type https://192.168.10.1 and press
<Enter>.

A Certificate Error message displays as shown in Figure G-1. This confirms
there is a problem with the website’s security certificate. On this occasion
only, click Continue to this website... to continue.

o= | (E)

A =B
Ge &8 m 2 Y ,O v 0 &) Certificate Eror; Navigation
0 There is a problem with this website's s unty certificate

We recommend that you close this webpage and do not continue to this website
9
v

Figure G-1: Certificate Error

The MS 3000 login page displays. Click on the ‘Certificate error’ icon in the
address bar to display the ‘Untrusted Certificate’ notice shown in Figure G-2.
To view the available certificates, click the View certificates... link at the
bottom of the message.
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https://192.168.10.1/

D = © Cenificate ervoe & | @) s 3000 -

e Untrusted Certificate

The security certificate presented by this
website was not issued by a trusted
certificate authority.

This problem might indicate an attempt to
fool you or intercept any data you send to
the server,

We recommend that you ciose this webpage

About certificate errors

View certificates

N —_— —— - T ==
Figure G-2: MS 3000 Untrusted Certificate

The Windows Certificate Information displays as shown in Figure G-3. Click
Install Certificate... to install the certificate and enable trust.

Certificate ]

General D-lnhlc.m‘liu:mmF‘aﬂ‘l

OR Certificate Information

This CA Rood certificabe s nol trusted. To enabde trust,
install this certificate in the Trusted Root Certification
Authorites store.

Igued to: 0500

Tesued by: 0000 E

Vald from 11/ 08/ 2017 to 1L 08/ 2009

Learn more about certificates

Figure G-3: Certificate Information

The ‘Certificate Import Wizard’ displays as shown in Figure G-4. Select Place
all certificates in the following store and click Browse to choose the
certificate. In the ‘Select Certificate Store’ dialog, select Trusted Root

Certificate Authorities.
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Certificate Import Wizard i'

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location
for the certificate.

(") Automatically select the certificate store based on the type of certificate

(@) Place all certificates in the following store

Certificate store:

Browse...

”
Select Certificate Store u

Select the certificate store you want to use.

----- "] Personal -

el | = =

----- "] Enterprise Trust ‘ﬂ

----- | Intermediate Certification Authorities

----- [ Active Directory User Object

— | ] Trusted Publishers

----- "] Untrusted Certificates )
I Next = I [ Cancel I

— | [ | Show physical stores J
Figure G-4: Certificate Import Wizard — Certificate Store

A confirmation message displays as shown in Figure G-5. Click OK to
continue.

Certificate Import Wizard u

'Q The import was successful.

Figure G-5: Certificate Import Wizard — confirmation

Restart Internet Explorer and select Tools > Internet Options > Content as
shown in Figure G-6. Then click Certificates.
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Internet Options m

Generail Secumyl anacy| Content |Connechons Programs | Advanced|

Certificates

@

| cearssistate |[ conifictes | publishers |

Use certificates for encrypted connections and identification.

AutoComplete

= AutoComplete stores previous entries

i on webpages and suggests matches
for you.

Feeds and Web Slices

Eé Feeds and Web Slices provide

updated content from websites that
can be read in Internet Explorer and
other programs.

@ Some settings are managed by your system administrator.

Figure G-6: Internet Options

In the ‘Certificates’ dialog box, select the Trusted Root Certification
Authorities tab and select the certificate previously installed and click Export
as shown in Figure G-7.

Corificalts o s —— — e

Iptended purpose: [cam> -

dictn Cartification Authoribes | Trusbed Rost Certification Authonties | Trusted Pub * | »

Bssued To Emsued By Expirati... Friendly Name =
'_-:3' JUGEH Lk Sl et TL/DBY... <Nona> =
CWAddTnest Extern... AddTrust Edernal .. 30/05/Z_.. The USERTML..
CJBalimore Cyber... Babimore CyberTr._. 13/05/2.. DegiCert Baki..
Cl Crtum CA, Certum Ch 1L/D6EZ.. Corbem
O Certum Trested ... Certum Trested .. 31712/Z... Corbum Trust...
_,:Dam 3 Public Pr... Class 3 Public Pri..  02/0B/2... “weriSign Clas...
_*:MRSA C.. COMODDO RSA Cer... 190172, CDMODD SEC..
T Copyright (c] 19... Copyright () 1987_.. 31012/, Macrosoft Tim..
CJDsgiCort Assure... [NgiCert Assured L.. D011/2.. DegiCert
SANndCert Hohal .. Teolerd Glohsd Bn.,. 01102, DeniCert

g, | [(opot. ]| meooe | | stanced |
Certficale infendtsd purpiies

<Al

Laaim more about Corifiaies _‘ Lhise

Figure G-7: Certificates: Trusted Root Certification Authorities
The ‘Certificate Export Wizard’ dialog box opens. Use the default settings and

specify a valid path and filename to save the certificate and click Next as
shown in Figure G-8.
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Certificate Export Wizard

File to Export

Specify the name of the file you want to export

File name:

C:\1.22.0.16889\ms3k.cer

l < Back “ Mext = Jl Cancel l

Figure G-8: Certificate Export Wizard - Certificate file name

P— -

The ‘Certificate Export Wizard’ completes with a confirmation message as

shown in Figure G-9.

i N
Certificate Export Wizard M

The export was successful.

Figure G-9: Certificate Export Wizard - confirmation

From the Windows Taskbar, click Start > Run and type mmc.

Microsoft Management Console as shown in Figure G-10.

exe to launch the

-
% Consolel - [Conscle Root]

-

(=B = |
& File Action View Favorites Window Help Hli"ﬂ
«= @z d
| Console Root Mame Actions

There are no items to show in this view. Console Root “
More Actions
Figure G-10: MMC main screen
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In the MMC, select File > Add/Remove Snap-in. From the Available snap-ins,
select Certificates and click Add as shown in Figure G-11.

Consolel - [Console Roo N [of@m] =
ﬁ Add or Remove Snap-ins M
& File Action View - 1 BE‘E‘
@ * | ‘ = | ﬂ You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For |_
= extensible snap ins, you can configure which extensions are enabled.

|| Consele Root Available snap-ins: Selected snap-ns:
Snap-in Vendor = [l Console Root Edit Extensions... I -
¥ N
= ActiveX Control Microsoft Cor... Remove »

Auﬂ’\orimhon Manager Micrasoft Cor...
Microsaft Cor...
. Component Services  Micrasoft Car... Move Up
;{'Computer Managem... Microsoft Cor...
=4 Device Manager Microsoft Cor. ..
(=7 Disk Management Microsoftand. ..
2] Event Viewer Microsoft Cor...
[l Folder Microsoft Cor...
_EJ Group Policy Object ... Micrasoft Cor...
@ IP Security Monitor Microsoft Cor...
\%IP Security Policy M...  Microsoft Cor...

%, Link to Web Address ~ Microsoft Cor... Advanced...

m

Mave Dawn

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

—

Figure G-11: MMC Add Certificates

In the ‘Certificates snap-in’ dialog box, select the Computer account option
and click Next as shown in Figure G-12.

& Consolel - [Console Roof . — — — = [=/E@] =
™

ﬁ File Action View | Certificates snap-in - ] M 7 ] H\i“il

= *l‘ -_;?l H snap-ns. Far [

This snap-in will always manage certificates for:

() My user accourt
2 My Edit Extensions... l =
»

|| Consele Root

() Senvice account

(@ Computer accourt | Remove

Move Up

Mave Down

Advanced...

< Back MNext > Cancel b
| |8 computer,

Figure G-12: MMC Certificates snap-in

In the ‘Select Computer’ dialog box, select the Local computer option and
click Finish as shown in Figure G-13.
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% Consalel - [Conscle Roa(f

el e B <

View

File Action

|1 Console Root

| Select Computer

() Another computer:

This snap-in will always manage:

Select the computer you want this snap-in to manage.

@ Local computer: {the computer this console is running on)

Browse.

[] Allow the selected computer to be changed when launching from the command line. This
only applies if you save the console

snap-ins, Far

Edit Extensions...

Remove

Move Up

Move Down

Advanced. ..

[ <Back ][ Finisn

=

| |& computer.

[=[@E] = ]

[=[=]x]

Figure G-13: MMC Select Computer

Click OK to close the ‘Add or Remove Snap-ins’ dialog box as shown in Figure
G-14 and return to the MMC main screen.

Consalel - [Console Roof

Add or Remove Snap-ins

[a[@m] = ]

F\\e Action
«s 0=

| Conscle Root

View

‘You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins:

Selected snap-ns:

Snap-n

+'| ActiveX Cantrol
[T Authorization Manager
¥ Certificates

. Component Services
#‘Cummt&r Managem...
i Device Manager

29 Disk Management

E Event Viewer

[ Folder

[=[ Group Policy Object ...
‘.g IP Security Monitor
&, 1P Security Policy M...
] Link to Web Address
= . .

Vendar

Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft and...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...

»

m

e

] Console Root

[l Certificates (Local Computer)
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Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer,
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Figure G-14: MMC Certificates added

In the MMC main screen, select Certificates (Local computer) > Trusted
Root Certification Authorities as shown in Figure G-15.
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Figure G-15: MMC main screen - Certificates (Local Computer)

On the MMC main menu, select Action > All Tasks > Import to launch the
‘Certificate Import Wizard’ as shown in Figure G-16. Click Next.

I L
Certificate Import Wizard

&3

flcwal Computa . [o]@] = ]
—— ==t RO

Welcome to the Certificate Import [

Wizard Actions

This wizard helps you copy certificates, certificate trust Certificates (Local Computer) -

lists, and certificate revocation lists from your disk to a More Actions

certificate store.

A certificate, which is issued by a certification authority, is Trusted Root Certification Authorities =

a confirmation of your identity and contains information More Acti

used to protect data or to establish secure network ore Actions

connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

Figure G-16: Certificate Import Wizard

Specify the certificate file name and path (as exported previously) as shown in
Figure G-17. Use the default settings and click Finish to complete the

‘Certificate Import Wizard'.
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Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (P78)

Microsoft Serialized Certificate Store ((S5T)

Learn more about certificate file formats

I L . flocal
Certificate Import Wizard [=5=) *
0 . i, [=[=]x]
File to Import
Spedfy the file you want to import.
Actions
Certificates (Local Computer) -
P More Actions 4
€:\1.22.0.16889\ms3k. cer| Browse...
Trusted Root Certification Authorities -
Note: More than one certificate can be stored in a single file in the following formats: More Actions

[ < Back ][ Next > ][ Cancel ]ﬁ

Figure G-17: Certificate Import Wizard - Certificate file name

The ‘Certificate Import Wizard’ completes with a confirmation message as
shown in Figure G-18.

-

Certificate Import Wizard u

'@ The import was successful,

b

Figure G-18: Certificate Import Wizard — confirmation

This allows you to use the default self-signed certificate and prevents the

certificate security warnings when accessing the MS 3000 device.
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GE Grid Solutions (UK) Ltd

Lissue Industrial Estate East

Unit 1, 7 Lissue Walk, Lisburn, Co. Antrim
Northern Ireland, United Kingdom BT28 2LU
www.gegridsolutions.com/MD.htm

For further assistance or queries please contact:

Customer Service Centre (24 hours a day, 365 days a year)
T 1-877-605-5777, option 4 (United States and Canada)

T +44 1785-250-070 (Rest of the World)
ga.support@ge.com

Kelman is a trademark of GE Vernova. Other company or product names
mentioned in this document may be trademarks or registered trademarks
of their respective companies.

GE Vernova reserves the right to make changes to specifications of
products described at any time without notice and without obligation to
notify any person of such changes.

This material is accurate at the time of writing.

© 2024 GE Vernova and/or its affiliates. All rights reserved.

GE VERNOVA
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